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About this document

This document explains how to use the ATM service provisioning tool. The 
ATM service provisioning tool is part of the Nortel Networks Preside 
Multiservice Data Manager (MDM) toolset.

For more information about this document, see the following sections:

• “Who should read this document and why” (page 13)

• “What you need to know” (page 13)

• “How this document is organized” (page 13)

• “What’s new in this document” (page 14)

• “Text conventions” (page 15)

• “Related documents” (page 16)

Who should read this document and why
This document is intended for personnel who are managing and provisioning 
Passport 7000, 15000, and 20000 nodes.

What you need to know
This document assumes that you have knowledge of the Preside Multiservice 
Data Manager (MDM) and an understanding of the Passport product.

How this document is organized
The information in this document is organized as follows:

• “Introducing ATM service provisioning” (page 17) describes the tool and 
its advantages.
Preside MDM Service Provisioning for ATM User Guide   14.3RSUP
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• “Installing the ATM service provisioning tool” (page 25) describes the 
software installation procedures.

• “Setup requirements and configuration” (page 29) provides information 
on setup and system requirements, and it describes how to start the tool.

• “ATM service provisioning tool user interface” (page 41) describes the 
tool interface.

• “General provisioning procedures” (page 103) provides generic 
procedures that may apply to any of the circuit types.

• “ATM permanent virtual connections” (page 139) provides the 
procedures to provision an ATM PVC circuit.

• “ATM soft permanent virtual path and soft permanent virtual channel 
connections” (page 173) provides the procedures to provision and ATM 
SPVC or ATM SPVP.

• “Frame relay to ATM circuits” (page 191) provides the procedures to 
provision SIWF FrAtm to FrAtm SPVC, SIWF FrAtm to ATM Access 
SPVC and SIWF Atm to FrAtm Access SPVC connections.

• “ATM Traffic Management Profile Editor” (page 217) describes the 
ATM Traffic Management Profile Editor and how to use it.

What’s new in this document
This document was updated to include the following feature:

• “FrAtm Service Provisioning” (page 14)

FrAtm Service Provisioning
This feature addresses the requirement for a FrAtm Service Provisioning 
solution for the following FRF.8 FrAtm scenarios:

• SIWF FR-ATM to FR-ATM access SPVC

• SIWF FR-ATM to ATM access SPVC

• SIWF ATM to FR-ATM access SPVC

This feature adds three new SPVC types to ATM service provisioning:

• FrAtm to FrAtm SPVC
241-6001-600   14.3RSUP   
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• FrAtm to Atm SPVC

• Atm to FrAtm SPVC

For information about the user interface for FrAtm service provisioning, see 
“ATM service provisioning tool user interface” (page 41).

For information about the procedures to provision FrAtm SPVC circuits, see 
“Frame relay to ATM circuits” (page 191).

Text conventions
This document uses the following text conventions: 

• nonproportional spaced plain type

Nonproportional spaced plain type represents system generated text or 
text that appears on your screen.

• nonproportional spaced bold type

Nonproportional spaced bold type represents words that you should type 
or that you should select on the screen.

• italics

Statements that appear in italics in a procedure explain the results of a 
particular step and appear immediately following the step.

Words that appear in italics in text are for naming.

• [optional_parameter]

Words in square brackets represent optional parameters. The command 
can be entered with or without the words in the square brackets.

• <general_term>

Words in angle brackets represent variables which are to be replaced with 
specific values.
Preside MDM Service Provisioning for ATM User Guide   14.3RSUP
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• UPPERCASE,lowercase

In MDM, uppercase and lowercase letters that appear in UNIX 
commands and parameters must be matched exactly. The system matches 
upper and lowercase characters differently.

The term absolute pathname refers to the full specification of a path starting 
from the root directory. Absolute pathnames always begin with the slash ( / )
symbol. A relative pathname takes the current directory as its starting point, 
and starts with any alphanumeric character (other than /).

Related documents
See the following documents for related information:

• 241-6001-310 Preside MDM Server Reference Guide

• 241-6001-400 Preside MDM Administration Database User Guide

• 241-6001-405 Preside MDM Administration Database Schema

• 241-6001-602 Preside MDM Service Provisioning for CES SVC User 
Guide

• 241-6001-610 Preside MDM Nodal Provisioning User Guide

• 241-6001-801 Preside MDM Overview

• 241-5701-060 Passport 7400, 15000, 20000 Components

• 241-5701-700 Passport 7400, 15000, 20000 ATM Overview

• 241-5701-705 Passport 7400, 15000, 20000 ATM Traffic Management 
Fundamentals

• 241-5701-710 Passport 7400, 15000, 20000 ATM Configuration Guide

• 241-5701-720 Passport 7400, 15000, 20000 AAL1 Circuit Emulation 
Guide

• 241-5701-920 Passport 7400, 15000, 20000 Frame Relay to ATM 
Interworking Guide
241-6001-600   14.3RSUP   
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Chapter 1
Introducing ATM service provisioning

This section introduces the Nortel Networks Preside Multiservice Data 
Manager (MDM) ATM service provisioning application. This section 
contains the following information:

• “ATM service provisioning overview” (page 17)

• “Benefits of ATM service provisioning” (page 22)

ATM service provisioning overview
ATM service provisioning is an application that lets you create end-to-end 
services on multiple Passport nodes from a single window. See the following 
sections for additional information:

• “ATM permanent virtual connections (PVCs)” (page 18)

• “ATM soft permanent virtual connections (SPVC and SPVP)” (page 18)

• “Frame relay to ATM (FR-ATM) connections” (page 19)

• “ATM service provisioning and the MDM Administration Database” 
(page 20)

For more information on the ATM service provisioning application, see 
“ATM service provisioning tool user interface” (page 41). 

Provisioning of the Circuit Emulation Service (CES) over ATM switched 
virtual circuit (SVC) connections is handled by the CES SVC service 
provisioning tool. See 241-6001-602 Preside MDM Service Provisioning for 
CES SVC User Guide.
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ATM permanent virtual connections (PVCs)
The ATM service provisioning application lets you provision Passport 
permanent virtual connections (PVC). 

A Passport permanent virtual connection can be either a virtual path or virtual 
channel. A permanent connection has a predefined static route that provides 
a permanently configured connection between the customer premise 
equipment and the ATM networks. Permanent connections are set up using 
predetermined user requirements for bandwidth and the duration of the 
connection. Once configured, permanent connections remain set up even 
when not in use.

For Trunk, VccBearerService, VpcBearerService, CES over PVC circuit 
types you can change the following items:

• default and node specific Traffic Management (TM) profiles

• customer field

• the correlationTag field

• the node configuration of the circuit 

• attributes of the nodes within the circuit that are directly related to 
provisioning these types of circuits

 ATM soft permanent virtual connections (SPVC and SPVP) 
The ATM service provisioning tool lets you provision Passport soft 
permanent virtual path (SPVP) and soft permanent virtual channel (SPVC) 
connections. 

Passport soft permanent virtual connections support the same functionality as 
permanent virtual connections (PVC) and eliminate the need to manually 
provision each node along the connection. The end point is provisioned but 
the connection route is automatically selected. Soft permanent connections 
also support automatic route selection, and connection establishment and re-
establishment.
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For SPVC/SPVP circuits, you can change the node name for the source and 
destination nodes. Since this circuit consists of two nodes changing either one 
modifies the circuit. The following attributes of both nodes are editable so if 
you change the node name, you can adjust the values.

• ATMIF

• calling address

• VPI/VCI values

Note: The ability to change the destination node name, and its attributes 
is available in PCR4.2 and above and will depend on whether the AIS 
option has been set.

Frame relay to ATM (FR-ATM) connections
The ATM service provisioning tool lets you provision Passport frame relay to 
ATM (FR-ATM) connections. The Passport FR-ATM interworking service 
allows frame relay traffic to travel over an ATM networking and transport 
infrastructure. 

To provision a FR-ATM connection, you bind the interworking function of a 
FR-ATM DLCI to an ATM VCC. You then configure a normal ATM S/PVC 
across the ATM subnet.

The ATM service provisioning tool supports the application of the FRF.8 
standard for service interworking (SIWF). The SIWF maps frame relay 
DLCIs to ATM VCCs on a one-to-one basis.

The ATM service provisioning tool addresses the following FRF.8 FrAtm 
scenarios:

• SIWF FR-ATM to FR-ATM Access SPVC
The ATM service provisioning tool supports the creation of an end-to-
end FR connection across a homogeneous PNNI cloud where Passport is 
on the edge of the network offering FR service on both ends.

• SIWF FR-ATM to ATM Access SPVC
The ATM service provisioning tool supports the creation of a FRATM 
connection across a homogeneous PNNI cloud where Passport is on the 
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edge of the network offering FR service on one end-point and ATM on 
the other. This is accomplished on Passport by providing FRF.8 
interworking on one of the Passport edge nodes.

• SIWF ATM to FR-ATM Access SPVC
The ATM service provisioning tool supports the creation of a FRATM 
connection across a homogeneous PNNI cloud where Passport is on the 
edge of the network offering ATM service on the source end-point and 
FrAtm on the destination. This is accomplished on Passport by providing 
FRF.8 interworking on one of the Passport edge nodes.

In addition, the ATM service provisioning tool user interface lets you perform 
the following tasks:

• select the interfaces (FrAtm, AtmIfs) used in the circuit

• display and search FrAtm instances on a Passport

•  create and configure new DLCIs for the connection

ATM service provisioning and the MDM Administration 
Database

If the MDM Administration Database is installed and you use the ATM 
service provisioning tool to configure and activate on-switch data, the MDM 
Administration Database is updated to maintain the current view of the 
network. If you do not activate the configuration, the MDM Administration 
Database is not updated because the current network view has not changed. 
The changes, however, will exist on the switch in either the edit or saved view. 

 ATM service provisioning tool populates the Administration Database with 
the newly provisioned circuit data for the following ATM connections:

• ATM PVC

• ATM PVP

• Passport Trunks over ATM

• ATM SPVC

• ATM SPVP

• FRATM ACCESS SPVC
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To populate the database using the ATM service provisioning tool, the 
following conditions must be met:

• You have installed the database software.

• You have successfully activated the circuit immediately after 
provisioning it. 

For additional information on the database population process, see 
241-6001-400 Preside MDM Administration Database User Guide.

The circuit type in the service provisioning tool corresponds to the circuit 
type in the database as follows:

• VccBearerService is considered to be an ATM PVC 

• VpcBearerService is considered to be an ATM PVP

• Trunk is considered to be a Trunk over ATM PVC

• ATM SPVP are considered to be a ATM SPVP

• For SPVCs, and FRATM ACCESS SPVCs the circuit type in the 
database is determined by the interface type on the source node, as 
follows:

— The ATM to FrAtm and ATM to ATM scenarios are considered to be 
ATM SPVCs. 

— The FrAtm to FrAtm and FrAtm to ATM scenarios are considered to 
be FrAtm Access SPVCs. 

The ATM service provisioning tool uses information in the Administration 
Database when modifying ATM circuits. You can use the circuit id to retrieve 
circuit information from the database. You can access information in the 
database in the following ways:

• through the Circuit Viewer tool. You can find the circuit in Circuit Viewer 
and set the circuit context. The ATM service provisioning tool gets the 
circuit context and retrieves the circuit from the database. For 
information on Circuit Viewer and how to use it, see 241-6001-011 
Preside MDM Fault Management User Guide.

• by entering the circuit id, if known, directly into the Circuit Id field in the 
ATM service provisioning window.
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For additional information on editing, copying, and deleting ATM circuits, 
see the following sections: 

• “Editing an ATM circuit” (page 111)

• “Copying an ATM circuit” (page 116)

• “Deleting an ATM circuit” (page 121)

Benefits of ATM service provisioning
ATM service provisioning lets you perform the following tasks:

• create, edit, and delete the following circuits:

— ATM logical trunks over ATM PVCs

— ATM virtual path connection (VPC) or virtual channel connection 
(VCC) bearer service

— AAL1 CES over PVCs

— SIWF FR-ATM to FR-ATM Access SPVC

— SIWF FR-ATM to ATM Access SPVC

— SIWF ATM to FR-ATM Access SPVC

• select any node in the network as the next hop in an ATM PVC

• use an assisted routing feature that automatically plots the shortest path 
between two selected end nodes in an ATM PVC connection

• edit the nodal configuration (path) of PVC and SPVC circuits and the 
attributes of the nodes that make up the circuit.

• provision SPVC destination address. You no longer have to manually 
enter this address, which is 40 hexadecimal characters long.

• validate the called VPI and VCI on the destination node in ATM SPVC 
service provisioning

• support SPVC Lock and Unlock for SPVC and SPVP connections 

• specify primary and alternate path (Designated Transit List (DTL)) to be 
taken by the SPVP or SPVC

• enable or disable the AIS generation at the source and destination ends 
when creating an SPVC or SPVP
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• enable or disable the PNNI route selection algorithm when the manual 
paths fail

• select any node in the network when configuring the master or remote 
end of an FrAtm connection

• display and search for FrAtm instances on a Passport

• create and configure DLCIs

• use either a Passport or non-Passport as the remote end of the connection

• integration into the Administration Database providing diagnostic, 
discovery, and editing support

• set the correlationTag attribute, and storing the correlationTag attribute in 
the Administration Database

• set a circuit ID for all nodes in the path, and storing the circuit ID in the 
Administration Database, independent of the correlation tag

• apply a traffic management (TM) profile to each node in the path, with a 
different TM profile applied to each Vcc/Vpp in a path. The TM profile 
is stored on a Virtual Connection basis in the Administration Database

• create, edit and view Traffic Management (TM) profiles with the ATM 
Traffic Management Profile Editor

• save, confirm, activate, and commit provisioning changes

• provides progress information and error reporting during provisioning
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Chapter 2
Installing the ATM service provisioning tool

For system requirements and installation instructions for the ATM service 
provisioning tool, see the following sections:

• “Requirements” (page 25)

• “Installing the ATM service provisioning tool software” (page 26)

• “Adding a license key and customer identifier” (page 27)

Requirements
The current supported platform of the ATM service provisioning tool is 
SPARC Solaris.

The ATM service provisioning tool requires the following software:

• Preside Multiservice Data Manager (MDM). The ATM service 
provisioning tool is part of Preside MDM on the MDM CD-ROM.

• third-party software supplied by Nortel Networks on the MDM CD-
ROM, consisting of the following items:

— associated JRE patches for Solaris

• a valid license key 
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Installing the ATM service provisioning tool software
The ATM service provisioning tool is part of the Preside Mulitservice Data 
Manager (MDM) software. When you load the Preside MDM software from 
CD-ROM with the InstallAnywhere program as described in 241-6001-100 
Preside MDM Installer Guide you are instructed to:

• load the Solaris software patches for the Java Runtime Environment that 
is needed to run the ATM service provisioning tool. See 241-6001-100 
Preside MDM Installer Guide.

• load the Preside MDM software with the InstallAnywhere program. 
When you run the InstallAnywhere program to load the Preside MDM, 
the program automatically loads the software packages required for the 
ATM service provisioning. These packages are Preside MDM base and 
the Java Runtime Environment (JRE). You do not need to load any 
additional packages. See 241-6001-100 Preside MDM Installer Guide.

• If you do not already have a license, you will need to add a license key 
and customer identifier before you can run the ATM service provisioning 
tool for the first time. See the procedure“Adding a license key and 
customer identifier” (page 27).
241-6001-600   14.3RSUP   



Chapter 2 Installing the ATM service provisioning tool   27
Adding a license key and customer identifier
You need a license before you can run the ATM service provisioning tool for 
the first time.

Nortel Networks provides this information along with the Preside 
Multiservice Data Manager (MDM) software on the MDM CD-ROM. If you 
do not have this information, contact your Nortel Networks account 
representative.

Prerequisites
 You only need to perform this procedure if the license you have for Preside 
MDM does not allow you to run the ATM service provisioning tool.

Procedure steps
1 Log in as root.

2 Using a UNIX editor open the following file for editing:

/etc/opt/Magellan/LIClicenses.cfg

3 Add the license key to the file.

4 Check what you have typed carefully.

5 Save the file and exit from it.

6 Open the following file for editing:

/etc/opt/Magellan/LICcustName.cfg

7 Check what you typed carefully.

8 Save the file and exit from it.
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Chapter 3
Setup requirements and configuration

For information on setup requirements and configuration for the ATM service 
provisioning tool, see the following sections:

• “ATM service provisioning tool configuration overview” (page 29)

• “Configuring the end-to-end server” (page 30)

• “Changing the server port number” (page 32)

• “Configuring the server host” (page 33)

• “Configuring access to the server host” (page 34)

• “Configuring a connection to a remote Administration Database” 
(page 35)

• “Setup prerequisites” (page 36)

ATM service provisioning tool configuration overview
Before using the ATM service provisioning tool, you need to do some or all 
of the following configuration tasks:

• “Configuring the end-to-end server” (page 30)

• “Changing the server port number” (page 32)

• “Configuring the server host” (page 33)

• “Configuring access to the server host” (page 34)

• “Configuring a connection to a remote Administration Database” 
(page 35)
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Configuring the end-to-end server
Use this procedure to configure and start the ATM end-to-end server. You 
need to use the Preside Multiservice Data Manager (MDM) Server 
Administration tool to edit the entry for the ATM end-to-end server. For more 
information on the end-to-end server, see 241-6001-310 Preside MDM Server 
Reference Guide.

Procedure steps
1 In the Preside MDM window, select System -> Administration -> Server 

Administration.

The Server Manager Administration Tool window opens.

2 From the Security menu, select the Enable Editing... command.

The SVM Enter Edit Password dialog opens and prompts for a 
password.

3 If required, type a valid password and click OK.

4 From the Edit menu, select Edit and then select New.

The Server Manager Edit Server dialog opens.

5 In the Descriptive name field, type the following information:

end-to-end server

6 In the Startup command field, type the following information:

/opt/MagellanNMS/bin/eteserver [-p <portno>]

[-p <portno>] specifies the TCP port number for monitoring 
incoming requests. The default value is 6600. 

Note:  The port number must not be used by any other process.

7 Enable the Automatic startup at reboot time option.

8 Click Save and Start.

The data you entered is stored and the server is started.

9 From the File menu, choose Refresh Server list.

An updated server list is displayed, including the eteServer.

10 Using the mouse menu button, click on the eteServer entry in the server 
list.

The Server Functions pop-up menu opens.
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11 From the pop-up menu, select Start.

The end-to-end server starts.
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Changing the server port number
Use this procedure to update the client resource file if your setup runs the end-
to-end server on a port other than the default. You need to update the client 
resource file for the provisioning tool and reconfigure the server. 

Procedure steps
1 While logged on as root, edit the ATM provisioning resource file:

/opt/MagellanNMS/cfg/eteATMRes.cfg

2 To change the server port number from the default value of 6600, set the 
port parameter to the appropriate port number:

port = <portno>

where:

<portno> is the TCP port number.

3 Go to the MDM Server Manager Administration tool and edit the server 
port number option. See “Configuring the end-to-end server” (page 30).

4 Restart the end-to-end server.
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Configuring the server host
Use this procedure to update the eteATMRes.cfg file. By default, the local 
host is the server host. If you are running the client on a different host than the 
server, you need to update the resource file.

Procedure steps
1 While logged on as root, edit the resource file:

/opt/MagellanNMS/cfg/eteATMRes.cfg

2 Set the host parameter:

host = <hostname>|<ipaddress>

<ipaddress> is the address of the host server.
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Configuring access to the server host
Use this procedure to update the hosts file. By default, the local host is the 
server host. If you are running the client on a different host than the end-to-
end server, you need to update the hosts file to add the IP address and host 
name of the server.

Procedure steps
1 While logged on as root, display the contents of the hosts file:

more /etc/hosts

2 Check that the file contains an entry with the IP address and host name 
of the end-to-end server.

3 If the entry is not listed, open an edit view of the resource file and add the 
IP address and host name of the end-to-end server on a new line:

<ipaddress> <hostname>
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Configuring a connection to a remote Administration 
Database

Use this procedure and the Circuit Database Administration tool to connect 
to a remote Administration Database. For information on the Circuit 
Database Administration tool, see 241-6001-400 Preside MDM 
Administration Database User Guide.

Procedure steps
1 In the Preside MDM window, select System -> Administration -> Circuit 

Database Administration.

The Circuit Database Administration tool opens.

2 From the main menu bar, select Options -> Configuration....

The Configuration Options dialog box opens.

3 In the Database Host field, enter the host on which the Administration 
Database is running and click OK.
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Setup prerequisites
Before using the ATM service provisioning tool, ensure that you have met the 
following prerequisites:

• configured the Passport switches for service provisioning, as described in 
“Passport configuration” (page 36)

• set up the information files required by the provisioning tool, as 
described in “Information files” (page 36)

Passport configuration
The ATM service provisioning application creates logical trunking, VCC, or 
VPC components and their subcomponents. Therefore, before using the 
application, you must ensure that all the Passports to be provisioned are 
configured for ATM and/or CES services up to the logical connection layer. 
The following preconfiguration is required:

• physical installation of cards, cabling, and other elements required to 
interconnect the Passports for service provisioning

• provisioning of cards, logical processors, software, ports, AtmIf 
components, and Uni/Pnni/Iisp subcomponents (if required) on the 
switches

For information on configuring Passports, refer to your Passport 
documentation.

Information files
The ATM service provisioning tool uses information provided in the 
following text files: 

• “eteATMConnections.cfg file” (page 37)

• “eteATMProfiles.cfg file” (page 38)

You can create these information files (in ASCII format) using any text editor. 
You can find sample versions of these files in the /opt/MagellanNMS/cfg 
directory. If you edit these files, save the changes in the /op/MagellanNMS/
cfg directory.
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Note: If the eteATMConnections.cfg file or the eteATMProfiles.cfg file 
is edited, the ATM service provisioning tool must be restarted for the 
changes to take effect. For information about starting the tool, see 
“General provisioning procedures” (page 103).

eteATMConnections.cfg file
The eteATMConnections.cfg file provides information about direct 
connections between nodes. This information is used by the assisted routing 
feature. 

For each node, use the following syntax:

EM/<first_node_name> atmif/<atmif_number>:EM/
<second_node_name> atmif/<atmif_number>

where:

atmif_number is the ATM interface number.

:  indicates a connection relationship.

For example:

EM/bdacr10 atmif/100:EM/bdacc3f atmif/50

Save the file as eteATMConnections.cfg in the /opt/MagellanNMS/cfg 
directory.

The connections file can be generated from topology information stored in the 
GMDR server. 

To generate the file, issue the following command:

/opt/MagellanNMS/bin/getLinks > /opt/MagellanNMS/cfg/
eteATMConnections.cfg

Note: The FMDR servers feeding the GMDR server must be running 
with the -l AL option:

/opt/MagellanNMS/bin/fmdr -l AL

The -l option turns on automatic generation of ATM topology. 
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FMDR uses the remoteAtmInterfaceLabel attribute of the AmtIf component 
to generate the topology. This attribute must be provisioned with the full 
name of the remote AtmIf component. 

See 241-6001-310 Preside MDM Server Reference Guide for further 
information on the GMDR and FMDR servers.

eteATMProfiles.cfg file
The eteATMProfiles.cfg file provides Traffic Management (also known as 
quality of service (QoS)) parameters. Information from this file is displayed 
in the Default TM profile field in the application window. See “Circuit 
Properties panel” (page 48).

The eteATMProfiles.cfg files are stored in the /opt/MagellanNMS/cfg/ete 
directory on the Preside MDM running the ATM service provisioning tool.

If you have saved ATM Traffic Management Profiles prior to R14.1, the first 
time the ATM service provisioning tool is run from a new MDM install, a 
warning dialog box opens informing you of the new location for the 
eteATMProfiles.cfg files. Any eteATMProfiles.cfg files created before R14.1 
remain unchanged in /opt/MagellanNMS/cfg. However, the ATM service 
provisioning tool does not use these files.

For each TM profile, use the following syntax:
[<QoSProfileName>]

key value

key value

where:
QoSProfileName is the profile name (contains no spaces). 

key value is derived from attribute value pairs of the TrafficManagement 
component. 

For more information, see 241-5701-710 Passport 7400, 15000, 20000 ATM 
Configuration Guide.
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For more information on CDL types and ATM traffic management, see 
241-5701-705 Passport 7400, 15000, 20000 ATM Traffic Management 
Fundamentals and 241-5701-700 Passport 7400, 15000, 20000 ATM 
Overview.

Example:

[AVCCBearerServiceQoSProfile]
txTrafficDescParm 1 0 2 0 3 0 4 0 5 8
txTrafficDescType 4
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ATM service provisioning tool user interface

For a description of the ATM service provisioning tool see the following 
sections:

• “Overview of ATM service provisioning tool window” (page 41)

• “Menu bar” (page 45)

• “Circuit Properties panel” (page 48)

• “Circuit Path panel for PVC circuit types” (page 51)

• “Node Properties panel” (page 52)

• “SPVC or SPVP Routing panel” (page 74)

• “ATM service provisioning dialog boxes” (page 77)

• “PVC dialog boxes” (page 88)

• “SPVC or SPVP dialog boxes” (page 91)

• “FRATM ACCESS SPVC dialog boxes” (page 99)

• “Using the keyboard” (page 101)

Overview of ATM service provisioning tool window
The ATM service provisioning window lets you do all your provisioning for 
the following circuit types:

• the following ATM soft permanent virtual connections:

— SPVC

— SPVP
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• the following ATM permanent virtual connections (PVC) 

— Trunk

— VccBearerService 

— VpcBearerService 

— CES over PVC

• FRATM ACCESS SPVC. This circuit type covers the following 
scenarios:

— FrAtm to FrAtm SPVC

— FrAtm to Atm SPVC

— ATM to FrAtm SPVC. In the Administration Database, this is 
considered an ATM SPVC because it originates on an ATM 
interface.

When you open the tool, the SPVC circuit type is selected, and the default 
operation is service creation.

For an illustration of the ATM service provisioning tool window at start-up, 
see the figure “ATM service provisioning window at launch showing the 
default circuit type (SPVC)” (page 43).
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Figure 1
ATM service provisioning window at launch showing the default circuit type (SPVC)

The ATM service provisioning window is dynamic and shows different 
elements for PVC, SPVC/SPVP, and FrAtm circuit types. 
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For PVC circuit types (trunk, VccBearerService, VpcBearerService, CES 
over PVC), the main window has the following elements:

• “Menu bar” (page 45)

• “Circuit Properties panel” (page 48)

• “Circuit Path panel for PVC circuit types” (page 51)

• “Node Properties panel for PVCs” (page 53)

• “Command panel” (page 76)

For SPVC and SPVP circuit types, the main window has the following 
elements:

• “Menu bar” (page 45)

• “Circuit Properties panel” (page 48)

• “Node Properties panel for SPVCs or SPVPs” (page 61)

• “SPVC or SPVP Routing panel” (page 74)

• “Command panel” (page 76)

For FRATM ACCESS SPVC circuit types, the main window has the 
following elements:

• “Menu bar” (page 45)

• “Circuit Properties panel” (page 48)

• “Node Properties panel for FRATM ACCESS SPVC” (page 68)

• “Command panel” (page 76)

See also...

• “ATM permanent virtual connections” (page 139)

• “ATM soft permanent virtual path and soft permanent virtual channel 
connections” (page 173)

• “Frame relay to ATM circuits” (page 191)

• “ATM Traffic Management Profile Editor” (page 217)
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Menu bar
The menu bar consists of the following menus:

• File

• Edit

• View

• Tools

• Help

Note: You can use mnemonics or command accelerators to access menu 
options. For additional information, see “Using the keyboard” 
(page 101).

File menu
Note: The Edit Circuit..., Copy Circuit..., and Delete Circuit... 
commands are shown only if the Administration Database is installed.

The File menu contains the following commands:

• Edit Circuit...
This command opens the Edit Circuit retrieve dialog box to retrieve the 
configuration data of a circuit from the Administration Database so that 
you can edit the circuit.

• New Circuit
This command lets you create a new circuit. This command clears all 
node information in the current provisioning path, so you can start over 
with new path information. 

• New Circuit Using Shortest Path...
This command opens the Shortest path dialog box to create a new PVC, 
with the path automatically selected based on the shortest path between 
the endpoints. The New Circuit Using Shortest Path... command is 
enabled for PVC application types (Trunk, VccBearerService, 
VpcBearerService, CES over PVC) but is disabled for SPVC or SPVP 
application types. For additional information on the shortest path dialog 
box, see “Shortest path dialog box” (page 88).
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• Copy Circuit...
This command opens the Copy Circuit retrieval dialog box to create a 
new circuit with the pertinent data copied from a circuit stored in the 
Administration Database.

• Delete Circuit...
This command opens the Delete Circuit retrieval dialog box to retrieves 
the configuration data of a circuit from the Administration Database and 
lets you delete the circuit.

• Exit...
Exit... closes the main window, and exits the ATM service provisioning 
tool.

Edit menu
The Edit menu contains the commands that let you change the nodal 
configuration of the circuit.

Note: The Edit menu commands are only available for PVC circuit types 
and are disabled when you select the SPVC or SPVP circuit type.

The Edit menu contains the following options:

• Add Node After
This command adds a node to the right of the selected node in the path 
of the following circuit types: 

— trunk

— VccBearerService

— VpcBearerService

• Add Node Before
This command adds a node to the left of the selected node in the path.of 
the following circuit types:

— trunk

— VccBearerService

— VpcBearerService
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• Delete Node
This command deletes the selected node from the path. If the path only 
contains a single node, you cannot delete it; the Delete option is disabled.

Note: These menu options are also available by right-clicking on a node 
in the Circuit Path panel to open a pop-up menu.

View menu
The View menu contains the Show Messages... command. Selecting this 
command opens the Status Window which displays status information about 
the tool and the provisioning operation. See “Status Window” (page 87).

Tools menu
The tools menu contains launch points for related Preside Multiservice Data 
Manager (MDM) tools. The Tools menu contains the following commands:

• Nodal Provisioning
This command provides a launch point for the Nodal Provisioning tool. 
See 241-6001-610 Preside MDM Nodal Provisioning User Guide.

Currently, Passport accepts only one provisioning session at a time. Be 
sure that Nodal Provisioning is in read-only mode or it is closed before 
trying to apply your service. Otherwise, an error message is generated 
because the Nodal Provisioning tool holds the provisioning session. The 
error message does not inform you that this is the reason for the error 
message.

• Circuit Viewer
This command launches the Circuit Viewer tool. For information about 
the Circuit Viewer tool, see 241-6001-011 Preside MDM Fault 
Management User Guide. 

• Circuit Database Administration
This command launches the Circuit Database Administration tool. For 
information about the Circuit Database Administration tool, see 
241-6001-400 Preside MDM Administration Database User Guide. 

• ATM Traffic Management Profile Editor
This command opens the ATM Traffic Management Profile Editor. For 
additional information, see the section “ATM Traffic Management 
Profile Editor” (page 217).
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Help menu
The Help menu displays online help information. The Help menu contains the 
following command:

• About...
This command displays the name of the tool, Service Provisioning - 
ATM.

• Help on Window
This command displays the online help information for the ATM service 
provisioning tool main window.

Circuit Properties panel
The Circuit Properties panel in the ATM service provisioning window 
specifies data that applies to the entire ATM PVC, SPVC/SPVP or FrAtm 
circuit. The circuit properties panel may vary, depending on the circuit type 
that you have selected.

The Circuit Properties panel has the following fields which are common to 
trunk, VccBearerService, VpcBearerService, SPVC/SPVP, and FrAtm circuit 
types:

Note: The Circuit Properties panel for the CES over PVC circuit type 
also contains most of these fields. It does not contain the Circuit Id and 
Customer fields or the Use Circuit Id check box.

• Circuit Type
This field lets you select the type of ATM circuit that you want to set up. 
You can select one of the following from the dropdown list: 

— SPVC

— SPVP

— Trunk

— VccBearerService 

— VpcBearerService 

— CES over PVC
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— FRATM ACCESS SPVC

The default circuit type that appears when you initially open the ATM 
service provisioning tool is SPVC.

• Circuit Id
The Circuit Id lets circuit management applications more easily find and 
identify circuits based on meaningful customer names. When creating a 
circuit, this field is read-write. Otherwise, it is read-only.

Note: The Circuit Id field appears in the ATM service provisioning 
window only if you have configured the system to use an Administration 
Database. 

The Circuit Id provides a method for operators to link subscriber 
information with the virtual circuit, providing a unique and meaningful 
name to assist in the management of the circuit. A suggested format is 
“Customer Name” plus a unique identifier (for example, 
BigCustomer00000023). This format provides visibility of the end 
subscriber, while still allowing the circuit to be uniquely identified.

The Circuit Id is a 128-byte text field, with no restriction or uniqueness 
checking on the node. If the Use Circuit Id is checked, the circuit Id is 
stored in the CorrelationTag attribute of the vpc or vpd component. For 
ATM PVC it is set to the same value for all components in the end to end 
circuit. For ATM SPVCs, it is set at the source node only.

• Correlation Tag
This field is used to set the value of the correlationTag attribute to the 
entered value for each VCC/VPC component in the connection. If 
accounting collection is enabled at the ATM Interface, then setting the 
CorrelationTag turns on accounting for permanent virtual connections. If 
you do not want accounting, then you should disable accounting at the 
ATM Interface or leave the Correlation Tag field empty.

When creating or editing a circuit, this field is read-write. Otherwise, it 
is read-only.

• Use Circuit Id check box
When you select Use Circuit Id, you set the value of the correlationTag 
to the value of the Circuit Id.
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Note: This field is displayed in the ATM service provisioning window 
only if the you have configured the system to use an Administration 
Database.

• Customer
This is an optional field that lets you specify the customer of the circuit. 

Note: This field is displayed in the ATM service provisioning window 
only if you have configured the system to use an Administration 
Database.

When creating or editing a circuit, this field is read-write. Otherwise, this 
field is read-only.

• Default User ID
This field is used to indicate the default User ID and password to be used 
to log into each of the Passport switches in the ATM path during service 
provisioning. This field is always read-write.

• Default Password
This field is used to indicate the default password to be used to log into a 
Passport node. This field is always read-write.

The Circuit Properties panel also contains the following fields for SPVC/
SPVP circuit types:

• Admin Control
The Admin Control feature introduces a provisionable attribute 
(adminControl) under the SPVC or SPVP component that lets you 
specify the initial state of the SPVC/SPVP connection following initial 
provisioning and after FP restarts and software reloads. When the 
connection is locked, the VPI and VCI numbers are reserved on the 
source node of the call, but no bandwidth is used.
241-6001-600   14.3RSUP   



Chapter 4 ATM service provisioning tool user interface   51
The Circuit Properties panel also contains the following field for Trunk, 
VccBearerService, VpcBearerService, and CES over PVC circuits:

• Default TM Profile
This field contains the default Traffic Management (TM) Profile for the 
selected circuit type. 

The TM profiles define default traffic management (also known as 
Quality of Service) parameters for the circuit. You can select a TM 
profile for the circuit from a drop down list. This profile may be 
overridden for individual Vcc or Vpc components, and is specified in the 
Node Properties pane.

This Default TM Profile field is editable.The Edit TM Profiles [....] 
button to the right of the Default TM Profile drop down list opens the 
ATM Traffic Management Profile Editor dialog box. For additional 
information, see the section “ATM Traffic Management Profile Editor” 
(page 217).

The TM parameters are provided through the TM Profiles file. This file 
specifies the traffic management component attributes and values that are 
to be applied to all nodes in the path. For information on setting up this 
file, see “Information files” (page 36). 

Circuit Path panel for PVC circuit types
The Circuit Path panel is displayed for nodes in the PVC path, specifically for 
the following circuit types:

• Trunk

• VccBearerService

• VcpBearerService

• CES over PVC

The Circuit Path section is not displayed for SPVC and SPVP circuit types 
because provisioning is performed on only one node.
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The Circuit Path section displays the nodes in the PVC path. The Circuit Path 
section provides a graphical representation of the ATM circuit that you are 
provisioning. When you create a new circuit, by default, a single empty node 
is displayed in this area. 

As you add nodes, each node appears with links on one or both sides 
indicating its placement as an end node or relay node in the path. 

When you select a node, the Node Properties section displays the 
provisioning details for the node.

Each node in the path has a pop-up menu containing commands that 
correspond to the commands in the Edit menu. You can access the pop-up 
menu by selecting the node and then right-clicking. The pop-up menu options 
are:

• Add After
This command adds a node to the left of the selected node in the path. 

• Add Before
This command adds a node to the right of the selected node in the path.

• Delete 
This command deletes the selected node in the path. If the path only 
contains a single node, you cannot delete it; the Delete option is disabled.

The pop-up menu options are enabled only when creating a new circuit.

Node Properties panel 
The Node Properties panel lets you provide data that is specific to each node 
that you are configuring in the ATM connection. The fields in the Node 
Properties panel are based on the circuit type that you are configuring.

For a detailed description of the Node properties panel for PVC, SPVC, or 
FrAtm connections, see the following sections:

• “Node Properties panel for PVCs” (page 53)

• “Node Properties panel for SPVCs or SPVPs” (page 61)

• “Node Properties panel for FRATM ACCESS SPVC” (page 68)
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Node Properties panel for PVCs
You use the Node Properties panel to provide data that is specific to each node 
you are configuring in the ATM PVC path. The node being configured is 
determined by the node graphic that is selected in the Circuit Path path. For 
more information, see “Circuit Path panel for PVC circuit types” (page 51).

The fields are read only or read-write, depending on the circuit operation that 
you are performing (create, modify, or delete)

The PVC Node Properties panel contains the following common elements:

• Node Name field
Use the Node Name field to select the name of the node to be provisioned 
from the list of available nodes. The list of node names is provided by the 
Host Group Directory Server (HGDS).

• End Node check box
The End Node application instance is displayed for ATM logical trunks 
and CES PVCs only. The End Node check box is checked for the first 
node in the path. You must select End Node for the last node in the ATM 
PVC or CES ATM path. 

• Node details panels
The fields in the node details panel contains a split pane of input fields on 
the left and right sides. The details panel changes with the type of service 
being provisioned. You use these fields to provide detailed information 
about the node that you have selected in the Circuit Path. For further 
information on the contents of the node details panel for each circuit 
type, see “Node details” (page 54).

• Use Defaults check box
Use this check box to indicate whether the default user ID and password 
(see “Circuit Properties panel” (page 48)) are used to provision the 
selected node. Select Use Defaults to use the default user ID and 
password. When you deselect the defaults option, you need to type a 
specific user ID and password in the appropriate fields.

• User Id field
The User Id field is enabled only if the Use Defaults check box is 
deselected. If you are not using the default user ID, you can enter a user 
ID in this field.
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• Password field
The Password field is enabled only if the Use Defaults check box is 
deselected. If you are not using the default Password, you can enter a user 
ID in this field.

• Path navigation buttons
The path navigation buttons let you select the previous or next nodes in 
the path, displaying the configuration data in the node details area for the 
selected node. 

When a navigation button is not applicable, it is disabled (greyed out). 
For example, once you provision the last node in the path, the Next button 
has grey letters because there are no additional nodes to add. The action 
buttons are as follows:

— Back 
The Back button allows you to navigate back through the nodes in 
the path.

— Next
The Next button allows you to navigate forward through the nodes 
in the path.

You may also navigate by selecting the node in the graphical area path.

Node details
The fields in the node details panel depend on the type of service being 
provisioned. The following sections describe the node details panel for the 
various circuit types:

• “Node details for VccBearerService and VpcBearerService circuit 
types” (page 54)

• “Node details for CES over PVC circuit type” (page 56)

• “Node details for trunk circuit type” (page 59)

Node details for VccBearerService and VpcBearerService circuit 
types
For an illustration of the main window and Node Properties panel for a PVC 
circuit type, see the figure“Node details for PVC (VccBearerService)” 
(page 55).
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Figure 2
Node details for PVC (VccBearerService)

The left and right sides of the PVC details panels contain the following fields:

• ATM IF
Use this field to specify the ATM interface number.
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• VPI 
Use this field to specify the virtual path identifier number.

• VCI 
Use this field to specify the virtual channel identifier number.

Note: This field is disabled for the VpcBearerService circuit type 
(PVPs).

• Use Default TM
Use this section to indicate whether the default Traffic Management 
(TM) profile is applied to the Vcc Vcd Tm or Vpc Vpd Tm component. 
By selecting Use Default TM, you use the default TM. 

• TM Profile
Deselecting the Use Default TM Profile option, enables the TM Profile 
field. You can select a different TM profile from the TM list, to be applied 
to the current VCD or VPD.

Node details for CES over PVC circuit type
You use the CES details panel for CES end nodes.

For an illustration of the Node Details panel for a CES circuit, see the 
figure“Node details for CES over PVC” (page 57). 
241-6001-600   14.3RSUP   



Chapter 4 ATM service provisioning tool user interface   57
Figure 3
Node details for CES over PVC 
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When you select the CES over PVC Circuit Type, the input fields for the right 
details panel are the same as for the node details for PVC. 

• ATM IF
Use this field to specify the ATM interface number.

• VPI 
Use this field to specify the virtual path identifier number.

• VCI 
Use this field to specify the virtual channel identifier number.

• Use Default TM
Use this section to indicate whether the default Traffic Management 
(TM) profile is applied to the Vcc Vcd Tm or Vpc Vpd Tm component. 
By selecting Use Default TM, you use the default TM. 

• TM Profile
Deselecting the Use Default TM Profile option, enables the TM Profile 
field. You can select a different TM from the TM list, to be applied to the 
current VCC or VPD.

On the left side, the following input fields appear:

• Aal1CES 
Use this field to specify the AAL1 CES component identifier.

• Service Type
Use this field to specify the AAL1 CES service type.

— Select structured to add a TrunkConditioning component, if it 
doesn’t already exist, to the channel associated with the AALI CES 
component.

— Select unstructured to delete the Trunk Conditioning component 
from the channel associated with the AALI CES component.

• Channel
Use this field to specify the AALI CES interface. You can click the 
browse button [...] to the right of the Channel field to search the available 
channels (all channels which are not linked to an application). When you 
select the button, a search dialog box opens. You can search for available 
channels on a specific logical processor (LP) or on all LPs. See “Browse 
Channels dialog box” (page 90).
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Node details for trunk circuit type
Use the Trunk details panel for Trunk end nodes.

For an illustration of the Trunk details panel, see the figure “Node details for 
Trunk” (page 60).
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Figure 4
Node details for Trunk
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When you select the Trunk circuit type, the input fields for the right details 
panel are the same as for the node details for PVC and CES over PVC:

• ATM IF
Use this field to specify the ATM interface number.

• VPI 
Use this field to specify the virtual path identifier number.

• VCI 
Use this field to specify the virtual channel identifier number.

• Use Default TM
Use this section to indicate whether the default Traffic Management 
(TM) profile is applied to the Vcc Vcd Tm or Vpc Vpd Tm component. 
By selecting Use Default TM, you use the default TM. 

• TM Profile
Deselecting the Use Default TM Profile option, enables the TM Profile 
field. You can select a different TM from the TM drop down list, to be 
applied to the current VCC or VPD.

On the left side, the following input field appears:

• Trunk
Use this field to specify the trunk identifier. 

Node Properties panel for SPVCs or SPVPs
You use the Node Properties panel to provide data for the source and 
destination nodes of the SPVC or SPVP. Although the attributes being 
provisioned all belong to the source node, the destination node is used to look 
up the called address and to validate the destination VPI and VCI.

The node properties panel contains a split pane of input fields on the left and 
right sides. You use these fields to provide the node details for the source and 
destination nodes.

Note: The fields in the SPVC Node Properties area may be read-only or 
read-write, based on the type of circuit operation (create, modify, or 
delete) being performed. 
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For an illustration of the SPVC Node Properties panel, see the figure “Main 
window - SPVC circuit type” (page 62).

Figure 5
Main window - SPVC circuit type
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For a description of the details panel of the SPVC Node Properties area, see 
the following sections:

• “Source fields” (page 63)

• “Destination fields” (page 64)

Source fields
The following are the source application fields:

• Source Node
Use this field to enter the source node. You can click the browse button 
[...], to the right of the Source Node field to open the Browse Nodes 
dialog box to search the available nodes. When you select the button, a 
search dialog box opens. You can search for available nodes from a list 
of available nodes. The list of node names is provided by the Host Group 
Directory Server (HGDS). See “Browse Nodes dialog box” (page 92).

• Node Type
By default the source node must always be a Passport so this field is read-
only.

• Interface Type
By default the source node of an Atm SPVC must always be ATM so this 
field is read-only.

Note: This field appears only in the SPVC circuit type.

• AtmIf
Use this field to specify the instance number of the ATM interface to be 
used on the source node. You can click the browse button [...], to the right 
of the ATM IF field, to open the Browse Addresses dialog box to query 
the Passport for a list of valid AtmIfs and addresses on the node. You can 
select and AtmIf from the list. See “Browse Addresses dialog box” 
(page 93). 

• Calling Address
Use this field to specify the calling address associated with the source 
interface. This field is optional. If you do not specify a value, the node 
uses the default source ATM interface address.

• VPI
Use this field to specify the source virtual path identifier number. 
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• VCI
Use this field to specify is the source virtual channel identifier number. 
This field is disabled for the SPVP application.

• AIS Generation 
This drop down list lets you select between disabling or enabling the 
generation of an Alarm Indication Signal (AIS) to the Customer Premise 
Equipment (CPE), when the switched portion of the SPVC or SPVP is 
disconnected. By default, AIS generation is disabled. When you edit a 
circuit, this feature is in read-write mode.

• TM Profile
The Traffic Management (TM) profile defines the Quality of Service 
parameters for the connection. The default TM profile for the selected 
circuit type appears in the drop down list. 

The edit TM Profiles button [....] to the right of the TM Profile drop down 
list opens the ATM Traffic Management Profile Editor dialog box. For 
additional information, “ATM Traffic Management Profile Editor” 
(page 217).

The TM parameters are provided by the TM Profile files. When you edit 
a circuit, this attribute is read-write.

• Use Defaults 
Select the Use Defaults option to use the default user ID and password to 
provision the selected node. 

• User Id and Password
When you deselect the Use Defaults option, you need to type a specific 
User ID and password in the User Id and Password fields before you can 
log onto the node. 

Destination fields
The destination node of the circuit can be a Passport or Foreign (non-
Passport) device. The following are the destination application fields:

• Dest Node
Use this field to enter the Destination node only if the destination node is 
a Passport. This field is disabled if you have selected Foreign from the 
Node Type drop down list. You can use the browse button [...], to the right 
of the Dest Node field, to open the Browse Nodes dialog box. This dialog 
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box lets you search and select a node from a list of available Passport 
nodes. The list of node names is provided by the Host Group Directory 
Server (HGDS). See “Browse Nodes dialog box” (page 92).

• Node Type
Use the Node Type drop down list to select the destination device. The 
destination can be a Passport or a Foreign (non-Passport) device. If you 
select Foreign, the Dest Node and Interface fields become disabled. The 
Provision Destination for AIS, AIS Generation and TM Profile drop 
down lists become disabled.

• Interface Type
You can select an AtmIf or FrAtm interface from the drop down list for 
the destination end of the circuit.

• instance number 
For SPVC circuit types this field name is dynamic, and depends on 
whether you have selected an AtmIf or FrAtm interface type. For SPVP 
circuit types, the destination interface type can only be an AtmIf.

— AtmIf 
For SPVC or SPVP circuit types, this field represents the instance 
number of the ATM interface to be used on the destination Passport. 
You should fill in this field only if the destination node is a Passport. 
When you complete both the Dest Node and AtmIf fields, the tool 
looks up the address of the ATM Interface on the destination node 
and auto-populate the called address field. You can open the Browse 
Addresses dialog box by clicking the browse button [...], found to 
the right of the AtmIf field to browse a list of AtmIfs and their 
addresses on the destination node and select an AtmIf from the list. 
If an AtmIf has more than one address, you can select the desired 
address from the list. See “Browse Addresses dialog box” (page 93). 
If you type in an AtmIf instance number without using the browse 
capability, the tool queries the Passport for the default address.

— FrAtm
For SPVC circuit types, this field represents the instance number of 
the FrAtm interface to be used on the destination Passport. You 
should fill in this field only if the destination node is a Passport. 
When you complete both the Dest Node and FrAtm fields, the tool 
looks up the address of the FrAtm Interface on the destination node 
and auto-populates the called address field. If there is no FrAtm 
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interface provisioned, a provisioning error occurs and the operation 
fails. You can open the FrAtm Browse Dialog box by clicking the 
browse button [...], found to the right of the FrAtm field to browse a 
list of FrAtm Interfaces and their addresses on the destination node 
and select an FrAtm interface from the list. 

• Called Address 
For SPVC circuit types, you can specify the address of either the ATM or 
FrAtm instance. For SPVP circuit types, the called address is for the 
destination AtmIf interface.

— AtmIf Called Address
For SPVCs or SPVPs, this field specifies the address associated with 
the destination ATM interface that the source end will call. If the 
destination end is a Passport, the tool looks up the address and auto-
populates the field. If the destination end is a non-Passport, this field 
is mandatory. 

— FrAtm Called Address
For SPVCs, this field specifies the address associated with the 
destination FrAtm interface, in native X.121, E.164, or ATM address 
in NSAP format, that the source end will call. If the destination end 
is a Passport, the tool looks up the address and auto-populates the 
field. If the destination end is a non-Passport, this field is mandatory.

• TM Profile
The Traffic Management (TM) profile defines the Quality of Service 
parameters for the connection. The default TM profile for the selected 
circuit type appears in the drop down list.

The edit TM Profiles [....] button to the right of the TM Profile drop down 
list opens the ATM Traffic Management Profile Editor dialog box. For 
additional information, see “ATM Traffic Management Profile Editor” 
(page 217).

The TM Profile drop down list and edit button are disabled if you select 
Foreign as the Node Type.

The TM parameters are provided by the TM Profile files. You can specify 
the TM profile for the destination node if the destination endpoint is 
provisioned. When you edit a circuit, this attribute is in read-write mode.
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• Use Defaults 
Select the Use Defaults option to use the default user id and password to 
provision the selected node. If you deselect the Use Defaults option, you 
need to type a specific userid and password in the User Id and Password 
fields to log onto the node. 

If you have selected the SPVP circuit type, or AtmIf from the Interface Type 
drop down list for the SPVC circuit, the following fields may also appear:

• VPI
Use this field to specify the remote virtual path identifier number. When 
the configuration is applied, the service provisioning tool verifies that a 
Vcc component under the destination AtmIf, with the given called 
VpiVci does not already exist. If it does, an error message opens. The 
verification is not performed if a destination node is not specified.

• VCI
Use this field to specify the remote virtual channel identifier number. 
This field is disabled for the SPVP application.

Note: When the VPI and the VCI values are entered for the first time, the 
Called VPI and Called VCI fields are set to the same values. You can 
overwrite them. Although the values do not need to match, the same 
naming is often used for correlation purposes.

• Provision Destination for AIS check box
Select this option to create the destination endpoint at provisioning time 
and to allow the setting of the AIS generation attribute on the destination 
endpoint. If you do not select the Provision Destination for AIS, the 
service provisioning tool dynamically creates the endpoint at call setup 
time and AIS generation is disabled. 

Note: This option is disabled if you select Foreign as the Node Type.

• AIS Generation
This drop down list lets you select between disabling or enabling the 
generation of an Alarm Indication Signal (AIS) to the Customer Premise 
Equipment, when the switched portion of the SPVC or SPVP is 
disconnected. By default, AIS generation is disabled. To have AIS 
capability at the destination node, the destination must be provisioned, as 
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well as the traffic management parameters related to it. You need to 
provide the node name and ATMIF. When you edit a circuit, this feature 
is in read-write mode. 

Note:  This drop down list is disabled if you select Foreign as the Node 
Type.

If you have selected the SPVC circuit type, and FrAtm from the Interface 
Type drop down list, the following additional field appears:

• DLCI
This field specifies the DLCI on the destination node. This field is 
mandatory for both the Passport and non-Passport scenarios. If the 
destination node is a Passport, the DLCI should not already exist on the 
Passport. The tool creates it automatically. If the destination node is not 
a Foreign node (non-Passport), the DLCI should exist on the node. The 
Get Next button is enabled only if the destination node is a Passport.You 
can also click the Get Next button to automatically populate the DLCI 
field with the next available DLCI number on the Passport.

Node Properties panel for FRATM ACCESS SPVC 
You use the Node Properties panel to provide data for the source and 
destination nodes of the FrAtm circuit. The node properties panel contains a 
split pane of input fields on the left and right sides. You use these fields to 
provide the node details for the source and destination nodes.

Note: The fields in the Node Properties area may be read-only or read-
write, based on the type of circuit operation (create, modify, or delete) 
being performed. 

For an illustration of the FRATM ACCESS SPVC Node Properties panel, see 
the figure “Main window - FRATM ACCESS SPVC circuit type, for FrAtm 
to FrAtm SPVC” (page 69).
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Figure 6
Main window - FRATM ACCESS SPVC circuit type, for FrAtm to FrAtm SPVC
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For a description of the details panel of the Node Properties area, see the 
following sections:

• “Source fields” (page 63)

• “Destination fields” (page 64)

Source fields
The following are the source application fields:

• Source Node
Use this field to enter the source node. The source node must be a 
Passport. You can also click the browse button [...], to the right of the 
Source Node field to open the Browse Nodes dialog box to search the 
available Passport nodes in the network. When you select the button, a 
search dialog box opens. You can search for available nodes from a list 
of available nodes. The list of node names is provided by the Host Group 
Directory Server (HGDS). See “Browse Nodes dialog box” (page 92).

• Node Type
This field is read-only since the node type for the source side must always 
be a Passport.

• Interface Type
This field is read-only since the source of a FrAtm Access SPVC must 
always be FrAtm.

• FrAtm
Use this field to specify the instance number of the FrAtm interface to be 
used on the source Passport. You can also click the browse button [...], to 
the right of the FrAtm field, to open the FrAtm Browse Dialog box to 
query the Passport selected in the source node field for the list of FrAtm 
Interfaces on the source node. You can select an available FrAtm 
Interface from the list and also show and select an unassigned DLCI. For 
a description of the FrAtm Browse dialog box, see “FRATM Browse 
Dialog box” (page 99).

• DLCI
Use this field to specify the instance number of the DLCI to be created as 
part of the circuit on the source node. You can also click the Get Next 
button to automatically populate the DLCI field with the next available 
DLCI number on the Passport.
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• TM Profile
The Traffic Management (TM) profile defines the Quality of Service 
parameters for the connection. The default FRATMSPVC TM profile 
appears in the drop down list. 

The edit TM Profiles button [....] to the right of the TM Profile drop down 
list opens the ATM Traffic Management Profile Editor dialog box. For 
additional information, “ATM Traffic Management Profile Editor” 
(page 217).

The TM parameters are provided by the TM Profile files. When you edit 
a circuit, this attribute is read-write.

• Use Defaults 
Select the Use Defaults option to use the default user ID and password to 
provision the selected node. 

• User Id and Password
When you deselect the Use Defaults option, you need to type a specific 
User ID and password in the User Id and Password fields before you can 
log onto the node. 

Destination fields
The following are the destination application fields:

• Dest Node
Use this field to enter the destination node name. The destination can be 
a Passport or Foreign (non-Passport) device. This is an optional field and 
you should only enter a node name if the destination node is a Passport 
device. You can use the browse button [...], to the right of the Dest Node 
field, to open the Browse Nodes dialog box. This dialog box lets you 
search and select a node from a list of available Passport nodes. The list 
of node names is provided by the Host Group Directory Server (HGDS). 
See “Browse Nodes dialog box” (page 92).

• Node Type
The destination node can be a Passport or Foreign node. If you select 
Passport, all the destination fields are enabled. If you select Foreign, the 
Dest Node, and the AtmIf or FrAtm fields are disabled. The TM Profile 
drop down list is also disabled.
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• Interface Type
You can specify whether the destination end of the circuit is an AtmIf or 
FrAtm interface.

• Instance number 
This field name is dynamic, and depends on whether you have selected 
an AtmIf or FrAtm interface type:

— AtmIf 
If you select the AtmIf interface type, this field represents the 
instance number of the Atm interface to be used on the destination 
Passport. You should fill in this field only if the destination node is a 
Passport. When you complete both the Dest Node and AtmIf fields, 
the tool looks up the address of the Atm Interface on the destination 
node and auto-populate the called address field. You can open the 
Browse Addresses dialog box by clicking the browse button [...], 
found to the right of the AtmIf field. You can browse a list of AtmIfs 
and their addresses on the destination node and select an AtmIf from 
the list. If an AtmIf has more than one address, you can select the 
desired address from the list. See “Browse Addresses dialog box” 
(page 93). If you type in an AtmIf instance number without using the 
browse capability, the tool queries the Passport for the default 
address.

— FrAtm
If you select the FrAtm interface type, this field represents the 
instance number of the FrAtm interface to be used on the destination 
Passport. You should fill in this field only if the destination node is a 
Passport. When you complete both the Dest Node and FrAtm fields, 
the tool looks up the address of the FrAtm Interface on the 
destination node and auto-populate the called address field. If there 
is no FrAtm interface provisioned, a provisioning error occurs and 
the operation fails. You can open the FrAtm Browse Dialog box by 
clicking the browse button [...], found to the right of the FrAtm field. 
You can browse a list of FrAtm Interfaces and their addresses on the 
destination node and select an FrAtm interface from the list. See 
“FRATM Browse Dialog box” (page 99).

• Called Address 
Use this field to specify either the address of the ATM or FrAtm instance
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— AtmIf called address
If you have selected the AtmIf interface type, this field specifies the 
address associated with the destination ATM interface, in native 
X.121, E.164, or ATM address in NSAP format, that the source end 
will call. If the destination end is a Passport, the tool looks up the 
address and auto-populates the field. If the destination end is a non-
Passport, this field is mandatory.

— FrAtm called address
If you have selected the FRAtm interface type, this field specifies the 
address associated with the destination FrAtm interface, in native 
X.121, E.164, or ATM address in NSAP format, that the source end 
will call. If the destination end is a Passport, the tool looks up the 
address and auto-populates the field. If the destination end is a non-
Passport, this field is mandatory.

• Use Defaults 
Select the Use Defaults option to use the default user id and password to 
provision the selected node. 

• User Id and Password fields
If you deselect the Use Defaults option, you need to type a specific userid 
and password in the User Id and Password fields to log onto the node. 

If you have selected AtmIf from the Interface Type drop down list, the 
following additional fields appear in the destination side of the Node 
Properties panel:

• VPI and VCI
Use these fields to specify the VCC of the remote address.

If you have selected FrAtm from the Interface Type drop down list, the 
following additional fields appear in the destination side of the Node 
Properties panel:

• DLCI
This field specifies the DLCI on the destination node. This field is 
mandatory for both the Passport and non-Passport scenarios. If the 
destination node is a Passport, the DLCI should not already exist on the 
Passport. The tool creates it automatically. If the destination node is not 
a Foreign node (non-Passport), the DLCI should exist on the node. The 
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Get Next button is enabled only if the destination node is a Passport.You 
can also click the Get Next button to automatically populate the DLCI 
field with the next available DLCI number on the Passport

• TM Profile
The Traffic Management (TM) profile defines the Quality of Service 
parameters for the circuit. The default TM profile for the FRATM SPVC 
circuit type appears in the drop down list. The TM Profile drop down list 
is disabled it the Node Type is foreign.

The edit TM Profiles [....] button to the right of the TM Profile drop down 
list opens the ATM Traffic Management Profile Editor dialog box. For 
additional information, see “ATM Traffic Management Profile Editor” 
(page 217).

SPVC or SPVP Routing panel 
The Routing panel appears for only SPVC and SPVP circuit types. The 
Routing panel lets you enable the routing feature which lets you specify the 
routing options (Designated Transit List (DTL) path) to be taken by the SPVC 
or SPVP to establish the connection. You can provision two manual paths for 
each SPVC or SPVP; a primary path and alternate path. Initially, the tool uses 
the primary path to establish the connection. If the primary path fails, the tool 
uses the alternate path. If both fail, the service provisioning tool provides the 
Automatic Fallback option which lets you enable or disable the default PNNI 
route selection algorithm. If you enable the Automatic Fallback option, this 
algorithm calculates the routing path based on predefined criteria and traffic 
management (TM) constraints. 

You can also search the pre-configured manual DTL path names based on 
Destination Node and Path Name search criteria. See “Browse Paths dialog 
box” (page 96).

After you successfully activate the connection, it is stored in the 
Administration Database, along with the Primary Path, Alternate Path, and 
Automatic Fallback attributes.

The Routing panel contains the following items:

• “User Specified Paths” (page 75)
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• “Primary Path” (page 75)

• “Alternate Path” (page 75)

• “Browse Paths... button” (page 75)

• “Automatic Fallback” (page 75)

User Specified Paths 
The User Specified Paths check box lets you enable the routing capability. 
When this attribute is enabled, the SPVC or SPVP uses the paths that you 
specify to establish the connection. When disabled, the service provisioning 
tool uses the default PNNI route selection algorithm.

Primary Path 
The Primary Path field lets you type the name of the path that the tool initially 
uses to establish the connection.

Alternate Path 
The Alternate Path field is an optional field where you can type the name of 
a path that the tool can use to establish a connection if the primary path fails. 

Browse Paths... button
The Browse Paths... search button opens the Browse Paths dialog box. This 
dialog box lets you search and select a path from a list of valid paths on the 
source node. For additional information, see “Browse Paths dialog box” 
(page 96).

Automatic Fallback
The Automatic Fallback dropdown list provides two options:

• enable
Select enable to use the PNNI route selection algorithm it the primary 
and alternate paths fail.

• disable
Select disable to disable the PNNI route selection algorithm.
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Command panel 
The command panel appears at the bottom of the interface. This panel 
contains buttons which are used to apply the configuration that you have set 
up in the ATM service provisioning tool. The buttons found in the command 
section depend on the type of operation being performed:

• Circuit Creation

When creating a new circuit, the command panel has the following 
command button:

— Apply
This button opens the Create Circuit dialog box if you have entered 
all required configuration data. The create circuit dialog box lets you 
apply the configuration that you have set up in the ATM service 
provisioning tool. If mandatory configuration data is missing, the 
Message dialog box opens, and provides details about the missing 
data. For additional information on the Create Circuit dialog box, 
see “Create Circuit dialog box” (page 80).

• Circuit Editing 

When you are editing a circuit, the command panel has the following 
buttons:

— Validate
This button validates the circuit configuration data that you have 
retrieved from the Administration Database against the current 
Passport configuration data. If the data matches, the applicable fields 
are set to read-write and the Reset and Apply buttons are enabled. If 
there are differences in the component data, the differences are 
reported in the status window and you cannot edit the circuit. If the 
stored data is in error, you may edit the data using the Circuit 
Database Administration tool, or you can repopulate the database 
from the network. See 241-6001-400 Preside MDM Administration 
Database User Guide for relevant procedures. You can also verify 
that the Passport node is running the correct view. If not, you can 
load and activate a different view.

— Reset
This button resets all configuration data fields to the values currently 
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stored in the Administration Database, replacing any editing 
changes that you have made, but not yet applied. The Reset button is 
disabled until the circuit has been successfully validated.

— Apply
The Apply button is disabled until the circuit has been successfully 
validated. The Apply button opens the Edit Circuit dialog box, once 
you have entered all required configuration data. The Edit Circuit 
dialog box lets you apply the configuration that you have set up in 
the ATM service provisioning tool. If mandatory configuration data 
is missing, the Message dialog box opens and provides details about 
the missing data. For additional information on the Edit Circuit 
dialog box, see “Edit Circuit dialog box” (page 83).

• Circuit Deletion 
When deleting a circuit, the command area contains the following button:

— Delete
This button opens the Delete Circuit dialog box. This dialog box lets 
you delete the circuit. For additional information, see “Delete 
Circuit dialog box” (page 85).

ATM service provisioning dialog boxes
This section describes the dialog boxes available in the ATM service 
provisioning user interface. 

For dialogs boxes that are available for all connections See the following 
sections for a description of the dialog box:

• “Retrieve dialog boxes” (page 78)

• “Create Circuit dialog box” (page 80)

• “Edit Circuit dialog box” (page 83)

• “Delete Circuit dialog box” (page 85)

• “Status Window” (page 87)

For a description of the dialog boxes relating to only the PVC application, see 
the following sections:

• “Shortest path dialog box” (page 88)
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• “Browse Channels dialog box” (page 90). The Browse Channels dialog 
box applies to the CES over PVC connection only.

For a description of the dialog boxes relating to only SPVC/SPVPs, see the 
following:

• “Browse Nodes dialog box” (page 92)

• “Browse Addresses dialog box” (page 93)

• “Browse Paths dialog box” (page 96)

For a description of the dialog boxes relating to FrAtm Access SPVC see the 
following:

• “Browse Nodes dialog box” (page 92)

• “FRATM Browse Dialog box” (page 99)

• “Browse Addresses dialog box” (page 93). This dialog box is available 
on the destination when the Interface Type is an AtmIf.

Dialog boxes common to PVC, SPVC/P and FrAtm Access 
SPVC applications

The following dialog boxes and window are common to the PVC, SPVC/
SPVP and FrAtm Access SPVC applications:

• “Retrieve dialog boxes” (page 78)

• “Create Circuit dialog box” (page 80)

• “Edit Circuit dialog box” (page 83)

• “Delete Circuit dialog box” (page 85)

• “Status Window” (page 87)

Retrieve dialog boxes
The ATM service provisioning tool has a selection of retrieve dialogs boxes. 
These dialog boxes s let you retrieve a circuit from the Administration 
Database so that you can edit, copy or delete a circuit. 
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A retrieve dialog box opens when you select one of the following commands 
from the File menu in the ATM service provisioning tool window menu bar:

• Edit Circuit

• Copy Circuit

• Delete Circuit

For an example of the retrieve dialog box, see the figure “Example of a 
Retrieve dialog box” (page 79). This example shows the retrieve dialog box 
that opens you select the Edit Circuit command from the File menu.

Figure 7
Example of a Retrieve dialog box

The retrieve dialog boxes contain the following items:

• Circuit Id field
You enter the Circuit ID of the circuit to be retrieved from the 
Administration Database. If you do not know the Circuit ID, you can use 
the Circuit Viewer tool to search for the desired circuit. See 
241-6001-011 Preside MDM Fault Management User Guide for the 
procedure to search for a circuit using the Circuit Viewer tool. Selecting 
a circuit in the Circuit Viewer circuit list sets the context. When the 
retrieve dialog box opens, the Circuit Id field contains the circuit ID 
which is currently in context. You can also retrieve the current context if 
you right click the Circuit Id field and select Get Context. 

• Command buttons

— Retrieve
Selecting the Retrieve button retrieves the circuit from the 
Administration Database. If the data is successfully retrieved, the 
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dialog box closes, and the circuit data displays in the ATM service 
provisioning tool window. If two or more circuits have the same 
circuit ID, the first circuit found is used. If a circuit is not found, a 
warning message opens and the Retrieve dialog box remains open.

— Cancel
Selecting cancel closes the Retrieve dialog box and cancels the 
retrieval of circuit data.

The data that displays in the ATM service provisioning tool main window as 
a result of a successful retrieve action depends on the circuit operation that 
you have selected.

• Edit Circuit...

— The data displays as read-only until you validate the circuit.

— The Command area displays the Validate..., Reset, and Apply... 
buttons. The Validate... button is enabled. The Reset and Apply... 
buttons are disabled.

• Copy Circuit...

— The data displays as read-write.

— The data is copied from the source circuit, except for the following 
fields which remain blank: VPI, VCI, Called VPI, Called VCI, 
Trunk, AAL1 CES, Channel.

— The Command area displays the Apply... button which is enabled.

• Delete Circuit...

— The Data is displayed as read-only.

— The Command area displays the Delete... button which is enabled.

Create Circuit dialog box
The Create Circuit dialog box lets you specify how to apply the configuration 
that you have set up in the ATM Service Provisioning tool. The Create Circuit 
dialog box opens when you select the Apply button in the Command area of 
the ATM service provisioning window when you are creating a circuit. 

For an illustration of the Create Circuit dialog box, see the figure “Create 
Circuit dialog box” (page 81).
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Figure 8
Create Circuit dialog box

The Create Circuit dialog box contains the following panels:

• “Open View panel” (page 81)

• “Apply Options panel” (page 82)

• “Command buttons” (page 83)

Open View panel
The Open View panel lets you specify the view to which to apply your 
configuration changes. The Open View panel contains the following options:

• Current
Current copies the current view to the edit view.

• Committed
Committed copies the committed view to the edit view.
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• Edit
Edit uses the edit view.

• Saved
Save loads the specified view. If you select Saved, you need to select one 
of the following options from the drop down list:

— User Specified. When you select User Specified, you need to enter a 
view file name.

— Dated. When you select dated you need to enter a date in the format 
<yymmdd>, where yy is the year, mm is the month and dd is the day. 
When you enter a date, the service data view with the highest version 
number (nn) is found. When an exact match does not exist, the most 
recent service data view, relative to the date is used. That is, the dated 
service data view with the latest date earlier than the given date, and 
with the latest version number, is opened. For additional information 
on dated views, see the section Using dated MCFs in 241-6001-304 
Preside MDM Configuration Management Administrator Guide. 
The file must exist on all the Passports being configured

Apply Options panel
The Apply Options panel lets you specify how to apply the configuration 
changes. The panel contains the following check boxes.

• Save
Save saves the configuration on the node. The Type dropdown list is 
enabled and you can select one of the following format options:

— portable saves the view in portable format

— delta saves the view in delta format

— ascii saves the view in ASCII forma

When you select Save, you need to select one to the following options 
from the drop down list:

— User Specified. You need to enter a view file name in the adjacent 
text box.

— Dated. You need to enter a date in the format yymmdd. where yy is 
the year, mm is the month and dd is the day. When you enter a date, 
the view is saved with the date followed by the next version number 
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<nn> in the sequence, in the format <yymmdd><nn>. For example, 
03012903. The file is created on all nodes that are being provisioned. 
For additional information on dated views, see the section “Using 
dated MCFs” in 241-6001-304 Preside MDM Configuration 
Management Administrator Guide.

• Activate
Activate activates the configuration changes. The activation is 
automatically confirmed. If you have installed the Administration 
Database, the database is populated with the circuit data.

• Commit
Commit commits the configuration as the default at startup. Commit is 
enabled only if you have selected Activate.

Command buttons
The Create dialog box has the following command buttons

• OK
OK begins the provisioning of the nodes in the path.

• Cancel
Cancel cancels the creation of the circuit and closes the Create Circuit 
dialog box.

Edit Circuit dialog box
The Edit Circuit dialog box lets you specify how to apply the modifications 
to a configuration. The Edit Circuit dialog box opens when you click Apply 
in the Command area of the main window when you are modifying a circuit. 

Circuit modifications are always validated against and applied to the current 
view. If the changes are not activated, the changes do not appear in the current 
Passport view, nor are they updated in the Administration Database. If the 
changes are not activated, and the circuit is edited a second time, the original 
changes are not visible. 

For an illustration of the Edit Circuit dialog box, see the figure “Edit Circuit 
dialog box” (page 84).
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Figure 9
Edit Circuit dialog box

The Edit Circuit dialog box has the following apply options:

• Save
Save saves the configuration on the node. The Type dropdown list is 
enabled and you can select one of the following format options:

— portable saves the view in portable format

— delta saves the view in delta format

— ascii saves the view in ASCII format

You need to select one of the following options from the drop down list:

—  User Specified. You need to enter a view file name in the adjacent 
text box.

— Dated. You need to enter a date in the format yymmdd. where yy is 
the year, mm is the month and dd is the day. When you enter a date, 
the view is saved with the date followed by the next version number 
<nn> in the sequence, in the format <yymmdd><nn>. For example, 
03012903. The file is created on all nodes that are being provisioned. 
For additional information on dated views, see the section “Using 
dated MCFs” in 241-6001-304 Preside MDM Configuration 
Management Administrator Guide.
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• Activate
Activate activates the configuration changes. The activation is 
automatically confirmed. If you have installed the Administration 
Database, the database is populated with the circuit data.

• Commit
Commit commits the configuration as the default at startup. Commit is 
disabled until you select Activate so you cannot commit the view without 
activating the view.

• Command buttons
The Edit Circuit dialog box has the following command buttons:

— OK
OK begins the provisioning of the nodes in the path.

— Cancel
Cancel cancels the circuit modification action and close the Edit 
Circuit dialog box.

Delete Circuit dialog box
The Delete Circuit dialog box lets you specify how to apply the deletion of a 
circuit. The Delete Circuit dialog box opens when you select the Delete 
button in the Command area of the ATM service provisioning window when 
you are deleting a circuit. 

Circuit deletions are always validated against and applied to the current view. 
If the changes are not activated, the changes do not appear in the current 
Passport view, nor do they appear in the database. If you delete a circuit, and 
the change is not activated, the circuit is still in the current view and the 
Administration Database is not updated.

For an illustration of the Delete Circuit dialog box, see the figure “Delete 
Circuit dialog box” (page 86).
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Figure 10
Delete Circuit dialog box

The Delete Circuit dialog box contains the following apply options:

• Save
Save saves the configuration on the node. The Type dropdown list is 
enabled and you can select one of the following format options:

— portable saves the view in portable format

— delta saves the view in delta format

— ascii saves the view in ASCII format

You need to select one of the following options from the drop down list:

—  User Specified. You need to enter a view file name in the adjacent 
text box.

— Dated. You need to enter a date in the format yymmdd. where yy is 
the year, mm is the month and dd is the day. When you enter a date, 
the view is saved with the date followed by the next version number 
<nn> in the sequence, in the format <yymmdd><nn>. For example, 
03012903. The file is created on all nodes that are being provisioned. 
For additional information on dated views, see the section “Using 
dated MCFs” in 241-6001-304 Preside MDM Configuration 
Management Administrator Guide.
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• Activate
Activate activates the configuration changes. The activation is 
automatically confirmed. If you have installed the Administration 
Database, the database is populated with the circuit data.

• Commit
Commit commits the configuration as the default at startup. Commit is 
disabled until you select Activate so you cannot commit the view without 
activating the view.

• Command buttons
The Delete Circuit dialog box has the following command buttons:

— OK
Select OK to begin the circuit deletion. The data that is retrieved 
from the Administration Database is validated against the Passport 
configuration data. If the data matches, the deletion proceeds. If the 
component data differs, the differences are reported in the status 
window and the circuit deletion does not proceed. If the stored data 
is incorrect, you can edit the data using the Circuit Database 
Administration tool or you can repopulate the database from the 
network. For the procedure to repopulate the database, see 
241-6001-400 Preside MDM Administration Database User Guide. 
You may also verify that the Passport node is running the correct 
view. If not, you may load and activate a different view.

— Cancel
Select Cancel to cancel the circuit deletion and close the Delete 
Circuit dialog box. 

Status Window
The Status Window opens when you select the Show Messages... command 
from the View Menu in the Menu bar. The Status Window displays status 
information about the tool and the provisioning operation. 

For an illustration of the Status Window, see “Status Window” (page 88).
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Figure 11
Status Window

The status dialog box contains the following command buttons:

• Clear
Select Clear to clear the status messages.

• Close
Select Close to close the Status dialog box.

PVC dialog boxes
See the following sections for a description of dialog boxes available for PVC 
circuit types.

• “Shortest path dialog box” (page 88) is available for ATM PVCs (Trunk, 
VccBearerService, VpcBearerService and CES over PVC circuit types

• “Browse Channels dialog box” (page 90) is available for the CES over 
PVC circuit type only.

Shortest path dialog box 
The shortest path dialog opens when you select New Circuit Using Shortest 
Path... command from the File menu. This command is enabled for ATM 
PVCs (Trunk, VccBearerService, VpcBearerService and CES over PVC 
circuit types). The feature streamlines the process of selecting nodes for an 
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ATM PVC through assisted routing, that is, by determining the shortest path 
(in number of hops) between two selected end nodes and automatically 
plotting the nodes in between.

For an illustration of the shortest path dialog box, see the figure “Shortest path 
dialog box” (page 89).

Figure 12
Shortest path dialog box

The shortest path dialog box contains the following:

• Start Node 
The Start Node provides a dropdown list of available nodes from which 
you can select the first node of the circuit.

• End Node
End Node provides a dropdown list of available nodes from which you 
can select the end node of the circuit.

• Command buttons

— OK
OK initiates the plotting of the path between the selected nodes. The 
information is added to the ATM service provisioning window.

— Cancel 
Cancel ends the assisted routing operation.

— Help
Help launches the online help for the dialog box.
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Browse Channels dialog box 
The Browse Channels dialog box lets you search for and select from a list of 
available channels on a specific LP or on all LPs. This dialog box is available 
for CES over PVC circuit types only.

You open the Browse Channels dialog box by clicking the browse button [...], 
found to the right of the Channel field in the Node Properties panel of CES 
over PVC Circuit Type, opens the Browse Channels dialog box.

For an illustration of the Browse Channels dialog box, see the Figure “Browse 
Channels dialog box” (page 90).

Figure 13
Browse Channels dialog box

For a description of the parts of the Browse Channels dialog box, see the 
following sections:

• “Search Criteria area” (page 91)

• “Search button” (page 91)

• “Search Results area” (page 91)

• “Command buttons” (page 91)
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Search Criteria area
The Search Criteria area lets you specify the search parameters:

• LP field lets you search for available channels, on a specified LP or on all 
LPs, from a drop down list. The default is ALL.

• Max Num to Retrieve field lets you restrict the number of channel 
instances retrieved. The default value is 100.

Search button
Clicking the Search button populates the Search Results area with a list of 
addresses matching the search criteria.

Search Results area
The Search Results area provides a list of channels that are not linked to an 
application and that meet the search criteria. You can select the desired 
channel and press the OK button to populate the selected channel to the 
Channel field in the ATM service provisioning window.

Command buttons
The Browse Channels dialog box has the following command buttons:

• OK
OK populates the selected channel to the Channel field in the ATM 
service provisioning window and closes the dialog box.

• Cancel
Cancel closes the Browse Channels dialog box without changing the 
Channel field.

• Help
Help accesses the help information for the dialog box.

SPVC or SPVP dialog boxes
The following dialog boxes are available for SPVC and SPVP circuit types:

Note: The “Browse Addresses dialog box” (page 93) is available for the 
destination for a FRATM ACCESS SPVC when the destination Interface 
Type is AtmIf.

• “Browse Nodes dialog box” (page 92)

• “Browse Addresses dialog box” (page 93)
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• “Browse Paths dialog box” (page 96)

Browse Nodes dialog box
The Browse Nodes dialog box lets you search and select an node from a list 
of nodes available from the HGDS server. This dialog box is available for 
both the source and destination nodes.

The Browse Nodes dialog box opens when you click the browse button [...] 
found to the right of the Source Node or Dest Node fields. 

For an illustration of the Browse Nodes dialog box, see the figure “Browse 
Nodes dialog box” (page 92).

Figure 14
Browse Nodes dialog box

The Browse Nodes dialog box consists of the following elements:

• “Search Criteria panel” (page 93)

• “Search button” (page 93)

• “Search Results area” (page 93)

• “Command buttons” (page 93)
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Search Criteria panel
The Search Criteria panel has the following fields:

• Device Name
Use the Device Name field to specify the node name for the search. By 
default, the Device Name field is populated with the wildcard character 
* to retrieve all devices.

• Max Num to Retrieve 
Use the Max Num to Retrieve field to restrict the number of instances 
retrieved. You can enter a value in the field. The default value is 100.

Search button
Clicking the Search button populates the Search Results area with the node 
names matching the search criteria.

Search Results area
The Search Results area provides the results of your search. The Device 
Name area lists the available nodes. You can select the desired node.

Command buttons
The Browse Nodes dialog box has the following command buttons:

• OK
This button copies the selected node into the node field in the ATM 
service provisioning tool window and closes the dialog box.

• Cancel
Cancel closes the dialog box. The node field is unchanged in the ATM 
service provisioning window.

• Help
Help accesses the on-line help information for the dialog box.

Browse Addresses dialog box
The Browse Addresses dialog box lets you search and select an address from 
a list of valid addresses for the node. This dialog box is available for both the 
source and destination nodes.

After entering a valid device name, user ID and password, you can open the 
Browse Addresses dialog box by clicking the browse button [...] found to the 
right of the ATM IF field in either the Source or Destination Node areas.
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Note:  If you do not provide a valid device name, user ID or password, 
an message dialog box opens which indicates that you need to enter a 
Node Name, User ID, and Password. 

For an illustration of the Browse Addresses dialog box, see the figure 
“Browse Addresses dialog box” (page 94).

Figure 15
Browse Addresses dialog box

For a description of the parts of the Browse Addresses dialog box, see the 
following sections:

• “Search Criteria area” (page 95)

• “Search button” (page 95)

• “Search Results area” (page 95)

• “Command buttons” (page 95)
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Search Criteria area
The Search criteria area lets you specify the search parameters:

• AtmIf
By default the AtmIf field is populated with the Destination AtmIf value 
of the ATM service provisioning window. If not yet specified, the default 
value is ALL. Only AtmIfs that have UNI, PNNI, or IISP components 
show up.

• IfType
The IfType criteria may be UNI, IISP, PNNI, or ALL. The default value 
is ALL. The IfType restricts the search of addresses to the named type of 
AtmIf component.

• Address Type
The Address Type criteria may be default, primary, alternate or ALL. The 
default value is ALL. Primary and alternate addresses will only be listed 
if they have a TerminateSPvpAndSPvc subcomponent.

• Address Max Num to Retrieve
This criteria restricts the number of address instances retrieved. The 
default value is 100.

Search button
Clicking the Search button populates the Search Results area with a list of 
addresses matching the search criteria.

Search Results area
The Search Results area provides a list of addresses available from the 
specified node that meet the search criteria. You can select the desired 
address.

Command buttons
The Browse Addresses dialog box has the following command buttons:

• OK
OK copies the AtmIf and address that you select in the Search Results 
area into the node field on the ATM service provisioning main window 
and closes the dialog box.
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• Cancel
Cancel closes the dialog box without changing the AtmIf and Address 
fields in the ATM service provisioning main window.

• Help
Help accesses the help information for the dialog box.

Browse Paths dialog box
The Browse Paths search dialog box lets you search and select a Designated 
Transit List (DTL) path to be taken by the SPVC or SPVP from a list of valid 
paths on the source node. 

The Browse Paths search dialog box opens when you click the Browse 
Paths... button in the ATM service provisioning window for SPVC or SPVP 
circuit types after you have entered the following information:

• source node name

• user ID

• password

If you have not entered a valid source node, user ID, and password, a message 
dialog box opens prompting you to enter the missing information.
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Figure 16
Browse Paths dialog box

The Browse Paths dialog box has the following areas:

• “Search Criteria panel” (page 97)

• “Search Results panel” (page 98)

• “Path Details panel” (page 98)

Search Criteria panel
The Search Criteria panel lets you specify the search parameters:

• Path Name
The Default is the wild card (*). You can specify a path name in this field.
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• Destination Node
By default, this field contains the name of the Destination Node from the 
Destination Node field in the main window. If you have not specified a 
node name in the main window, the default is the wild card (*).

• Max Num to Retrieve
This field lets you restrict the number of instances retrieved by specifying 
a maximum number to retrieve. the default value is 50.

• Search button
When you click this button, you initiate the search and populate the 
Search Results panel with a list of Manual Designated Transit List 
(MDTL) paths which match the search criteria.

Search Results panel
The Search Results panel displays a list of MDTL paths available on the 
specified node which meet the search criteria. When you select a path, the 
path details are populated in the Path Details panel. The Search Results panel 
has the following command buttons:

• Set Primary
When you select a path in the Search Results panel, and then click the Set 
Primary button, the selected path name is copied into the Primary Path 
field in the Routing panel of the main window.

• Set Alternate
When you select a path in the Search Results panel, and then click the Set 
Alternate button, the selected path name is copied into the Alternate Path 
field in the Routing panel of the main window.

Path Details panel
When you select a path in the Search Results panel, the Path Details panel 
provides a list of nodes and port IDs that make up the selected path. If the port 
is an ATM port, and is non-zero, the port ID is mapped to its ATM IF value.

Close button
The Close button closes the dialog box.
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FRATM ACCESS SPVC dialog boxes
The following dialog box is available for the FRATM ACCESS SPVC circuit 
type:

• “FRATM Browse Dialog box” (page 99)

Note: The “Browse Addresses dialog box” (page 93) is available for the 
destination for a FRATM ACCESS SPVC when the destination Interface 
Type is AtmIf.

FRATM Browse Dialog box
The FrAtm Browse Dialog box lets you search and display FrAtm interfaces 
and their addresses. You can select a FrAtm interface from a list of available 
interfaces on the node. This dialog box is available from both the source and 
destination nodes.

The FrAtm Browse Dialog box opens when you click the browse button [...] 
found to the right of the FrAtm field in the source or destination sides of the 
Node Properties panel. 

For an illustration of the FrAtm Browse Dialog box, see the figure “FrAtm 
Browse Dialog box” (page 100).
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Figure 17
FrAtm Browse Dialog box

The FrAtm Browse Dialog box consists of the following elements:

• “Search results area” (page 100)

• “Show button” (page 100)

• “Search Results area” (page 93)

• “Command buttons” (page 93)

Search results area
The search results area displays the FrAtm Interfaces and their Addresses.

Show button
Clicking the show button populates the Unassigned DLCI area with available 
DLCIs.

Unassigned DLCI area
When you click the Show button, the Unassigned DLCI area lists the 
unassigned DLCIs. You can select a DLCI.
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Command buttons
The FrAtm Browse Dialog box has the following command buttons:

• OK
OK populates the FrAtm field in the ATM service provisioning window 
with the FrAtm interface that you have selected from the list. The dialog 
box closes.

• Cancel
Cancel closes the dialog box. The FrAtm field is unchanged in the ATM 
service provisioning window.

Using the keyboard
For ATM service provisioning, you can use the keyboard instead of the mouse 
to select a menu option, or to execute a command by using an accelerator. 
Every menu option in the menu bar has a mnemonic and an accelerator 
associated with it. See the following sections:

• “Mnemonics” (page 101)

• “Command accelerators” (page 101)

Mnemonics
Every menu option in the menu bar has a mnemonic associated with it. The 
single character that selects a given menu item is shown by the underscore 
under that letter in the name of the menu item. If there are duplicate options 
in the same menu, the second capital letter in the option is used. If there are 
no other capital letters in the menu option, then the second letter in the option 
is used.

You can use mnemonics by pressing the F10 key, entering the mnemonic for 
the menu bar option, and then entering the mnemonic for the entry that you 
want to use in the menu.

Command accelerators
The ATM service provisioning tool provides command accelerators to 
execute menu commands.The accelerators are usually the control key 
followed by the first letter of the menu option. Accelerators that are 
commonly used to reflect the options that are common to most applications 
are used.
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General provisioning procedures

This section describes the procedures that apply to any of the circuit types in 
the ATM service provisioning tool. This section contains the following 
information:

• starting the ATM service provisioning tool

— “Starting the ATM service provisioning tool from the Preside MDM 
window” (page 105)

— “Starting the ATM service provisioning tool from the Nodal 
Provisioning tool” (page 106)

— “Starting the ATM service provisioning tool from the Circuit 
Database Administration tool” (page 109)

— “Starting the ATM service provisioning tool from Circuit Viewer” 
(page 110)

• generic provisioning procedures

— “Editing an ATM circuit” (page 111)

— “Copying an ATM circuit” (page 116)

— “Deleting an ATM circuit” (page 121)

• applying provisioning changes

— “Applying service creations” (page 126)

— “Applying service modifications” (page 129)

— “Applying service deletions” (page 131)
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• “Invalid circuit conditions” (page 133)

— “Manually deleting a circuit from the network and Administration 
Database” (page 134)

— “Correcting the circuit in the network” (page 136)

Prerequisites
Before using the service provisioning tool, you need to do the following tasks:

• Ensure that all of the Passports to be provisioned are configured for ATM 
and/or CES service up to the logical connection layer. For more 
information, see “Passport configuration” (page 36).

• Set up the required information files. For details, see “Information files” 
(page 36).
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Starting the ATM service provisioning tool from the Preside 
MDM window

Use this procedure to start the ATM service provisioning tool from the 
Preside MDM window.

Procedure steps
1 Launch Preside MDM. 

/opt/MagellanNMS/bin/nmstool &

2 In the Preside MDM window, select Configuration -> Passport Devices 
-> Service Provisioning -> ATM. 

If you have installed the Administration Database, an authentication 
dialog box opens.

3 In the User name and Password fields, type a valid user name and 
password and click OK.

The Service Provisioning - ATM window opens.
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Starting the ATM service provisioning tool from the Nodal 
Provisioning tool

Use this procedure to start the ATM service provisioning tool from the 
external tools menu in Nodal Provisioning.

Procedure steps
1 Open Preside MDM.

/opt/MagellanNMS/bin/nmstool &

2 In the Preside MDM window, select Configuration -> Passport Devices 
-> Nodal Provisioning.

The Nodal Provisioning splash screen appears, and then the Device 
Selection dialog opens.

3 From the drop down list of devices, select a device and click OK.

An authentication dialog opens.

4 Complete the following steps to authenticate to the device:

a. In the Username field, enter a user name.

b. In the Password field, enter a password.

c. Click OK.

The Open View dialog box opens.

5 Select an Access Mode and View Mode and click Ok.

The Nodal Provisioning window opens.

6 From the menu bar, select External Tools -> Service Provisioning -> 
ATM.

If you have installed the Administration Database, an authentication 
dialog box opens.

7 In the User name and Password fields, type a valid user name and 
password and click OK.

The Service Provisioning - ATM window opens.
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Starting the ATM service provisioning tool from the 
Network Viewer Start Tool menu

Use this procedure to start the ATM service provisioning tool in context from 
the Network Viewer tool. When you launch the service provisioning tool from 
Network Viewer, the Network Viewer remains open and you can continue to 
use it.

The order in which you select the nodes in Network Viewer determines how 
the service provisioning tool populates its node path.

If you select more than two nodes in Network Viewer and then start the ATM 
service provisioning tool with Trunk, VCC Bearer Service or VPC Bearer 
Service, or CES over PVC, the order that you added the nodes in the Network 
Viewer window is the order in which they appear in the node path in the 
Service Provisioning - ATM window

If you select more than two nodes in Network Viewer and then start the ATM 
service provisioning tool with SPVP or SPVC, the first two nodes are used for 
context. The first node that you select is the source node. The second node 
that you select is the destination node. Other selected nodes are unused.

Procedure steps
1 Launch Preside MDM.

/opt/MagellanNMS/bin/nmstool &

2 In the Preside MDM window, select Fault -> Network Viewer.

Network Viewer opens.

3 In Network Viewer, select the nodes required to provision the ATM 
service by doing one of the following:

• click on the background of the Network Viewer window, drag the 
mouse and release it when all the desired nodes are included in the 
area where you dragged the mouse, or

• press the shift key and click on the nodes that you know have the 
required cards to provision the ATM service

4 While holding the shift key, click the right mouse button on a selected node 
and select Start Tool -> Configuration -> Service Provisioning and 
select a circuit type:
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• SPVC

• SPVP

• Trunk

• Vcc Bearer Service

• VPC Bearer Service

• CES over PVC

• FRATM ACCESS SPVC

If you have installed the Administration Database, an authentication 
dialog box opens. Proceed to step 5.

If you have not installed the database, the Service Provisioning - ATM 
window opens.

5 In the User name and Password fields, enter a valid user name and 
password.

The Service Provisioning - ATM window opens. The node path contains 
all the nodes selected in the Network Viewer. The selected application 
type appears in the Application Type field of the main window.
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Starting the ATM service provisioning tool from the Circuit 
Database Administration tool

Use this procedure to start the ATM service provisioning tool from the Circuit 
Database Administration tool.

Procedure steps
1 In the Preside MDM window, select System -> Administration -> 

Circuit Database Administration.

An authentication dialog box opens.

2 In the User name and Password fields, type a valid user name and 
password.

The Circuit Database Administration window opens.

3 From the tools menu in the Circuit Database Administration window, 
select Tools -> ATM Service Provisioning.

The Service Provisioning - ATM window opens.
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Starting the ATM service provisioning tool from Circuit 
Viewer

Use this procedure to open the ATM service provisioning tool from Circuit 
Viewer. 

Procedure steps
1 In the Preside MDM window, select Fault -> Circuit Viewer.

An authentication dialog box opens.

2 In the User name and Password fields, type a valid user name and 
password.

The Circuit Viewer window opens.

3 From the tools menu in the Circuit Viewer window, select Tools -> ATM 
Service Provisioning.

The Service Provisioning - ATM window opens.
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Editing an ATM circuit 
Use this procedure to edit an ATM circuit.

Note: You can also edit a circuit using the Circuit Database 
Administration tool. However, if you use this tool to edit a circuit, the 
changes are only reflected in the Administration Database, not on-
switch.

This procedure uses the Circuit Viewer tool to find the circuit to be edited. 
Alternatively, you can also select the Edit Circuit command from the File 
menu, and type a valid circuit ID in the Circuit Id field. If the circuit ID that 
you type does not belong to any circuit in the Administration Database, an 
error message displays.

Editing a VCC Bearer Service, VPC Bearer Service or Trunk
You can edit both the node configuration of the circuit path or attributes of the 
nodes which make up the circuit.

You can edit the following for VCC Bearer Service, VPC Bearer Service and 
Trunk:

• Trunk

• AtmIf

• VPI and VCI

• default and node specific TM profiles

• customer

• correlationTag

The following table shows the Edit menu commands that let you modify the 
node configuration of the nodes that make up a VCC Bearer Service, VPC 
Bearer Service or Trunk circuit path, and the corresponding pop-up menu 
commands.
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Editing a SPVC or SPVP 
For SPVC/SPVP circuits, you can change the node name for the Source Node 
and Dest Node. Since this circuit consists of two nodes changing either one 
modifies the circuit. 

Note: The ability to change the destination node name, and its attributes 
is available in Passport software release PCR4.2 and above and will 
depend on whether the AIS option has been set.

All fields, except the circuit ID are editable:

• AtmIf

• callingAddress

• calledAddress

• calledVpiVci for SPVC and for SPVP called Vpi is also editable

• default TM profile

• adminControl

• customer

• AIS Generation attribute

• Mdtl usage, and primaryPath, alternatePath, and automaticFallback 
attributes

• correlationTag 

The Edit menu commands are disabled for SPVC and SPVP connections.

Edit menu commands Pop-up menu commands

Add Node After Add After

Add Node Before Add Before

Delete Node Delete
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Prerequisites
Before proceeding with this procedure you need to know the circuit ID of the 
circuit that you want to edit.

Procedure steps
1 You can use the Circuit Viewer to retrieve and select the circuit that you 

want to edit. For the procedure to retrieve circuits, see 241-6001-011 
Preside MDM Fault Management User Guide.

If you use the Circuit Viewer to retrieve and select a circuit, the Circuit 
Id field displays the circuit ID that you selected in the Circuit Viewer tool.

If you decide not to use the Circuit Viewer, proceed to step 2.

2 In the File menu of the ATM Service Provisioning tool window, select Edit 
Circuit... .

The Edit Circuit dialog opens. 

Enter a circuit ID in the Circuit Id field.

Note:  You can change your selection of circuit id by selecting another 
circuit in the Circuit Viewer and then selecting the Get Context menu 
item in the Circuit Id field pop-up menu. The Circuit Id field in the Delete 
Circuit dialog is populated with the newly selected circuit ID.

3 Click Retrieve.

If the circuit is found, the ATM service provisioning window is populated 
with the circuit data.

If more than one circuit matching the query is found, a dialog opens listing 
the matching circuits. Select the correct circuit and click OK.

The data displayed in the Circuit Properties and Node Properties 
sections matches the data displayed in the Circuit Viewer. The data is 
displayed in read-only mode. The Default User Id and Default Password 
fields are enabled. The Validate button is displayed and enabled. The 
Reset and Apply buttons are displayed and disabled.
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Click Cancel if you want to end the operation. The Edit Circuit dialog 
closes.

4 In the Default User Id and Default Password fields, type the default user 
ID and password to provision the Passports nodes in the path.

You can override the default user ID and password for a selected node in 
the path by deselecting the Use Defaults option and then entering a new 
userid and password.

5 In the command section of the main window, click Validate... .

The data that was retrieved from the Administration Database is validated 
against the current Passport configuration data. If the retrieve operation is 
successful and the data matches, a message indicates that the circuit is 
valid. The Reset and Apply buttons are enabled. Proceed to step 6.

If the validate action fails because the circuit in the Administration 
Database is invalid, a dialog opens with the message that the circuit does 
not match the on-switch data. This indicates that one or more of the 
provisioned components no longer exist in the network. 

The Reset and Apply buttons in the main window are not enabled and the 
provisioning data fields remain read-only.

If you click View -> Show Messages... in the main window, the messages 
dialog box displays the information on the first component that was found 
to be invalid. The service provisioning tool does not detect all invalid 
components. 

Click OK in the Message dialog box and refer to “Invalid circuit conditions” 
(page 133) for the procedure to correct an invalid circuit condition.
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6 Modify the circuit data.

Optionally, if at any time you want to return to the original data stored in 
the Administration Database, click Reset. Any fields that you edited are 
reset to their original value

7 To apply the configuration changes, click Apply. 

The Confirm ATM Circuit Changes dialog box opens summarizing the 
changes made to the circuit.

8 To confirm the circuit changes before they are applied, click OK.

To cancel the changes, click Cancel.

If mandatory data is missing, a message dialog opens specifying the 
missing data. Enter the missing data and click OK.

If you clicked OK and there are no missing data, the Edit Circuit dialog 
box opens.

9 Apply the circuit modifications. See “Applying service modifications” 
(page 129).

After clicking Apply, the circuit is automatically revalidated. If there are 
differences in the component data, the differences are reported in the 
status window, and the circuit changes are not applied.

If the stored data is incorrect, you can edit the data using the Circuit 
Database Administration tool, or repopulate the database from the 
network. For the procedures to edit the data and repopulate the database, 
see 241-6001-400 Preside MDM Administration Database User Guide. 
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Copying an ATM circuit 
This procedure uses the Circuit Viewer tool to find the circuit to be copied. 
Alternatively, you can also select the Copy Circuit... command from the File 
menu, and type a valid circuit id in the Circuit Id field. If the circuit id that 
you type does not belong to any circuit in the Administration Database, an 
error message displays.

When you copy an ATM circuit, the following occurs on the Passport:

• VCC Bearer Service
When copying a VCC connection, the ATM service provisioning tool 
copies the following:

— the nodes in the path 

— the source and destination AtmIfs

— the default and node specific TM profiles

— the customer

• VPC Bearer Service
When copying a VCC connection the ATM service provisioning tool 
copies the following data:

—  nodes in the path

—  source and destination AtmIfs

— default and node specific TM profiles

— customer

• Trunk
When copying a Trunk over PVC connection, the ATM service 
provisioning tool copies the following data:

— nodes in the path

— source and destination AtmIfs

— default and node specific TM profiles

—  customer

• When copying an SPVC connection, the ATM service provisioning tool 
copies the following data:
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— source node

— destination node, if known

— source AtmIf

— destination AtmIf, if known

—  calling and called address

— customer

— adminControl state

— AIS generation attribute

— Mdtl usage, and primaryPath, alternatePath and automaticFallback 
attributes

• When copying an SPVP connection, the ATM service provisioning tool 
copies the following data:

— source node

— destination node, if known

— source AtmIf

— destination AtmIf, if known

— calling and called address

— customer

— adminControl state

— AIS generation attribute

— Mdtl usage, and primaryPath, alternatePath and automaticFallback 
attributes

• When copying a FrAtm to FrAtm SPVC, the ATM service provisioning 
tool copies the following data:

— source node

— destination node, if known

— source FrAtm

— destination FrAtm, if known
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— called address

— customer

• When copying a FrAtm to ATM SPVC, the ATM service provisioning 
tool copies the following data:

— source node

— destination node, if known

— source FrAtm

— destination AtmIf, if known

— called address

— customer

• When copying an ATM to FrAtm SPVC, the ATM service provisioning 
tool copies the following data:

— source node

— destination node, if known

— source AtmIf

— destination FrAtm, if known

— called address

— customer

— adminControl state

Prerequisites
Before proceeding with this procedure you need to know the circuit ID of the 
circuit that you want to copy.

Procedure steps
1 You can use the Circuit Viewer to retrieve and select the circuit that you 

want to copy. For the procedure to retrieve circuits, see 241-6001-011 
Preside MDM Fault Management User Guide.

If you decide not to use the Circuit Viewer, proceed to step 2.

2 In the File menu of the ATM Service Provisioning tool main window, select 
Copy Circuit... .
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The Copy Circuit dialog opens. If you have used the Circuit Viewer to 
retrieve and select a circuit, the Circuit Id field displays the circuit ID that 
you selected in the Circuit Viewer tool. 

Otherwise, enter a circuit ID in the Circuit Id field.

3 Click Retrieve.

If the circuit is found, the ATM service provisioning window is populated 
with the circuit data.

If more than one circuit matching the query is found, a dialog opens listing 
the matching circuits. Select the correct circuit and click OK.

For PVC, Trunk, and PVP circuits, the following data matches the data 
shown in Circuit Viewer:

• nodes in the path

• source and destination AtmIfs

• default and node specific TM profiles

• customer

• correlationTag (for Trunk circuits)

For SPVC and SPVP circuits, the following data matches the data shown 
in Circuit Viewer:

• source node

• source AtmIf

• calling and called address

• customer

• adminControl state

4 Complete the circuit data.

5 In the command area, click Apply... .
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6 The Create Circuit dialog opens.

7 Apply the configuration changes as described in “Applying service 
creations” (page 126).
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Deleting an ATM circuit 
You can use the Circuit Viewer tool to find and retrieve the circuit to be 
deleted. Alternatively, you can select the Delete Circuit... command from the 
File menu, and type a valid circuit ID in the Circuit Id field. If the circuit ID 
that you type does not belong to any circuit in the Administration Database, 
an error message displays.

The following happens on the Passport when you delete a circuit:

• VCC Bearer Service
When deleting a VCC connection, the source and destination VCC 
components are deleted on each Passport node in the path.

• VPC Bearer Service
When deleting a VPC connection, the source and destination VPC 
components are deleted on each Passport node in the path.

• Trunk
When deleting a Trunk over PVC connection, 

— the Trunk component and VCC component that is linked to the 
Trunk, are deleted on each end node in the path

— the source and destination VCC components are deleted on each 
relay node in the path 

• SPVC
When deleting an SPVC connection, the VCC component is deleted at 
the source node.

If the destination end is provisioned, the ATM service provisioning tool 
deletes the VCC component at the destination node.

• SPVP
When deleting an SPVP connection, the VPC component is deleted at the 
source node.

If the destination end point is provisioned, the service provisioning tool 
deletes the Vpc component from the destination node.
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• FrAtm to FrAtm SPVC
deletes the DLCI component on the source node. If the destination node 
is a Passport then the DLCI component is deleted on the destination 
node.

• FrAtm to ATM SPVC
deletes the DLCI component on the source node.

• ATM to FrAtm SPVC
deletes the VCC component on the source node. If the destination node 
is a Passport and the destination node is known, the DLCI component is 
deleted on the destination node.

Deleting a FrAtm circuit whose destination node is not known, either because 
the destination is a foreign node or because the circuit was not created with 
the ATM service provisioning tool and discovered by circuit discovery, will 
result in a dangling DLCI on the destination node.

The following occurs in the Administration Database:

• for PVCs, the circuit and VCC components are deleted

• for PVPs, the circuit and VPC components are deleted

• for SPVCs, the circuit and VCC components are deleted

• for SPVPs, the circuit and VPC components are deleted

• for trunks, the circuit, Vcc, trunk, and AtmAc components, are deleted

Prerequisites
Before proceeding with this procedure you need to know the circuit ID of the 
circuit that you want to delete.

Procedure steps
1 You can use the Circuit Viewer to retrieve and select the circuit that you 

want to delete. For the procedure to retrieve circuits, see 241-6001-011 
Preside MDM Fault Management User Guide.

If you decide not to use the Circuit Viewer, proceed to step 2.

2 In the File menu of the ATM service provisioning tool window, select the 
Delete Circuit... command.
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The Delete Circuit dialog box opens. If you used the Circuit Viewer to 
select and retrieve the circuit, the Circuit Id field displays the circuit ID 
that you selected in the Circuit Viewer tool.

Otherwise, enter a circuit ID in the Circuit Id field.

Note:  You can change your selection of circuit ID by selecting another 
circuit in the Circuit Viewer and then selecting the Get Context menu 
item in the Circuit Id field popup menu. The Circuit Id field in the Delete 
Circuit dialog is populated with the newly selected circuit ID.

3 Click Retrieve.

If the circuit is found, the ATM service provisioning window is populated 
with the circuit data.

If more than one circuit matching the query is found, a dialog opens listing 
the matching circuits. Select the correct circuit and click OK.

The data is displayed in read-only mode.

4 In the Default User Id and Default Password fields, type the default user 
ID and password to provision the Passports nodes in the path.

You can override the default user ID and password for a selected node in 
the path by deselecting the Use Defaults option and then entering a new 
user ID and password.

5 In the command section of the main window, click Delete....
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The Delete Circuit dialog opens.

6 Apply the service deletion. See “Applying service deletions” (page 131).

The data that was retrieved from the Administration Database is validated 
against the current Passport configuration data. If the retrieve operation is 
successful and the data matches, the circuit is deleted.

If the validate action fails because the circuit in the Administration 
Database is invalid, a dialog opens with the message that the circuit does 
not match the on-switch data. This indicates that one or more of the 
provisioned components no longer exist in the network.

The delete action does not occur.

If you click View -> Show Messages... in the main window, the messages 
dialog box displays the information on the first component that was found 
to be invalid. The service provisioning tool does not detect all invalid 
components.
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Click OK in the Message dialog box and refer to “Invalid circuit conditions” 
(page 133) for procedures to correct an invalid circuit condition.
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Applying service creations
Use the following procedure to apply a new circuit.

Prerequisites
This procedure requires that the following conditions are met:

• you have created a new circuit. See “ATM permanent virtual 
connections” (page 139)“ATM soft permanent virtual path and soft 
permanent virtual channel connections” (page 173), and “Frame relay to 
ATM circuits” (page 191).

• You have clicked Apply in the main window and opened the Create 
Circuit dialog box.

Procedure steps
1 In the Open View panel, select one of the following view options to which 

you want to apply the configuration changes:

• Select Current to copy the current view into the edit view.

• Select Committed to copy the committed view into the edit view.

• Select Edit to use the existing edit view
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• Select Saved and then select either User Specified or Dated from 
the drop down list. 

If you select User Specified, enter a file name in the adjacent text box.

If you select Dated, enter a date in the format yymmdd. where yy is 
the year, mm is the month and dd is the day. When you enter a date, 
the service data view with the highest version number <nn> is found. 
When an exact match does not exist, the most recent service data 
view, relative to the date is used. That is. the dated service data view 
with the latest date earlier that the given date, and with the latest 
version number, is opened. For additional information on dated 
views, see the section Using dated MCFs in 241-6001-304 Preside 
MDM Configuration Management Administrator Guide.

2 To save the configuration on the node, in the Apply Options panel, select 
Save. 

3 From the Type dropdown list, select one of the following format options:

• portable saves the view in portable format

• delta saves the view in delta format

• ascii saves the view in ASCII format

4 From the drop down list, select one of the following options:

• User Specified. Enter a view file name in the adjacent text box.

• Dated. Enter a date in the format yymmdd. where yy is the year, mm 
is the month and dd is the day. When you enter a date, the view is 
saved with the date followed by the next version number <nn> in the 
sequence, in the format <yymmdd><nn>. For example, 03012903. 
The file is created on all nodes that are being provisioned. For 
additional information on dated views, see the section “Using dated 
MCFs” in 241-6001-304 Preside MDM Configuration Management 
Administrator Guide.

5 To activate the new configuration, select Activate.
The activation is automatically confirmed. If you have installed the 
Administration Database, the database is populated with the circuit data.

6 To commit the configuration as the default on startup, select Commit. You 
must have selected Activate before you can select the Commit option.

7 Click OK.
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Provisioning information and error messages, if any occur, display in the 
status area while the connection is being set up. The Create Circuit 
dialog box closes.
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Applying service modifications
Use this procedure to apply the configuration changes when you modify or 
delete a circuit.

The ATM service provisioning tool begins the apply process by re-
provisioning any Passport devices that have been affected by the changes. 
These changes may include deleting nodes, adding nodes anywhere in the 
circuit, and may involve removing components from some devices, adding 
components to others, and changing component attribute values on others.

Following the re-provisioning, the new provisioning data is stored in the 
Administration Database. The modified circuit can be monitored from the 
Circuit Viewer tool.

Prerequisites
This procedure requires the following conditions are met:

• you have modified the node configuration of the circuit or modified node 
attributes. See “Editing an ATM circuit” (page 111) 

• you have clicked Apply in the main window and confirmed your editing 
changes. The Edit Circuit dialog box has opened.

Figure 18
Edit Circuit dialog box

Procedure steps
1 To save the configuration on the node, from the Apply Options panel, 

select Save.
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2 From the Type drop down list, select one of the following format options:

• portable saves the view in portable format.

• delta saves the view in delta format

• ascii saves the view in ASCII format

3 From the drop down list, select one of the following options:

• User Specified. Enter a view file name in the adjacent text box.

• Dated. Enter a date in the format yymmdd. where yy is the year, mm 
is the month and dd is the day. When you enter a date, the view is 
saved with the date followed by the next version number <nn> in the 
sequence, in the format <yymmdd><nn>. For example, 03012903. 
The file is created on all nodes that are being provisioned. For 
additional information on dated views, see the section “Using dated 
MCFs” in 241-6001-304 Preside MDM Configuration Management 
Administrator Guide.

4 Select Activate to activate the new configuration.

The activation is automatically confirmed. If you have installed the 
Administration Database, the database is populated with the circuit data.

5 To commit the configuration as the default at startup, select Commit. You 
need to select the Activate option before you can select the Commit 
option. 

6 Click OK.
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Applying service deletions 
Use this procedure to apply the configuration changes when you delete a 
circuit.

Prerequisites
This procedure requires the following conditions are met:

• you have modified the node configuration of the circuit or modified node 
attributes. See “Deleting an ATM circuit” (page 121)

• you have clicked Delete in the command section of the main window. 
The Delete Circuit dialog box is open.

Figure 19
Delete Circuit dialog box

Procedure steps
1 To save the configuration on the node, select Save. 

2 From the Type dropdown list, select one of the following format options:

• portable saves the view in portable format

• delta saves the view in delta format

• ascii saves the view in ASCII format

3 From the drop down list, select one of the following options:

• User Specified. Enter a view file name in the adjacent text box.

• Dated. Enter a date in the format yymmdd. where yy is the year, mm 
is the month and dd is the day. When you enter a date, the view is 
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saved with the date followed by the next version number <nn> in the 
sequence, in the format <yymmdd><nn>. For example, 03012903. 
The file is created on all nodes that are being provisioned. For 
additional information on dated views, see the section “Using dated 
MCFs” in 241-6001-304 Preside MDM Configuration Management 
Administrator Guide

4 To activate the new configuration, select Activate.

The activation is automatically confirmed. If you have installed the 
Administration Database, the database is populated with the circuit data.

5 To commit the configuration as the default on startup, select Commit. You 
must have selected the Activate option before you can select the Commit 
option.

6 Click OK.
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Invalid circuit conditions
Use the following procedures to resolve an invalid circuit condition. An 
invalid circuit condition may occur in the following circumstances:

• the Administration Database is not synchronized with the network

• erroneous provisioning changes have occurred in the network

To resolve an invalid circuit condition, you can take the following actions:

• remove the circuit from both the database and the network by using one 
of the following procedures:

— reload the affected nodes into the Administration Database. For the 
relevant procedure, refer to 241-6001-400 Preside MDM 
Administration Database User Guide.

— manually remove the circuit from both the Administration Database 
and the network. See “Manually deleting a circuit from the network 
and Administration Database” (page 134).

• fix the circuit in the network so that it aligns with the Administration 
Database. This is achieved by provisioning the missing pieces in the 
network. See “Correcting the circuit in the network” (page 136).
Preside MDM Service Provisioning for ATM User Guide   14.3RSUP



134   Chapter 5 General provisioning procedures
Manually deleting a circuit from the network and 
Administration Database

Use this procedure to manually delete a circuit from the Administration 
Database and the network when you have an invalid circuit condition. An 
invalid circuit condition occurs when a circuit is validated against the on-
switch data and it is found that one or more of the provisioned components no 
longer exist on the network. This situation generates a message that the circuit 
does not match the on-switch data.

Procedure steps
1 Before deleting the circuit from the database, determine if there are any 

components of the circuit still provisioned in the network.

To identify data still provisioned in the network, you need to locate the 
invalid circuit using the Circuit Viewer tool:

Note:  Refer to the Circuit Viewer section in 241-6001-011 Preside MDM 
Fault Management User Guide for procedures to use the Circuit Viewer 
tool.

a. Open Circuit Viewer and locate the invalid circuit using the Circuit 
Retrieval Criteria panel.

b. From the Circuit(s) found list, select the circuit.

c. Right-click on the circuit and from the pop-up menu, select Start 
State Polling.

d. In the Circuit details panel, select the Circuit components tab.

The state of all components is displayed in the State column. 
Components that are marked “purple” no longer exist in the network. 
All other components, independent of the state reported, exist in the 
network.

2 Manually delete all VCC components using one of the following methods:

• the delete component capability of the Nodal Provisioning tool. 
Refer to 241-6001-610 Preside MDM Nodal Provisioning User 
Guide for the relevant procedure.

• the Passport command line interface via telnet

Note:  You need to log into each node on which components for the circuit 
exist, check for the presence of the components, and delete each 
component found. Once all necessary components on a given node are 
deleted, you need to activate the view.
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3 Once the circuit is completely removed from the network, use the Circuit 
Database Administration tool to delete the circuit from the database. For 
the relevant procedure, refer to 241-6001-400 Preside MDM 
Administration Database User Guide.
Preside MDM Service Provisioning for ATM User Guide   14.3RSUP



136   Chapter 5 General provisioning procedures
Correcting the circuit in the network
Use this procedure to provision the missing pieces in the network to align the 
circuit with the Administration Database. An invalid circuit condition occurs 
when a circuit is validated against the on-switch data and it is found that one 
or more of the provisioned components no longer exist on the network. This 
situation generates a message that the circuit does not match the on-switch 
data.

Procedure steps
1 Before correcting the circuit in the network to align with the Administration 

Database, determine which components are missing and if there are any 
components of the circuit still provisioned in the network.

To identify data still provisioned in the network, you need to do the 
following tasks:

• Open the ATM service provisioning tool to view the components of 
the circuit (for instance, its interfaces and circuit pieces). These 
components can span several nodes.

• log into each participating node and check for the presence of the 
components. This can be done using either the Nodal Provisioning 
tool (see 241-6001-610 Preside MDM Nodal Provisioning User 
Guide) or Passport command line interface via telenet.

2 Once you have determine which components are missing, use one of the 
following methods to correct the circuit in the network:

• reload views onto the nodes that are improperly configured. You can 
only use this approach if the provisioning error was a result of an 
incorrect view being loaded onto a node. Although MDM does not 
provide a system that provides history of views loaded onto the 
nodes in the network, there are several MDM tools that can assist in 
this process. including the Configuration Repository and the Network 
Reporting System. For information on these tools, see 241-6001-400 
Preside MDM Administration Database User Guide and 
241-6001-022 Preside MDM Network Reporting System User Guide. 
Once you have made the network corrections, you can use the ATM 
service provisioning tool to validate the circuit. It will mark the circuit 
as “Normal” in the Administration Database so it becomes 
manageable.

• delete the circuit from both the database and the network and re-
provision the entire circuit. You need to use this approach when the 
provisioning cannot be corrected by reloading the views onto the 
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nodes. First record the nodes, interfaces, connection components 
(VPC/VCC, DLCI), customer, and traffic management profiles using 
the procedures described in step 1. Then follow the procedure 
“Manually deleting a circuit from the network and Administration 
Database” (page 134) to delete the circuit. Once the circuit is 
deleted, you can use the service provisioning tool to provision the 
circuit, using the information that you recorded.
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ATM permanent virtual connections

The ATM service provisioning tool is used to create the following ATM 
permanent virtual (PVC) connections over one or more Passport nodes:

• ATM PVC - Vcc Bearer Service

• ATM PVC - Vpc Bearer Service

• ATM PVC - Trunk over ATM PVC

• CES over ATM PVC

 Once you have successfully activated the provisioning data, they are stored 
as a circuit in the Administration Database. 

This section contains the following information:

• “Prerequisites” (page 140)

• basic procedures

— “Adding a node before or after a selected node” (page 141)

— “Deleting a node within a circuit” (page 142)

— “Deleting all nodes in a path” (page 144)

— “Using assisted routing” (page 145)

• “Creating an ATM PVC - VCC Bearer Service” (page 147)

— “Configuring the first node” (page 148)

— “Configuring additional nodes” (page 150)
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• “Creating an ATM PVP - VPC Bearer Service” (page 152)

— “Configuring the first node” (page 153)

— “Configuring additional nodes” (page 155)

• “Creating a Passport Trunk over ATM PVC” (page 157)

— “Configuring the first node” (page 159)

— “Configuring relay nodes” (page 161)

— “Configuring the end node” (page 162)

• “Creating a CES over ATM PVC connection” (page 164)

— “Configuring the first node” (page 165)

— “Configuring one or more relay nodes” (page 168)

— “Configuring the end node” (page 170)

Prerequisites
Before using the service provisioning tool, you need to do the following tasks:

• Ensure that all of the Passports to be provisioned are configured for ATM 
and/or CES service up to the logical connection layer. For more 
information, see “Passport configuration” (page 36).

• Set up the required information files. For details, see “Information files” 
(page 36).
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Adding a node before or after a selected node
Use this procedure to add a single node before or after a selected node for the 
following PVC circuit types:

• Trunk

• VccBearerService

• VpcBearerService

• CES over PVC

You can add a node before or after a selected node. The VPI and VCI values 
and the TM profiles of each side of the new node is the same as the 
corresponding adjacent node. 

If the node is inserted before the first node in the circuit, the node is 
automatically de-selected as an end node and the new node is made the first 
node. The trunk information for the original end node is moved to the new end 
node.

Procedure steps
1 Complete one of the following steps:

2 To add a node to the left of the selected node

• In the Circuit Path section of the main window, right-click on a node 
and from the pop-up menu select Add Before.

• In the File menu, select Edit -> Add Node Before.

To add a node to the right of the selected node, complete one of the 
following steps:

• In the Circuit Path section of the main window, right-click on a node 
and from the pop-up menu select Add After.

• In the File menu, select Edit -> Add Node After.
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Deleting a node within a circuit
Use the following procedure to delete a node anywhere in an ATM PVC path 
for the following circuit types:

• Trunk

• VccBearerService

• VpcBearerService

• CES over PVC

If the deleted node is the first one in the circuit, the node to the right becomes 
the first node. If the last node is deleted, the node to the left becomes the new 
end node. In both cases, the trunk value for the old end node becomes the 
trunk for the new end node. 

If the end (that is, last) node of a two node circuit is deleted, no changes are 
made to the remaining node. If the first node of a two node circuit is deleted, 
the VPI, VCI, and Trunk information is cleared on the remaining node. If only 
a single node exists in the Circuit Path, it cannot be deleted. The Delete Node 
command in the Edit menu, and the Delete command in the node’s pop-up 
menu, are disabled. 

Procedure steps
1 In the Circuit Path section of the ATM service provisioning window, 

click on the node that you wish to delete.

2 Complete one of the following steps:

• Right-click and select Delete from the pop-up menu.

• From the Edit menu, select Delete Node.

When a non end node is deleted, and the destination values of the left 
node are not the same as the source values of the right node, you are 
prompted to take one of the following actions with regard to the VCI and 
VPI values of the adjacent nodes of the deleted node:

• leave the value as is

• set the values to the destination side of the left node

• set the values to the source side of the right node

3 Select an option and click OK.
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4 In the command panel, click Apply.

A confirmation dialog box opens stating that the node will be deleted.

5 In the confirmation dialog, select OK to delete the circuit.

If you do not wish to delete the circuit, select Cancel.

If you wish to restore the circuit, click Reset.

6 Apply the deletion. See the procedure “Applying service modifications” 
(page 129).
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Deleting all nodes in a path
Use the following procedure to delete all nodes in an ATM PVC path for the 
following circuit types:

• Trunk

• VccBearerService

• VpcBearerService

• CES over PVC

Procedure steps
1 In the ATM service provisioning window, select File -> New Circuit.

All the nodes, except the first node, are cleared from the circuit path.
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Using assisted routing
The ATM service provisioning tool provides an assisted routing feature to 
streamline the process of selecting nodes for ATM PVC circuit types:

• Trunk

• VccBearerService

• VpcBearerService

• CES over PVC

The assisted routing feature determines the shortest path (in number of hops) 
between two selected end nodes and automatically plots the nodes in 
between. 

Procedure steps
1 From the Service Provisioning - ATM window, select File -> New Circuit 

Using Shortest Path....

The New Circuit dialog opens.

2 Select a node in the Start Node field.

3 Select a node in the End Node field.

4 Click OK.

The tool plots the path between the selected nodes and adds this 
information to the Service Provisioning - ATM window. 

Note:  If the tool cannot determine a path between the selected nodes, an 
error message opens.
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Creating ATM PVC circuits
The ATM service provisioning tool is used to create ATM connections over 
one or more Passport nodes. Once you have successfully activated the 
provisioning data, they are stored as a circuit in the Administration Database. 
See the following sections for procedures to create the following connections:

• “Creating an ATM PVC - VCC Bearer Service” (page 147)

• “Creating an ATM PVP - VPC Bearer Service” (page 152)

• “Creating a Passport Trunk over ATM PVC” (page 157)

• “Creating a CES over ATM PVC connection” (page 164)

• “Using assisted routing” (page 145)
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Creating an ATM PVC - VCC Bearer Service
This section describes the procedures to provision an ATM PVC on a 
Passport. When creating a VCC connection, the ATM service provisioning 
tool performs the following at each Passport node in the path:

• creates a VCC subcomponent on the source and destination AtmIf. If an 
AtmIf component does not exist, the operation ends. If a Vcc component 
already exists, the operation ends.

• creates Nrp subcomponents on the Vccs and links them

• sets the TM attributes on the Vcd Tm subcomponents of the Vccs

• sets the Vcc Vcd correlationTag for all Vccs

The Administration Database is populated with the following circuit data:

• circuit ID - set to the value of the circuit id field

• circuit type - set to ATM_PVC

• flags: set to USER_GENERATED indicates that the circuit was created 
by a service provisioning tool. Note that this term is not displayed in the 
circuit management tools.

• comment: records that the circuit was created by the ATM service 
provisioning tool

• TM profile: set to the name of the Traffic Management (TM) profile

• customer: set to the value of the customer field

• connections: a connection for each source and destination of each node 
in the path containing Vpi and Vci values, TM profile name, and 
correlationTag

Task flow navigation
• “Configuring the first node” (page 148)

• “Configuring additional nodes” (page 150)

• “Applying service creations” (page 126)

See also,

• “Using assisted routing” (page 145)
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Configuring the first node 
1 Start the ATM service provisioning tool from the Preside MDM window:

Configuration -> Passport Devices -> Service Provisioning -> ATM

2 From the ATM service provisioning window, select File -> New Circuit.

3 In the Circuit Type list in the main window, select the VccBearerService 
circuit type.

4 If you are using circuit management, complete the following steps

• in the Circuit Id field, enter a circuit ID. If the circuit ID already exists, 
a dialog opens asking you to decide whether or not to continue with 
the configuration operation. Click Continue to begin configuration, or 
Cancel to discontinue.

• optionally, in the Customer field, enter a customer name. An error 
message opens if the customer name already exists in the 
Administration Database. If the customer does not exist in the 
database, it is created.

5 To set the correlation tag to the same value as the circuit ID, check the 
Use Circuit Id check box. Other wise, in the Correlation Tag field, enter 
an independent identifier, as required.

The correlation tag is only 32 bytes, so if you use the circuit ID, you need 
to limit the allowed 128 byte circuit ID to 32 bytes. If you have selected 
Use Circuit Id and more than 32 characters are entered in the Circuit Id 
field, the correlation tag on the Passport device is set to the first 32 
characters. 

Note:  If accounting collection has been enabled at the ATM Interface, 
then provisioning the correlation tag enables accounting collection for the 
VCC. The correlation tag can be left un-provisioned if this effect is not 
desired.

6 In the Default User Id and Default Password fields, type the default user 
id and password to provision the Passport devices in the path.

7 From the Default TM list, select a TM profile to apply to the ATM PVC.

A list of TM profiles is provided through the TM Profiles file. For 
information on setting up this file, see “Information files” (page 36).

8 Select the displayed node in the Circuit Path panel.

9 In the Node Properties section, type a node name in the Node Name 
field, or select a node from the drop down list.
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This becomes the first node in the PVC path.

Note:  If you use the assisted routing feature, the node name is provided 
for you. See “Using assisted routing” (page 145).

10 In the node details section of the Node Properties panel, complete the 
following steps:

• In the Source (ingress) and Dest (egress) ATM IF fields, type the 
ingress and egress ATM Interface, or select the ingress and egress 
ATM interface from the list. The ingress and egress ATM interface 
must already exist on the switch.

• In the Source (ingress) and Dest (egress) VPI fields, type the ingress 
and egress virtual path identifier.

• In the Source (ingress) and Dest (egress) VCI fields, type the ingress 
and egress virtual connection identifier numbers.

Note 1:  If you enter VPI or VCI values which are already in use, an error 
message appears in the Status Window informing you that the VPI or 
VCI value is in use.

Note 2:  If you enter invalid data, an error message in the Status Window 
informs you of the error.

11 To override the default TM profiles applied to the specific Vcc Vcd Tm 
component, deselect the Use Defaults option and select a new TM profile 
from the list.

12 To override the default user ID and password, deselect the Use Defaults 
option, and enter a new user ID and password.

13 Proceed to add additional nodes to the PVC, if desired. 
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Configuring additional nodes
Once you have set up the first node, you can add none, one, or more nodes to 
a PVC using the following procedure.

1 In the Circuit Path panel, select the newly created node and complete 
one of the following steps:

• Right-click and from the pop-up menu, select Add Before to add a 
node to the left of the selected node, or Add After to add a node to 
the right of the selected node from the popup menu.

• From the Edit menu, select Add Node Before to add a node to the 
left of the selected node, or Add Node After to add a node to the right 
of the selected node.

A new node appears in the Circuit Path area. 

2 In the Node Properties section, select or type a node name in the Node 
Name field.

Note:  If you use the assisted routing feature, the node name is provided 
for you. See “Using assisted routing” (page 145). 

3 In the Node Properties section, complete the following steps:

• In the Source (ingress) and Dest (egress) ATM IF fields, type the 
ingress and egress ATM Interface, or select the ingress and egress 
ATM interface from the list.

• In the Source (ingress) and Dest (egress) VPI fields, type the ingress 
and egress virtual path identifier.

• In the Source (ingress) and Dest (egress) VCI fields, type the ingress 
and egress virtual connection identifier numbers.

Note:  If you enter invalid data, an error message opens to inform you of 
the error. 

4 To override the default TM profile applied to the specific Vcc Vcd Tm 
component, deselect the Use Defaults option and select a new TM 
Profile.

5 To override the default user ID and password, deselect the Use Defaults 
option, and enter a new user ID and password.

6 Click Apply. 

If mandatory data is missing, a message dialog box opens and describes 
what is missing. Enter the missing information and click Apply again.
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If successful, a Create Circuit dialog box opens.

7 Proceed to apply the service creation. See “Applying service creations” 
(page 126).
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Creating an ATM PVP - VPC Bearer Service 

This section provides the procedures required to provision an ATM PVP on 
Passport. 

When creating a VPC connection, the ATM service provisioning tool 
performs the following actions at each Passport node in the path:

• creates VPC subcomponents on the source and destination AtmIf. If an 
AtmIf component does not exist, the operation ends. If a Vpc component 
already exists, the operation ends.

• creates Nrp subcomponents on the Vpc and links them

• sets the TM attributes on the Vpd Tm subcomponents of the Vpc

• sets the Vpc Vpd correlationTag on the Vpcs

The Administration Database is populated with the following data:

• circuit ID: set to the value of the circuit Id field

• circuit type: set to ATM_PVP

• flags: set to USER_GENERATED

• comment: records that the circuit was created by the ATM Service 
Provisioning tool

• class of service: set to the name of the TM profile

• customer: set to the value of the customer field

• connections: a connection for each source and destination of each node 
in the path containing Vpi values, TM profile name, and correlationTag

Task flow navigation
• “Configuring the first node” (page 153)

• “Configuring additional nodes” (page 155)

• “Applying service creations” (page 126)

See also,

• “Using assisted routing” (page 145)
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Configuring the first node 
1 Start the ATM service provisioning tool from the Preside MDM window:

Configuration -> Passport Devices -> Service Provisioning -> ATM

2 From the ATM service provisioning window, select File -> New Circuit.

3 Select the circuit type, VpcBearerService circuit type, from the Circuit 
Type list.

4 If you are using circuit management, complete the following steps

• in the Circuit Id field, enter a circuit ID. If the circuit ID already exists, 
a dialog opens asking you to decide whether or not to continue with 
the configuration operation. Click Continue to begin configuration, or 
Cancel to discontinue.

• optionally, in the Customer field, enter a unique customer name. An 
error message opens if the customer name already exists in the 
Administration Database.

5 To set the correlation tag to the same value as the circuit ID, check the 
Use Circuit Id check box. Other wise, in the Correlation Tag field, enter 
an independent identifier, as required.

The correlation tag is only 32 bytes, so if you use the circuit ID, you need 
to limit the allowed 128 byte circuit ID to 32 bytes. If you have selected 
Use Circuit Id and more than 32 characters are entered in the Circuit Id 
field, the correlation tag on the Passport device is set to the first 32 
characters. 

Note:  If accounting collection has been enabled at the ATM Interface, 
then provisioning the correlation tag enables accounting collection for the 
VCC. The correlation tag can be left un-provisioned if this effect is not 
desired.

6 In the Default UserId and Default Password fields, type the default user 
ID and default password to provision the Passport nodes in the path.

7 From the Default TM list, select a TM profile to apply to the ATM PVP.

A list of TM profiles is provided through the TM Profiles file. For 
information on setting up this file, see “Information files” (page 36).

8 Select the displayed node in the Circuit Path panel.

9 In the Node Properties panel, complete the following steps:

• In the Node Name field type a node name, or select a node from the 
list. This becomes the first node in the PVP path. 
Preside MDM Service Provisioning for ATM User Guide   14.3RSUP



154   Chapter 6 ATM permanent virtual connections
Note:  If you use the assisted routing feature, the node name is provided 
for you. See “Using assisted routing” (page 145).

• In the Source (ingress) and Dest (egress) ATM IF fields, type the 
ingress and egress ATM interface or select the ingress and egress 
ATM interface from the list. The ATM interface must already exist on 
the device.

• In the Source (ingress) and Dest (egress) VPI fields, type the ingress 
and egress virtual path identifier numbers.

Note 1:  If you enter VPI values which are already in use, an error 
message appears in the Status Window informing you that the value is 
in use.

Note 2:  If you enter invalid data, an error message in the Status Window 
informs you of the error.

10 To override the default TM profiles applied to the specific Vpc Vpd Tm 
component, deselect the Use Default TM Profile option and select a new 
TM profile from the TM Profile drop down list.

11 To override the default user ID and password, deselect the Use Defaults 
option, and enter a new user ID and password.

12 Proceed to add additional nodes to the PVC. See “Configuring additional 
nodes” (page 155).
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Configuring additional nodes
Once you set up the first node in the ATM PVP, you can add none, one, or 
more nodes.

1 In the Circuit Path panel, select the newly created node and complete 
one of the following steps:

• Right-click, and from the pop-up menu, select Add After to add a 
node to the right of the selected node, or Add Before to add a node 
to the left of the selected node.

• From the Edit menu, select Add Node After to add a node to the 
right of the selected node, or Add Node Before to add a node to the 
left of the selected node

A new node appears in the Circuit Path section.

2 In the Node Properties section complete the following steps:

• Select or type a node name in the Node Name field.

Note:  If you use the assisted routing feature, the node name is provided 
for you. See “Using assisted routing” (page 145). 

• In the ATM IF field, type the Source (ingress) and Dest (egress) ATM 
interface, or select the ingress and egress ATM interface from the list.

• In the Source (ingress) and Dest (egress) VPI fields, type the ingress 
and egress virtual path identifier numbers.

Note 1:  If you enter VPI values which are already in use, an error 
message appears in the Status Window informing you that the value is 
in use.

Note 2:  If you enter invalid data, an error message in the Status Window 
informs you of the error.

3 To override the default TM profile applied to the specific Vpc Vpd Tm 
component, deselect the Use Defaults option and select a new TM 
Profile.

4 To override the default user ID and password, deselect the Use Defaults 
option, and enter a new user ID and password.

5 Click Apply. 

If mandatory data is missing, a message dialog box opens and describes 
what is missing. Enter the missing information and click Apply again.

If successful, a Create Circuit dialog box opens.
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6 Apply the service creation. See “Applying service creations” (page 126).
241-6001-600   14.3RSUP   



Chapter 6 ATM permanent virtual connections   157
Creating a Passport Trunk over ATM PVC
This section shows you how to use the ATM service provisioning tool to 
provision a Passport Trunk over an ATM PVC. 

When creating a Trunk over PVC, the ATM Service provisioning tool 
performs the following at each end node in the path:

• creates the following components:

— Trunk. 
If the Trunk component already exists, the operation ends.

• creates the following subcomponents:

— Trunk AtmAc 

— Vcc. 
If the AtmIf component does not exist, the operation ends. If the Vcc 
already exists, the operation ends.

— Vcc Nep

• sets the TM attributes on the Vcd Tm subcomponent of the Vcc

• links the AtmAc and Nep components

• sets the Vcc Vcd correlationTag for all Vccs

When creating a Trunk over PVC, the ATM service provision tool performs 
the following actions on each relay node in the path:

• creates the following subcomponents:

— a VCC on the source and destination AtmIf. 
If an AtmIf component does not exist, the operation ends. If a Vcc 
component already exists, the operation ends.

—  Nrp subcomponents on the Vccs and links them

• sets the following:

— TM attributes on the Vcd Tm subcomponents of the Vccs

— Vcc Vcd correlationTag for all Vccs
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In the Administration Database, the following information is stored:

• circuit ID: set to the value of the circuit Id field

• circuit type: set to ATM_TRUNK

• flags: set to USER_GENERATED

• comments: records that the circuit was created by the ATM service 
provisioning tool

• class of service: set to the name of the TM profile

• customer: set to the value of the customer field

• connections: a connection for each source and destination of each node 
in the path containing Vpi and Vci values, TM profile name and 
correlationTag.

• trunk: a trunk and atmac component for the first and last nodes in the 
circuit

Task flow navigation
• “Configuring the first node” (page 159)

• “Configuring relay nodes” (page 161)

• “Configuring the end node” (page 162)

• “Applying service creations” (page 126)

See also, 

• “Using assisted routing” (page 145)
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Configuring the first node 
1 Start the ATM service provisioning tool from the Preside MDM window:

Configuration -> Passport Devices -> Service Provisioning -> ATM

2 From the ATM service provisioning window, select File -> New Circuit.

3 From the Circuit Type list, select Trunk.

4 If you are using circuit management, complete the following steps

5 in the Circuit Id field, enter a circuit ID. If the circuit ID already exists, a 
dialog opens asking you to decide whether or not to continue with the 
configuration operation. Click Continue to begin configuration, or Cancel 
to discontinue.

6 optionally, in the Customer field, enter a unique customer name. An error 
message opens if the customer name already exists in the Administration 
Database.

7 To set the correlation tag to the same value as the circuit ID, check the 
Use Circuit Id check box. Other wise, in the Correlation Tag field, enter 
an independent identifier, as required.

The correlation tag is only 32 bytes, so if you use the circuit ID, you need 
to limit the allowed 128 byte circuit ID to 32 bytes. If you have selected 
Use Circuit Id and more than 32 characters are entered in the Circuit Id 
field, the correlation tag on the Passport device is set to the first 32 
characters. 

Note:  If accounting collection has been enabled at the ATM Interface, 
then provisioning the correlation tag enables accounting collection for the 
VCC. The correlation tag can be left un-provisioned if this effect is not 
desired.

8 In the Default UserId and Default Password fields, type the default user 
ID and default password to provision the Passport nodes in the path.

9 From the Default TM list, select a TM profile to apply to the ATM PVC.

A list of TM profiles is provided through the TM Profiles file. For 
information on setting up this file, see “Information files” (page 36).

10 In the Circuit Path panel, select the displayed node.

11 In the Node Properties panel complete the following steps:

• Select or type a node name in the Node Name field.

This becomes the trunk end node.
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Note:  If you use the assisted routing feature, the node name is provided 
for you. See “Using assisted routing” (page 145).

• In the Trunk field, type the trunk instance name. 

• Type the ATM interface. 

• Type the virtual path identifier of the VCC that is linked to the trunk. 

• Type the virtual connection identifier numbers of the VCC that is 
linked to the trunk. 

Note 1:  The service provisioning application creates the Trunk, so the 
trunk instance name should not already exist on the device. The ATM 
interface should exist, and the VCCs should not already exist on the 
device. When you enter VPI or VCI values that are already in use, an error 
message appears in the Status Window informing you that the VPI or VCI 
value is in use.

Note 2:  If you enter invalid data, an error message in the Status Window 
informs you of the error.

12 To override the default TM profile applied to the specific Vcc Vcd Tm 
component, deselect the Use Defaults option and select a new TM 
profile.

13 To override the default user ID and password, deselect the Use Defaults 
option, and enter a new user ID and password.
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Configuring relay nodes 
Once you have set up the first node in the path, you can add none, one, or more 
than one node to the path. To add additional nodes, use the following 
procedure.

1 In the Circuit Path panel, select the newly created node and complete 
one of the following steps:

• Right-click, and from the pop-up menu, select Add After to add a 
node to the right of the selected node or Add Before to add a node 
to the left of the selected node.

• From the Edit menu, select Add Node After to add a node to the 
right of the selected node or Add Node Before to add a node to the 
left of the selected node

A new node appears in the Circuit Path panel.

2 In the node details area of the Node Properties panel, type a node name 
in the Node Name field, or select a name from the drop down list.

Note:  If you use the assisted routing feature, the node name is provided 
for you. See “Using assisted routing” (page 145). 

3 In the Node Properties section, enter the following data for each relay 
node that you create:

• In the Source (ingress) and Dest (egress) ATM IF fields, type the 
ingress and egress ATM interface, or select ingress and egress ATM 
interface from the list.

• In the Source (ingress) and Dest (egress) VPI fields, type the ingress 
and egress virtual path identifier.

• In the Source (ingress) and Dest (egress) VCI fields, type the ingress 
and egress virtual connection identifier numbers.

Note:  The ATM Interface should already exist on the device. The VCCs 
should not exist. 

4 To override the default user ID and password, deselect the Use Defaults 
option, and enter a new user ID and password.

5 To override the default TM profile applied to the specific Vcc Vcd Tm 
component, deselect the Use Defaults option and select a new TM 
Profile.
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Configuring the end node 
1 In the Circuit Path panel, select the newly created node and complete 

one of the following steps:

• Right-click, and from the pop-up menu, select Add After to add a 
node to the right of the selected node or Add Before to add a node 
to the left of the selected node.

• From the Edit menu, select Add Node After to add a node to the 
right of the selected node or Add Node Before to add a node to the 
left of the selected node

Another node is added to the path. This becomes the end node in the 
path.

2 Select the newly added end node.

3 Enter the following mandatory data in the node details section of the Node 
Properties panel:

• Select or type a node name in the Node Name field 
This becomes the trunk end node.

Note:  If you use the assisted routing feature, the node name is provided 
for you. See “Using assisted routing” (page 145).

• Select the End Node check box.

• In the Trunk field, type the trunk instance value.

• Type the ATM interface. 

• Type the virtual path identifier (VPI) of the VCC that is linked to the 
trunk. 

• Type the virtual connection identifier (VCI) numbers of the VCC that 
is linked to the trunk. 

Note:  The service provisioning application creates the trunk, so the trunk 
instance name should not already exist on the device. The ATM interface 
should exist, and the VCCs should not already exist on the device.When 
you enter VPI or VCI values that are already in use, an error message 
appears in the Status Window informing you that the VPI or VCI value is 
in use.

Note:  If you enter invalid data, an error message in the Status Window 
informs you of the error.

4 To override the default user ID and password, deselect the Use Defaults 
option, and enter a new user ID and password.
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5 To override the default TM profile applied to the specific Vcd vpd Tm 
component, deselect the Use Defaults option and select a new TM 
Profile.

6 Click Apply. 

If mandatory data is missing, a message dialog box opens and describes 
what is missing. Enter the missing information and click Apply again.

If successful, a Create Circuit dialog box opens.

7 Apply the service creation. For the procedure, see “Applying service 
creations” (page 126).

The Trunk over PVC is configured on each Passport node in the path.
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Creating a CES over ATM PVC connection
This section describes the procedures to provision a CES connection to an 
ATM network using a PVC.

When creating a CES over PVC connection, the ATM service provisioning 
tool performs the following at each end node in the path:

• creates an AAL1 CES component and links the component to the 
channel. If the AAL1 CES component already exists, the operation ends. 
If the channel doesn’t exist, the operation ends.

• sets the AAl1CES serviceType. If the serviceType is structured, the tool 
adds a TrunkConditioning component, if it does not already exist, to the 
channel associated with the AAL1 CES component.

If the serviceType is unstructured, the tool deletes the TrunkConditioning 
component from the channel associated with the AAL1 CES component.

• creates the following subcomponents:

— AAL1 CES ATmAc 

— creates a VCC 
If the AtmIf component does not exist, the operation ends. If the 
VCC already exists, the operation ends.

— Vcc Nep

• sets the TM attributes on the Tm subcomponent of the Nep

• links the Nap and Nep components

When creating a CES over PVC connection, the ATM service provisioning 
tool performs the following at each relay node in the path:

• creates a VCC subcomponent on the source and destination AtmIf. If an 
AtmIf component does not already exist, the operation ends. If a Vcc 
component already exists, the operation ends.

• creates Nrp subcomponents on the Vccs

• sets the TM attributes on the Vcd Tm subcomponents of the Vccs

• links the source and destination Nrp components
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Task flow navigation
 See the following procedures:

• “Configuring the first node” (page 165)

• “Configuring one or more relay nodes” (page 168)

• “Configuring the end node” (page 170)

• “Applying service creations” (page 126)

See also,

• “Using assisted routing” (page 145)

Configuring the first node 
1 Start the ATM service provisioning tool from the Preside MDM window:

Configuration -> Passport Devices -> Service Provisioning -> ATM

2 From the ATM service provisioning window, select File -> New Circuit.

3 From the Circuit Type list, select CES over PVC.

4 If you are using circuit management, complete the following steps

5 in the Circuit Id field, enter a circuit ID. If the circuit ID already exists, a 
dialog opens asking you to decide whether or not to continue with the 
configuration operation. Click Continue to begin configuration, or Cancel 
to discontinue.

6 optionally, in the Customer field, enter a unique customer name. 

7 To set the correlation tag to the same value as the circuit ID, check the 
Use Circuit Id check box. Other wise, in the Correlation Tag field, enter 
an independent identifier, as required.

The correlation tag is only 32 bytes, so if you use the circuit ID, you need 
to limit the allowed 128 byte circuit ID to 32 bytes. If you have selected 
Use Circuit Id and more than 32 characters are entered in the Circuit Id 
field, the correlation tag on the Passport device is set to the first 32 
characters. 

Note:  If accounting collection has been enabled at the ATM Interface, 
then provisioning the correlation tag enables accounting collection for the 
VCC. The correlation tag can be left un-provisioned if this effect is not 
desired.
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8 In the Default User Id and Default Password fields, type the default user 
ID and default password to provision the Passport node.

9 From the Default TM list, select a default traffic management (TM) profile 
to apply to the ATM PVC.

A list of TM profiles is provided through the TM Profiles file. For 
information on setting up this file, see “Information files” (page 36).

10 Select the first displayed node in the Circuit Path section.

11 In the Node Properties section, type a node name in the Node Name 
field, or select a node from the list.

This becomes the first node in the PVC path.

Note:  If you use the assisted routing feature, the node name is provided 
for you. See “Using assisted routing” (page 145).

12 In the Node Properties section, complete the node details:

• In the Aal1CES field, type the AAL1 CES instance value.

• Select the AAL1 CES service type from the drop down list. If the 
Service Type field specifies structured, the tool adds a 
TrunkConditioning component, if it does not already exist, to the 
channel associated with the AAL1 CES component. If the Service 
Type field specifies unstructured, the tool deletes the 
TrunkConditioning component from the channel associated with the 
AAL1 CES component. 

• In the Channel field, enter the full channel instance name, for 
example Lp/1 DS1/3 Chan/0, to which the AAL1 CES instance is 
linked. or use the can also use the Browse [...] button to the right of 
the Channel field to open the Browse Channels dialog to search for 
all available channels

• In the ATM IF field, select the ATM Interface from the list, or type the 
ATM interface

• Type the virtual path identifier (VPI) of the VCC that is linked to the 
AAL1 CES. 

• Type the virtual connection identifier (VCI) numbers of the VCC that 
is linked to the AAL1 CES. 

Note 1:  The service provisioning application creates the AAL1 CES, so 
the AAL1CES instance name should not already exist on the device. The 
ATM interface should exist, and the VCCs should not already exist on the 
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device. When you enter VPI or VCI values that are already in use, an error 
message appears in the Status Window informing you that the VPI or VCI 
value is in use.

Note 2:  If you enter invalid data, an error message in the Status Window 
informs you of the error.

13 To override the default TM profiles applied to the specific Vcc Vcd Tm 
component, deselect the Use Defaults options and select a new TM 
profile from the list.

14 To override the default user ID and password, deselect the Use Defaults 
option, and enter a new user ID and password.

15 Proceed to add additional nodes to the PVC. See “Configuring one or 
more relay nodes” (page 168).
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Configuring one or more relay nodes 
Once you have set up the first node, you can add one or more nodes to a PVC 
using the following procedure.

1 In the Circuit Path panel, select the newly created node and complete 
one of the following steps:

• Right-click, and from the pop-up menu, select Add After to add a 
node to the right of the selected node or Add Before to add a node 
to the left of the selected node.

• From the Edit menu, select Add Node After to add a node to the 
right of the selected node or Add Node Before to add a node to the 
left of the selected node

A new node appears in the Path Nodes area.

2 In the Node Properties section, select or type a node name in the Node 
Name field.

Note:  If you use the assisted routing feature, the node name is provided 
for you. See “Using assisted routing” (page 145). 

3 In the Node Properties section, complete the following steps:

• In the Source (ingress) and Dest (egress) ATM IF fields, type the 
ingress and egress ATM Interface, or select the ingress and egress 
ATM interface from the list.

• In the Source (ingress) and Dest (egress) VPI fields, type the ingress 
and egress virtual path identifier.

• In the Source (ingress) and Dest (egress) VCI fields, type the ingress 
and egress virtual connection identifier numbers.

Note 1:  The service provisioning application creates the AAL1 CES, so 
the AAL1CES instance name should not already exist on the device. The 
ATM interface should exist, and the VCCs should not already exist on the 
device. When you enter VPI or VCI values that are already in use, an error 
message appears in the Status Window informing you that the VPI or 
VCI value is in use.

Note 2:  If you enter invalid data, an error message in the Status Window 
informs you of the error.

4 To override the default user ID and password, deselect the Use Defaults 
option, and enter a new user ID and password.
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5 To override the default TM profile applied to the specific Vcc Vpd Tm 
component, deselect the Use Defaults option and select a new TM 
Profile.

6 Proceed to configure the end node.
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Configuring the end node 
1 In the Circuit Path panel, select the newly created node and complete 

one of the following steps:

• Right-click, and from the pop-up menu, select Add After to add a 
node to the right of the selected node or Add Before to add a node 
to the left of the selected node.

• From the Edit menu, select Add Node After to add a node to the 
right of the selected node or Add Node Before to add a node to the 
left of the selected node

A new node appears in the Path Nodes area. This becomes the end 
node.

2 In the Node Properties section, select or type a node name in the Node 
Name field.

Note:  If you use the assisted routing feature, the node name is provided 
for you. See “Using assisted routing” (page 145). 

3 Select the End Node check box.

4 In the Node Properties section, complete the node details:

• In the Aal1CES field, type the AAL1 CES instance value.

• Select the AAL1 CES service type from the drop down list. If the 
Service Type is structured, the tool adds a TrunkConditioning 
component, if it does not already exist, to the channel associated with 
the AAL1 CES component. If the Service Type is unstructured, the 
tool deletes the TrunkConditioning component from the channel 
associated with the AAL1 CES component.

• In the Channel field, enter the full channel instance name, for 
example Lp/1 DS1/3 Chan/0, to which the AAL1 CES instance is 
linked. You can also use the Browse [...] button to the right of the 
Channel field to open the Browse Channels dialog to search for all 
available channels.

• Type the ATM interface.

• Type the virtual path identifier (VPI) of the VCC that is linked to the 
AAL1 CES.

• Type the virtual connection identifier (VCI) numbers of the VCC that 
is linked to the AAL1 CES.
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Note:  If you enter VPI or VCI values which are already in use, an error 
message appears in the Status Window informing you that the VPI or 
VCI value is in use.

Note:  If you enter invalid data, an error message in the Status Window 
informs you of the error.

5 To override the default user ID and password, deselect the Use Defaults 
option, and enter a new user ID and password.

6 To override the default TM profile applied to the specific Vcc Vcd Tm 
component, deselect the Use Defaults option and select a new Tm 
Profile.

7 Click Apply. 

If mandatory data is missing, a message dialog box opens and describes 
what is missing. Enter the missing information and click Apply again.

 If successful, a Create Circuit dialog box opens.

8 Apply the service provisioning. For the procedure, see “Applying service 
creations” (page 126).
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ATM soft permanent virtual path and soft 
permanent virtual channel connections

This section provides procedures to for ATM soft permanent virtual path 
(SPVP) and soft permanent virtual channel (SPVC) connections:

Note: This section covers ATM to ATM connections only. For the 
following FR.8 FrAtm scenarios, SIWF FrAtm to FrAtm SPVC, SIWF 
FrAtm to ATM Access SPVC, and SIWF ATM to FrAtm Access SPVC 
see the section “Frame relay to ATM circuits” (page 191).

• “Prerequisites” (page 173)

• “Creating an ATM SPVC connection” (page 175)

• “Creating ATM SPVP connection” (page 181)

• “Browsing Node Names” (page 186)

• “Browsing Addresses” (page 187)

• “Browsing MDTL paths” (page 188)

Prerequisites
Before using the service provisioning tool, you need to do the following tasks:

• Ensure that all of the Passports to be provisioned are configured for ATM 
and/or CES service up to the logical connection layer. For more 
information, see “Passport configuration” (page 36).
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• Set up the required information files. For details, see “Information files” 
(page 36).
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Creating an ATM SPVC connection
This section describes how to use the ATM service provisioning tool to 
provision an ATM SPVC connection. 

Figure 20
SPVC connections

When creating an SPVC connection, the ATM service provisioning tool 
performs the following on the source node:

• creates the following components:

— Vcc component under the source AtmIf component on the source 
node. If the AtmIf component does not already exist, the operation 
terminates. If the Vcc component already exists, the operation 
terminates.

— Vcc SourcePvc component

• sets the SourcePvc callingAddress, calledAddress, called VpiVci, 
aisGeneration attributes
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• if Mdtl routing is selected, creates the Mdtl component and sets the 
primaryPath, alternatePath and automaticFallback attributes

• sets the attributes of the Vcd Tm subcomponents of the source Vcc to the 
value of the QoS profile

• if the provision destination option is selected, the destination end of the 
connection is provisioned. The ATM service provisioning tool then 
performs the following at the destination node:

— creates a Vcc component with the given calledVpicalledVci under 
the destination AtmIf component on the destination node. If the 
AtmIf component does not exist, the operation is terminated. If the 
Vcc component already exists, the operation is terminated

— creates a Vcc DestPvc Config component

— Sets the Dest Pvc Config aisGeneration attribute

— Sets the destination TM attributes on the Tm subcomponent of the 
destination VccVcd

If the provision destination option is selected on the destination node, the 
destination end of the connection is dynamically created by the call setup.

When validating the data retrieved from the Administration Database against 
the current view of the Passport switches, the ATM service provisioning tool 
performs the following validation at the source node:

• verifies that the Vcc Source Pvc component exists

• verifies that the calledAddress, and calledVpi and calledVci match

If the destination end is provisioned, the ATM service provisioning tool 
performs the following validation at the destination node:

• verifies that the Vcc DestPvc Config component exists

When creating an SPVC connection, the Administration Database is 
populated with the following circuit information:

• circuit ID: set to the value of the circuit Id field

• circuit type: set to ATM_SPVC
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• flags: set to USER_GENERATED

• comment: records that the circuit was created by the ATM service 
provisioning (SP) tool

• TM Profile: set to the name of the TM profile

• customer: set to the value of the customer field

• connections: a source vcc with the correlation Tag, adminControl, AtmIf, 
Vpi, called address, and called VpiVci, Tm Profile, AIS generation

• if routing is selected: primary path, alternate path, and automatic fallback

• if the destination is provisioned: a destination vcc with the correlationTag 
Tm profile, AIS generation

Use the following procedures to provision an ATM SPVC path

• “Creating an ATM SPVC connection” (page 175)

• “Browsing Node Names” (page 186)

• “Browsing Addresses” (page 187)

• “Browsing MDTL paths” (page 188)

Procedure steps
1 Start the ATM service provisioning tool from the Preside MDM window:

Configuration -> Passport Devices -> Service Provisioning -> ATM

2 From the ATM service provisioning window, select File -> New Circuit.

3 In the Circuit Properties panel, select SPVC from the Circuit Type list.

4 If you are using circuit management, complete the following steps:

• In the Circuit Id field, type a circuit ID.

• In the Correlation Tag field, type a correlationTag, or select the Use 
Circuit Id option to set the value of the correlationTag to the value of 
the circuit ID.

• Optionally, if you are using circuit management, in the Customer field, 
enter a unique customer name. An error message opens if the 
customer name already exists in the Administration Database.

5 Select the initial state of the SPVC connection from the adminControl 
field.
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When the connection is permlocked, the VPI and VCI numbers are 
reserved on the source node of the call but no bandwidth is used. The 
default value is unlocked.

6 In the Default User Id and Default Password fields, enter the default 
user ID and password to provision the Passport node.

7 In the Node Properties panel, type a node name in the Source field or 
click the browse nodes [...] button and select a node from the Browse 
Nodes dialog. See “Browsing Node Names” (page 186). 

8 The Node Type is always a Passport and the Interface Type is always 
AtmIf for the source node.

9 On the source, enter the source ATM interface, virtual path identifier (VPI), 
and virtual connection identifier number (VCI), 

Note 1:  The source ATM interface must already exist on the device.

Note 2:  The VCCs should not already exist on the device.

10 If you do not want to use the default value, enter a calling address.
If you want to use the default value, leave this field blank. You can click the 
browse button [...] next to the AtmIf field to open the Browse Addresses 
dialog to search and select a calling address from the list of available 
interfaces. The Calling Address field is auto-populated.with the selected 
AtmIf address.

11 In the destination panel, select a Node Type. Your choices are Passport 
or Foreign.

12 If provisioning a Passport destination, enter a destination node name or 
click the browse nodes [...] button and select a node from the Browse 
Nodes dialog. See “Browsing Node Names” (page 186).

If you have selected a Node Type of Foreign, this field is disabled.

13 Select the AtmIf  Interface Type. 

14 If the destination is a Passport, enter the destination ATM interface, 
destination virtual path identifier, and destination virtual connection 
identifier.

Note 1:  The destination ATM interface must already exist on the device.

Note 2:  The VCCs should not already exist on the device.

15 If you want to use the default destination interface address, leave the 
called address entry blank. Otherwise, enter a value or, if your destination 
is a Passport, click the browse addresses button [...] to open the Browse 
Addresses dialog. You can search and select a called address from the 
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list of available addresses. See “Browsing Addresses” (page 187).

If the destination node is a foreign node, the Browse Addresses button {...} 
is disabled and you will need to enter the values.

16 Enable or disable AIS Generation at the source and destination.
This attribute enables/disables the generation of an Alarm Indication 
Signal (AIS) to the Customer Premise Equipment (CPE), when the 
switched portion of the SPVC is disconnected.

On the destination side, to enable AIS, select the Provision Destination for 
AIS option. This option is disabled if your destination is a Foreign node.

17 In the TM Profile field, type the quality of service profile to apply to the 
source ATM SPVC, or select the traffic management (TM) profile from the 
dropdown list. If the destination endpoint is being provisioned you also 
need to specify a TM profile for the destination node.

If the destination is a Foreign node type, this option is disabled.

A list of TM profiles is provided through the TM Profiles file. For 
information on setting up this file, see “Information files” (page 36).

18 Select Use Defaults in both the source and destination if you wish to use 
the default user ID and password specified in step 6. Otherwise, enter a 
user ID and password for the source and/or destination.

19 To use the user specified routing feature, in the Routing panel select 
User Specified Paths. 

20 In the Primary Path field type the name of the path that the tool will use 
to initially establish the connection. Optionally, you can search for and 
select a path from a list of available paths by using the Browse Paths 
dialog. See “Browsing MDTL paths” (page 188).

21 Optionally, in the Alternate Path field, enter the name of the Alternate 
Path which the tool will use to establish the connection if the primary path 
selection fails. Optionally, you can search for and select a path from a list 
of available paths using the Browse Paths dialog. See “Browsing MDTL 
paths” (page 188).

22 Optionally, select the Automatic Fallback option which enables or 
disables the use of the default PNNI route selection algorithm if the 
manual (primary and alternate) paths fail.

23 Click Apply. 

If mandatory data is missing, a message dialog box opens and describes 
what is missing. Enter the missing information and click Apply again.
Preside MDM Service Provisioning for ATM User Guide   14.3RSUP



180   Chapter 7 ATM soft permanent virtual path and soft permanent virtual channel connections
If successful, a Create Circuit dialog box opens.

24 Apply the service creation. See “Applying service creations” (page 126).
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Creating ATM SPVP connection
This section describes how to use the ATM service provisioning tool to 
provision an ATM SPVP connection.

Figure 21
SPVP connections

When creating an SPVP connection, the Atm service provisioning tool 
performs the following on the source node:

• creates the following components:

— Vpc component under the source AtmIf component on the source 
node. If the AtmIf component does not already exist, the operation 
is terminated. If the Vpc component already exists, the operation is 
terminated.

— Vpc SourcePvp component

• sets the SourcePvp callingAddress, calledAddress, called VpiVci, 
aisGeneration attributes

• if Mdtl routing is selected, creates the Mdtl component and sets the 
primary path, alternate path, and automaticFallback attributes
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• sets the attributes on the Vpd Tm subcomponents of the source Vpc to 
the values of the TM profile

If the provision destination option is selected on the destination node, the 
destination end of the connection is provisioned. The ATM service 
provisioning tool then performs the following at the destination node:

• creates a Vpc component with the given calledVpi under the destination 
AtmIf component on the destination node. If the AtmIf component does 
not exist, the operation is terminated. If the Vpc component already 
exists, the operation is terminated.

• Creates a Vpc DestPvp Config component

• sets the DestPvp Config aisGeneration attribute

• sets the destination TM attributes on the Tm subcomponent of the 
destination VpcVpd.

If the aisGeneration attribute is not enabled on the destination node, the 
destination end of the connection is dynamically created by the call 
setup.

When validating the data retrieved from the Administration Database against 
the current view of the Passport switches, the ATM service provisioning tool 
performs the following validation at the source node:

• verifies that the Vcc Source Pvp component exists

• verifies that the calledAddress, and calledVpi match

If the destination end is provisioned, the ATM service provisioning tool 
performs the following validation at the destination node:

• verifies that the Vpc DestPvp Config component exists

When creating an SPVC connection, the Administration Database is 
populated with the following circuit information:

• circuit id: set to the value of the circuit id field

• circuit type: set to ATM_SPVP

• flags: set to USER_GENERATED
241-6001-600   14.3RSUP   



Chapter 7 ATM soft permanent virtual path and soft permanent virtual channel connections   183
• comment: records that the circuit was created by the ATM service 
provisioning (SP) tool

• TM Profile: set to the name of the TM profile

• customer: set to the value of the customer field

• connections: a source vpc with the correlationTag, adminControl, AtmIf, 
Vpi, called address and called Vpi, TM profile, AIS generation

• if the destination is provisioned: a destination vcc with the 
correlationTag, Tm profile, AIS generation

• if Routing is selected: primary path, alternate path, and automatic 
fallback

Use the following procedures to provision an ATM SPVP path

• “Creating ATM SPVP connection” (page 181)

• “Browsing Node Names” (page 186)

• “Browsing Addresses” (page 187)

• “Browsing MDTL paths” (page 188)

• “Applying service creations” (page 126)

Procedure steps
1 Start the ATM service provisioning tool from the Preside MDM window:

Configuration -> Passport Devices -> Service Provisioning -> ATM

2 From the ATM service provisioning window, select File -> New Circuit.

3 In the Circuit Properties panel, select SPVC from the Circuit Type list.

4 If you are using circuit management, complete the following steps

• In the Circuit Id field, type a circuit ID.

• In the Correlation Tag field, type a correlationTag or select the Use 
Circuit Id option to set the value of the correlationTag to the value of 
the circuit ID.

• Optionally, if you are using circuit management, in the Customer 
field, enter a unique customer name. An error message opens if the 
customer name already exists in the database.
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5 Select the initial state of the SPVP connection from the adminControl 
field.

When the connection is permlocked, the VPI and VCI numbers are 
reserved on the source node of the call but no bandwidth is used. The 
default value is unlocked.

6 In the Default User Id and Default Password fields, enter the default 
user ID and password to provision the Passport node.

7 In the Node Properties panel, type a node name in the Source field or 
click the browse nodes [...] button and select a node from the Browse 
Nodes dialog. See “Browsing Node Names” (page 186). The Node Type 
is always a Passport.

8 Enter the source ATM interface, virtual path identifier, virtual connection 
identifier number, called virtual path identifier, and called virtual 
connection identifier.

Note 1:  The source ATM interface must already exist on the device.

Note 2:  The VCCs should not already exist on the device.

9 If you do not want to use the default value, enter a calling address. If you 
want to use the default value, leave this field blank. Otherwise, enter a 
value or click the browse addresses button [...] to open the Browse 
Addresses dialog. You can search and select a called address from the 
list of available addresses. See “Browsing Addresses” (page 187).

10 In the destination panel, select a Node Type. Your choices are Passport 
or Foreign.

11 If provisioning a Passport destination, enter a destination node name or 
click the browse nodes [...] button and select a node from the Browse 
Nodes dialog. See “Browsing Node Names” (page 186).

If you have selected a Node Type of Foreign, this field is disabled.

12 If provisioning a Passport, enter the destination ATM interface, destination 
virtual path identifier, and destination virtual connection identifier.

Note 1:  The destination ATM interface must already exist on the device.

Note 2:  The VCCs should not already exist on the device.

13 If you want to use the default destination interface address, leave the 
called address entry blank. Otherwise, enter a value or click the browse 
addresses button [...] to open the Browse Addresses dialog. You can 
search and select a called address from the list of available addresses. 
See “Browsing Addresses” (page 187).
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If the destination node is a foreign node, the Browse Addresses button {...} 
is disabled and you will need to enter the values.

14 Enable or disable AIS Generation on the source and destination.
This attribute enables/disables the generation of an Alarm Indication 
Signal (AIS) to the Customer Premise Equipment (CPE), when the 
switched portion of the SPVP is disconnected.

On the destination side, to enable AIS, also select the Provision 
Destination for AIS option. This option is disabled if the destination node 
is a non-Passport.

15 In the Default TM field, type the traffic management profile to apply to the 
ATM SPVP, or select the traffic management (TM) profile from the 
dropdown list.

A list of TM profiles is provided through the TM Profiles file. For 
information on setting up this file, see “Information files” (page 36).

16 Select Use Defaults in the source and/or destination if you wish to use 
the default user ID and password specified in step 6. Otherwise, enter a 
user ID and password for the source and/or destination.

17 To use the user specified routing feature, in the Routing panel, select 
User Specified Paths.

18 In the Primary Path field, type the name of the path that the tool will use 
to initially establish the connection. You can also search for and select a 
path, using the Browse Paths dialog. See “Browsing MDTL paths” 
(page 188).

19 Optionally, in the Alternate Path field, enter the name of the Alternate 
Path which the tool can use to establish the connection if the primary path 
selection fails. You can also search for and select a path, using the 
Browse Paths dialog. See “Browsing MDTL paths” (page 188).

20 Optionally, select the Automatic Fallback option which enables or 
disables the use of the default PNNI route selection algorithm if the 
manual (primary and alternate) paths fail.

21 Click Apply. 

If mandatory data is missing, a message dialog box opens and describes 
what is missing. Enter the missing information and click Apply again.

If successful, a Create Circuit dialog box opens.

22 Apply the service creation. See “Applying service creations” (page 126)
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Browsing Node Names 
Use this procedure to search for and select a Passport device from a list of 
available devices. This procedure applies to the SPVC or SPVP application 
types.

Procedure steps
1 In the ATM service provisioning window, click the browse nodes [...] 

button.

The Browse Nodes dialog opens.

2 Enter the desired search criteria in the Device Name field or use the 
default wildcard * to retrieve all devices. 

3 Optionally, in the Max Num to Retrieve field, set the maximum number of 
search result instances that you want to retrieve. The default is 100.

4 Click Search.

The Search Results area is populated with a list of valid node names that 
match the search criteria.

5 Select the desired node.

6 Click OK.

The node field in the node properties area of the ATM service provisioning 
window is populated with the selected node.
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Browsing Addresses
Use this procedure to select a valid ATM address. The following procedure 
applies to the SPVC or SPVP application types.

Procedure steps
1 Open the ATM service provisioning tool.

The ATM service provisioning window opens.

2 Select SPVC or SPVP in the Application field.

3 If the source and destination nodes have the same user ID and password, 
in the User Id and Password fields in the Default Node Properties area, 
type the default user ID and password to be used to provision the 
Passport devices in the path.

Note:  Since Use Defaults is checked, by default, in both the Source 
Node and Destination Node Properties areas, the user ID and 
password is used for both the source and destination nodes.

If the target node has a different user ID and password from the default, 
deselect the Use Defaults option for the target node and enter the 
specific user ID and password for the target node.

4 Choose the device name.

5 In the ATM service provisioning window, select the browse addresses [...] 
button.

The Browse Addresses dialog opens.

6 In the Browse Addresses dialog, enter the desired search criteria.

7 Click the Search button.

The Search Results area is populated with a list of the valid addresses 
matching the search criteria.

8 Select the desired address.

9 Click OK.

If the Destination Node, the Called Address field is populated with the 
selected address. If the Source Node, the Calling Address field is 
populated with the selected address. The AtmIf field is populated with the 
selected AtmIf. The dialog closes.

If the search fails, a dialog opens showing the error. Click OK in the 
message dialog.
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Browsing MDTL paths
This procedure applies to Browsing Manual Designated Transit List (MDTL) 
paths for both SPVC and SPVP circuit types. The Browse Paths dialog opens 
after you enter a valid source node name, user ID, and password in the main 
window.

1 In the Routing panel of the main window, select the User Specified 
Paths check box.

2 Click the Browse Paths... button.

The Browse Paths dialog opens.

3 In the Search Criteria panel of the Browse Paths dialog, enter the 
desired search criteria:

• In the Path Name, enter a path name.
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• In the Destination Node, enter a destination node name if you have 
not already specified the destination node in the main window. 
If you have specified a destination node in the main window, this 
name appears in the Destination Node field of the Browse Paths 
dialog.

• In the Max Num to Retrieve field, enter the maximum number of 
instances retrieved by the search.

4 Click Search.

The Search Results panel is populated with a list of valid paths that 
match the search criteria.

5 Select the desired primary path. 

The Path Details panel displays the details for the selected path.

6 To copy the selected path to the primary path field in the main window, 
click the Set Primary button.

7 Select the desired alternate path.

The Path Details panel displays the details for the selected path.

8 To copy the selected alternate path to the Alternate Path field in the main 
window, click the Set Alternate button.

9 Click Close to close the Browse Paths dialog.

The selected primary and alternate path names are displayed in their 
respective path fields in the main window.
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Chapter 8
Frame relay to ATM circuits

This section provides procedures to provision the following FR.8 Frame relay 
to Atm (FrAtm) scenarios:

• SIWF FrAtm to FrAtm SPVC

— “Creating a FRF.8 FrAtm to FrAtm SPVC between Passport 
devices” (page 192)

— “Creating a FRF.8 FrAtm to FrAtm SPVC between a Passport device 
and a non-Passport device” (page 196)

• SIWF FrAtm to ATM Access SPVC

— “Creating a FRF.8 FrAtm to ATM SPVC between Passport devices” 
(page 199)

— “Creating a FrAtm to Atm SPVC between a Passport device and a 
non-Passport device” (page 203)

• SIWF ATM to FrAtm Access SPVC

— “Creating a ATM to FrAtm SPVC between Passport devices” 
(page 206)

— “Creating an ATM to FrAtm SPVC between a Passport device and a 
non-Passport device” (page 212)

For information on the Passport frame relay to ATM (FR-ATM) service, see 
241-5701-920 Passport 7400, 15000, 20000 Frame Relay to ATM 
Interworking Guide.
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Creating a FRF.8 FrAtm to FrAtm SPVC between Passport 
devices

Use this procedure to create an end-to-end Frame Relay connection to enable 
a Frame Relay customer-provided equipment (CPE) to communicate with 
another Frame Relay CPE across a homogeneous ATM PNNI network. In this 
procedure Passport is on the edge of the network, offering Frame Relay 
service on both ends. The source device must always be a Passport and the 
destination device is a Passport.

This procedure provisions the following on the source Passport node:

• creates a Data Link Connection Identifier (DLCI) component under the 
source FrAtm. If the source FrAtm does not exist, the operation 
terminates. If the specified DLCI already exists, the operation terminates.

• creates the service interworking function (SIWF) component under the 
source DLCI

• creates a soft PVC (SPVC) component under the source SIWF

• sets the source SIWF attributes: remote address (raddr), rci, and 
correlation tag (correlationTag) attributes 

• sets the traffic management attributes under the source component 
FrAtm DLCI ServiceParameters

This procedure provisions the following on the destination Passport node:

• Creates a DLCI under the destination FrAtm. If the destination FrAtm 
does not exist, the operation terminates. If the destination DLCI already 
exists, the operation terminates.

• Creates a SIWF under the destination DLCI.

When validating a FR/ATM Access SPVC retrieved from the Administration 
Database against the current view of Passport switches, the ATM service 
provisioning tool performs the following actions on the source node:

• verifies that the Fratm DLCI SIWF spvc component exists

• verifies that the raddr and rci attributes match
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If the destination node is known, the tool verifies that the FrAtm DLCI SIWF 
component exists.

Prerequisites
The FrAtm interfaces are provisioned before using the service provisioning 
tool.

You have reviewed the section on basic provisioning procedures for general 
procedures.

Procedure steps
1 Start the ATM service provisioning tool from the Preside MDM window:

Configuration -> Passport Devices -> Service Provisioning -> ATM

If the Administration Database is installed, a dialog box opens prompting 
you for a database user ID and password.

2  In the User name and Password fields, type a user ID and password, and 
click OK.

The Service Provisioning - ATM window opens.

3 In the Circuit Type list in the main window, select the FRATM ACCESS 
SPVC circuit type.

4 In the Default User Id and Default Password fields, type the default user 
id and password to provision the Passport devices in the path.

5 If you are using circuit management, complete the following steps

• in the Circuit Id field, enter a circuit ID.

• optionally, in the Customer field, enter a customer name. If the 
customer does not exist in the database, it is created.

6 To set the correlation tag to the same value as the circuit ID, check the 
Use Circuit Id check box. Other wise, in the Correlation Tag field, enter 
an independent identifier, as required.

The correlation tag is only 32 bytes, so if you use the circuit ID, you need 
to limit the allowed 128 byte circuit ID to 32 bytes. If you have selected 
Use Circuit Id and more than 32 characters are entered in the Circuit Id 
field, the correlation tag on the Passport device is set to the first 32 
characters. 
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Note:  If accounting collection has been enabled at the ATM Interface, 
then provisioning the correlation tag enables accounting collection for the 
VCC. The correlation tag can be left un-provisioned if this effect is not 
desired.

7 On the source side of the Node Properties panel, type a node name in 
the Source Node field or click the browse [...] button and select a 
Passport node from the Browse Nodes dialog. The source node must be 
a Passport.

8 You cannot change the Node Type and Interface Type fields. These fields 
are read only since the source node is always a Passport, and the 
interface type is always FrAtm.

9 Click the browse [...] button and select a FrAtm interface from the list of 
interfaces displayed in the FrAtm Browse Dialog. 

10 Click the Get Next button next to the DLCI field to auto-populate the field 
with the next available DLCI on the source Passport, or type in an 
instance number that is not already in use on the Passport.

11 From the TM Profile drop down list, select the FrAtm TM profile, or accept 
the default profile. You can edit the TM Profile by clicking the [...] button 
next to the TM Profile field.

12 Select the Use Defaults check box to use the default user ID and 
password. Otherwise, enter a user ID and password in the User Id and 
Password fields.

13 In the Dest Node field, on the destination side of the Node Properties 
panel, type the name of the destination Passport device, or click the 
browse [...] button next to this field to open the Browse Nodes dialog box. 
Select a Passport from the list of available Passports, and click OK.

14 Select Passport from the Node Type drop down list.

15 Select the FrAtm Interface type.

16 Click the browse [...] button next to the destination FrAtm field. Select a 
FrAtm interface from the list of available FrAtm interfaces.

The Called Address field is auto-populated with the address of the 
destination FrAtm that you have selected.

17 Click the Get Next button next to the destination DLCI field to auto-
populate the field with the next DLCI on the destination Passport or type 
in an instance number that is not already in use in the Passport. 
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18 From the TM Profile drop down list, select the FrAtm TM profile, or accept 
the default profile. You can edit the TM Profile by clicking the [...] button 
next to the TM Profile field.

19 Select the Use Defaults check box to use the default user ID and 
password. Otherwise, enter a user ID and password in the User Id and 
Password fields.

20 Apply and activate the provisioning. See “Applying service creations” 
(page 126).

Procedure job aid
Figure 22
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Creating a FRF.8 FrAtm to FrAtm SPVC between a Passport 
device and a non-Passport device

Use this procedure to create an end-to-end Frame Relay connection to enable 
a Frame Relay customer-provided equipment (CPE) to communicate with 
another Frame Relay CPE across a homogeneous ATM PNNI network. The 
source device must always be a Passport and the destination device is a non-
Passport running FrAtm FRF.8.

This procedure provisions the following on the source Passport node:

• creates a Data Link Connection Identifier (DLCI) component under the 
source FrAtm. If the source FrAtm does not exist, the operation 
terminates. If the specified DLCI already exists, the operation terminates.

• creates the service interworking function (SIWF) component under the 
source DLCI

• creates a soft PVC (SPVC) component under the source SIWF

• sets the source SIWF attributes: remote address (raddr), rci, and 
correlation tag (correlationTag) attributes 

• sets the traffic management attributes under the source component 
FrAtm DLCI ServiceParameters (Sp)

When validating a FR/ATM Access SPVC data retrieved from the 
Administration Database against the current view of Passport switches, the 
ATM service provisioning tool performs the following actions on the source 
node:

• verifies that the Fratm DLCI SIWF spvc component exists

• verifies that the raddr and rci attributes match

Prerequisites
The FrAtm interface on the source is provisioned before using the service 
provisioning tool. 

The destination node has been provisioned. Since the destination node is not 
a Passport, the service provisioning tool does not provision it.
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You have reviewed the section on basic provisioning procedures for general 
provisioning procedures.

Procedure steps
1 Start the ATM service provisioning tool from the Preside MDM window:

Configuration -> Passport Devices -> Service Provisioning -> ATM

If the Administration Database is installed, a dialog box opens prompting 
you for a database user ID and password.

2  In the User name and Password fields, type a user ID and password, and 
click OK.

The Service Provisioning - ATM window opens.

3 In the Circuit Type list in the main window, select the FRATM_Access_ 
SPVC circuit type.

4 In the Default User Id and Default Password fields, type the default user 
id and password to provision the Passport devices in the path.

5 If you are using circuit management, complete the following steps

• in the Circuit Id field, enter a circuit ID.

• optionally, in the Customer field, enter a customer name. If the 
customer does not exist in the database, it is created.

6 To set the correlation tag to the same value as the circuit ID, check the 
Use Circuit Id check box. Other wise, in the Correlation Tag field, enter 
an independent identifier, as required.

The correlation tag is only 32 bytes, so if you use the circuit ID, you need 
to limit the allowed 128 byte circuit ID to 32 bytes. If you have selected 
Use Circuit Id and more than 32 characters are entered in the Circuit Id 
field, the correlation tag on the Passport device is set to the first 32 
characters. 

Note:  If accounting collection has been enabled at the ATM Interface, 
then provisioning the correlation tag enables accounting collection for the 
VCC. The correlation tag can be left un-provisioned if this effect is not 
desired.

7 On the source side of the Node Properties panel, type a node name in 
the Source Node field or click the browse [...] button and select a 
Passport node from the Browse Nodes dialog. The source node must be 
a Passport.
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8 You cannot change the Node Type and Interface Type fields. These fields 
are read only since the source node is always a Passport, and the 
interface type is always FrAtm.

9 Click the browse [...] button and select a FrAtm interface from the list of 
interfaces displayed in the FrAtm Browse Dialog. 

10 Click the Get Next button next to the DLCI field to auto-populate the field 
with the next available DLCI on the source Passport, or type in an 
instance number that is not already in use on the Passport.

11 From the TM Profile drop down list, select the FrAtm TM profile, or accept 
the default profile. You can edit the TM Profile by clicking the [...] button 
next to the TM Profile field.

12 Select the Use Defaults check box to use the default user ID and 
password. Otherwise, enter a user ID and password in the User Id and 
Password fields.

13 On the destination side, the Dest Node field is disabled.

14 Select Foreign from the Node Type drop down list.

15 Select the FrAtm interface type from the Interface Type drop down list.

The FrAtm field is disabled.

16 Fill in the Called Address field of the FrAtm interface being used on the 
non-Passport.

17 Fill in the DLCI field with the DLCI used on the destination non-Passport. 
The Get Next button and TM Profile drop down list are disabled.

18 Select the Use Defaults check box to use the default user ID and 
password. Otherwise, enter a user ID and password in the User Id and 
Password fields.

19 Apply and activate the provisioning. See “Applying service creations” 
(page 126).
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Creating a FRF.8 FrAtm to ATM SPVC between Passport 
devices

Use this procedure to allow a Frame Relay customer-provided equipment 
(CPE) to communicate with an ATM CPE across a homogeneous ATM PNNI 
network. In this procedure, Passport is on the edge of the network offering 
Frame Relay services on one end-point and ATM on the other. This is 
accomplished on Passport by providing FRF.8 interworking on one of the 
Passport edge nodes. In this procedure, both the source and destination 
devices are Passports.

The following provisioning occurs on the source node:

• creates a creates a Data Link Connection Identifier (DCLI) under the 
source FrAtm. If the source FrAtm does not exist, the operation 
terminates. If the specified DCLI already exists, the operation terminates.

• creates the service interworking function (SIWF) component under the 
source DLCI

• creates a soft PVC (SPVC) component under the source SIWF

• sets the source SPVC attributes remote address (raddr), rci, and 
correlation tag (correlationTag)

• sets the traffic management attributes under the source component 
FrAtm DLCI ServiceParameters (Sp)

When validating a FR/ATM Access SPVC retrieved from the Administration 
Database against the current view of Passport switches, the ATM service 
provisioning tool performs the following actions on the source node:

• verifies that the Fratm DLCI SIWF spvc component exists

• verifies that the raddr and rci attributes match

Prerequisites
The FrAtm and AtmIf interfaces are provisioned before using the service 
provisioning tool.

You have reviewed the section on basic provisioning procedures for general 
provisioning procedures.
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Procedure steps
1 Start the ATM service provisioning tool from the Preside MDM window:

Configuration -> Passport Devices -> Service Provisioning -> ATM

If the Administration Database is installed, a dialog box opens prompting 
you for a database user ID and password.

2  In the User name and Password fields, type a user ID and password, and 
click OK.

The Service Provisioning - ATM window opens.

3 From the Circuit Type list, select FRATM ACCESS SPVC.

4 In the Default User Id and Default Password fields, type the default user 
id and password to provision the Passport devices in the path.

5 If you are using circuit management, complete the following steps

• in the Circuit Id field, enter a circuit ID.

• optionally, in the Customer field, enter a customer name. If the 
customer does not exist in the database, it is created.

6 To set the correlation tag to the same value as the circuit ID, check the 
Use Circuit Id check box. Other wise, in the Correlation Tag field, enter 
an independent identifier, as required.

The correlation tag is only 32 bytes, so if you use the circuit ID, you need 
to limit the allowed 128 byte circuit ID to 32 bytes. If you have selected 
Use Circuit Id and more than 32 characters are entered in the Circuit Id 
field, the correlation tag on the Passport device is set to the first 32 
characters. 

Note:  If accounting collection has been enabled at the ATM Interface, 
then provisioning the correlation tag enables accounting collection for the 
VCC. The correlation tag can be left un-provisioned if this effect is not 
desired.

7 On the source side of the Node Properties panel, type a node name in 
the Source Node field or click the browse [...] button and select a 
Passport node from the Browse Nodes dialog. The source node must be 
a Passport.

8 You cannot change the Node Type and Interface Type fields. These 
fields are read only since the source node is always a Passport, and the 
interface type is always FrAtm.
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9 Click the browse [...] button next to the FrAtm field and select a FrAtm 
interface from the list of interfaces displayed in the FrAtm Browse Dialog 
box.

10 Click the Get Next button next to the DLCI field to auto-populate the field 
with the next available DLCI on the source Passport, or type in an 
instance number that is not already in use on the Passport.

11 From the TM Profile drop down list, select the FrAtm TM profile, or accept 
the default profile. You can edit the TM Profile by clicking the [...] button 
next to the TM Profile field.

12 Select the Use Defaults check box to use the default user ID and 
password. Otherwise, enter a user ID and password in the User Id and 
Password fields.

13 In the Dest Node field, on the destination side of the Node Properties 
panel, type the name of the destination Passport device, or click the 
browse [...] button next to this field to open the Browse Nodes dialog box. 
Select a Passport from the list of available Passports, and click OK.

14 Select Passport from the Node Type drop down list.

15 Select the AtmIf Interface type from the Interface Type drop down list.

16 Click the browse [...] button next to the destination AtmIf field. Select a 
ATM interface from the list of available ATM interfaces.

The Called Address field is auto-populated with the address of the 
destination ATM that you have selected.

17 Fill in the VPI and VCI fields.

18 Select the Use Defaults check box to use the default user ID and 
password. Otherwise, enter a user ID and password in the User Id and 
Password fields.

19 Apply and activate the provisioning. See “Applying service creations” 
(page 126).
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Procedure job aid
Figure 23
FrAtm to Atm SPVC CDL where the source and destination are Passports 
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Creating a FrAtm to Atm SPVC between a Passport device 
and a non-Passport device

Use this procedure to create a FrAtm to ATM SPVC circuit between a source 
Passport device and a destination non-Passport device running ATM. 

The following provisioning occurs on the source node:

• creates a creates a Data Link Connection Identifier (DCLI) under the 
source FrAtm. If the source FrAtm does not exist, the operation 
terminates. If the specified DCLI already exists, the operation terminates.

• creates the service interworking function (SIWF) component under the 
source DLCI

• creates a soft PVC (SPVC) component under the source SIWF

• sets the source SPVC attributes remote address (raddr), rci, and 
correlation tag (correlationTag)

• sets the traffic management attributes under the source component 
FrAtm DLCI ServiceParameters

When validating a FR/ATM Access SPVC retrieved from the Administration 
Database against the current view of Passport switches, the ATM service 
provisioning tool performs the following actions on the source node:

• verifies that the Fratm DLCI SIWF spvc component exists

• verifies that the raddr and rci attributes match

Prerequisites
The FrAtm and AtmIf interfaces are provisioned before using the service 
provisioning tool.

The destination node has been provisioned. Since the destination node is not 
a Passport, the service provisioning tool does not provision it.

You have reviewed the section on basic provisioning procedures for general 
provisioning procedures.

Procedure steps
1 Start the ATM service provisioning tool from the Preside MDM window:
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Configuration -> Passport Devices -> Service Provisioning -> ATM

If the Administration Database is installed, you are prompted for a 
database user ID and password.

2  In the User name and Password fields, type a user ID and password, and 
click OK.

The Service Provisioning - ATM window opens.

3 From the Circuit Type drop down list, select the FRATM ACCESS SPVC 
circuit type.

4 In the Default User Id and Default Password fields, type the default user 
ID and password to provision the Passport devices in the path.

5 If you are using circuit management, complete the following steps

• in the Circuit Id field, enter a circuit ID.

• optionally, in the Customer field, enter a customer name.If the 
customer does not exist in the database, it is created.

6 To set the correlation tag to the same value as the circuit ID, check the 
Use Circuit Id check box. Otherwise, in the Correlation Tag field, enter 
an independent identifier, as required.

The correlation tag is only 32 bytes, so if you use the circuit ID, you need 
to limit the allowed 128 byte circuit ID to 32 bytes. If you have selected 
Use Circuit Id and more than 32 characters are entered in the Circuit Id 
field, the correlation tag on the Passport device is set to the first 32 
characters. 

7 On the source side of the Node Properties panel, type a node name in 
the Source Node field or click the browse [...] button and select a 
Passport node from the Browse Nodes dialog. The source node must be 
a Passport.

8 You cannot change the Node Type and Interface Type fields. These fields 
are read only since the source node is always a Passport, and the 
interface type is always FrAtm.

9 Click the browse [...] button and select a FrAtm interface from the list of 
interfaces displayed in the FrAtm Browse Dialog. 

10 Click the Get Next button next to the DLCI field to auto-populate the field 
with the next available DLCI on the source Passport, or type in an 
instance number that is not already in use on the Passport.
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11 From the TM Profile drop down list, select the FrAtm TM profile, or accept 
the default profile. You can edit the TM Profile by clicking the [...] button 
next to the TM Profile field.

12 Select the Use Defaults check box to use the default user ID and 
password. Otherwise, enter a user ID and password in the User Id and 
Password fields.

13 On the destination side, the Dest Node field is disabled.

14 Select Foreign from the Node Type drop down list.

15 Select the AtmIf interface type from the Interface Type drop down list.

The AtmIf field is disabled.

16 Fill in the Called Address field of the ATM interface being used on the 
destination non-Passport.

17 Fill in the VPI and VCI fields.

18 Apply and activate the provisioning. See “Applying service creations” 
(page 126).
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Creating a ATM to FrAtm SPVC between Passport devices
Use this procedure to create an ATM to FrAtm SPVC circuit between 
Passport devices. The circuit originates at an ATM node, crosses a PNNI 
network, and terminates on a node accessing a Frame Relay customer-
provided equipment (CPE). 

The following provisioning occurs on the source node:

• creates a VCC under the source AtmIf. If the source AtmIf does not exist, 
the operation terminates. If the source VCC already exists, the operation 
terminates

• creates the SourcePVC under the sourceVCC

• Sets the SourcePVC attributes: calledAddress, calledVpiVci

• Sets the calledVpiVci value to 0.remotedlci

The following provisioning occurs on the destination node:

• creates a creates a Data Link Connection Identifier (DCLI) under the 
source FrAtm. If the source FrAtm does not exist, the operation 
terminates. If the specified DCLI already exists, the operation terminates.

• creates the service interworking function (SIWF) component under the 
source DLCI

When validating a ATM to FrAtm SPVC retrieved from the Administration 
Database against the current view of Passport switches, the ATM service 
provisioning tool performs the following actions on the source node:

• verifies that the Atmif Vcc SourcePvc component exists

• verifies that the calledAddress, calledVpi and calledVci match

If the destination node is known, the tool verifies that the FrAtm DLCI SIWF 
component exists on the destination.

Prerequisites
The FrAtm and AtmIf interfaces are provisioned before using the service 
provisioning tool.
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You have reviewed the section on basic provisioning procedures for general 
provisioning procedures.

Procedure steps
1 Start the ATM service provisioning tool from the Preside MDM window:

Configuration -> Passport Devices -> Service Provisioning -> ATM

If the Administration Database is installed, you are prompted for a 
database user ID and password.

2  In the User name and Password fields, type a user ID and password, and 
click OK.

The Service Provisioning - ATM window opens.
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3 From the Circuit Type drop down list, select the SPVC circuit type.

4 In the Circuit Type list in the main window, select the SPVC circuit type.

5 In the Default User Id and Default Password fields, type the default user 
id and password to provision the Passport devices in the path.
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6 If you are using circuit management, complete the following steps

• in the Circuit Id field, enter a circuit ID.

• optionally, in the Customer field, enter a customer name. If the 
customer does not exist in the database, it is created.

7 To set the correlation tag to the same value as the circuit ID, check the 
Use Circuit Id check box. Other wise, in the Correlation Tag field, enter 
an independent identifier, as required.

The correlation tag is only 32 bytes, so if you use the circuit ID, you need 
to limit the allowed 128 byte circuit ID to 32 bytes. If you have selected 
Use Circuit Id and more than 32 characters are entered in the Circuit Id 
field, the correlation tag on the Passport device is set to the first 32 
characters. 

Note:  If accounting collection has been enabled at the ATM Interface, 
then provisioning the correlation tag enables accounting collection for the 
VCC. The correlation tag can be left un-provisioned if this effect is not 
desired.

8 On the source side of the Node Properties panel, type a node name in 
the Source Node field or click the browse [...] button and select a 
Passport node from the Browse Nodes dialog. See “Browsing Node 
Names” (page 186).

9 You cannot change the Node Type and Interface Type fields. These fields 
are read only since the source node is always a Passport, and the 
interface type is always AtmIf.

10 Click the browse [...] button next to the source AtmIf, and select a ATM 
interface from the list of available interfaces in the Browse Addresses 
dialog box. See “Browsing Addresses” (page 187).

The Calling Address field is auto-populated with the address of the AtmIf 
that you select.

11 Fill in the VPI and VCI fields.

12 Enable or disable AIS Generation at the source.
This attribute enables/disables the generation of an Alarm Indication 
Signal (AIS) to the customer-provided equipment (CPE), when the 
switched portion of the SPVC is disconnected.

13 From the TM Profile drop down list, select the Atm TM profile, or accept 
the default profile. You can edit the TM Profile by clicking the [...] button 
next to the TM Profile field.
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14 In the Dest Node field, type the name of the Passport device, or click the 
browse [...] button next to this field to open the Browse Nodes dialog box. 
Select a Passport from the list of available Passport devices and click OK.

15 From the Node Type drop down list, select Passport.

16 From the Interface Type drop down list, Select FrAtm.

17 Click the browse [...] button next to the destination FrAtm field select an 
FrAtm Interface from the list of available FrAtm interfaces.

The Called Address field is auto-populated with the address of the 
destination FrAtm that you have selected.

18 Click the Get Next button to the right of the DLCI field, or type in an 
instance number that is not already in use on the Passport.

If you click Get Next, the field is auto-populated with the next available 
DLCI on the destination Passport.

19 From the TM Profile drop down list, select the TM profile, or accept the 
default profile. You can edit the TM Profile by clicking the [...] button next 
to the TM Profile field.

20 Select the Use Defaults check box to use the default user ID and 
password. Otherwise, enter a user ID and password in the User Id and 
Password fields.

21 Apply the provisioning. See “Applying service creations” (page 126).
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Procedure job aid
Figure 24
Atm to FrAtm SPVC CDL where the source and destination are Passports
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Creating an ATM to FrAtm SPVC between a Passport device 
and a non-Passport device

Use this procedure to create an Atm to FrATM SPVC circuit between a 
Passport and non-Passport device. The circuit originates at an ATM node, 
crosses a PNNI network, and terminates on a node accessing a Frame Relay 
customer-provided equipment (CPE). The following provisioning occurs on 
the destination node:

The following provisioning occurs on the source node:

• creates a VCC under the source AtmIf. If the source AtmIf does not exist, 
the operation terminates. If the source VCC already exists, the operation 
terminates

• creates the SourcePVC under the sourceVCC

• Sets the SourcePVC attributes: calledAddress, calledVpiVci

When validating a ATM to FrAtm SPVC retrieved from the Administration 
Database against the current view of Passport switches, the ATM service 
provisioning tool performs the following actions on the source node:

• verifies that the Atmif Vcc SourcePvc component exists

• verifies that the calledAddress, calledVpi and calledVci match

Note: In the database, the ATM to FrAtm SPVC is considered an ATM 
SPVC because it originates on an ATM interface.

Prerequisites
The FrAtm and AtmIf interfaces are provisioned before using the service 
provisioning tool.

The destination node has been provisioned. Since the destination node is not 
a Passport, the service provisioning tool does not provision it.

You have reviewed the section on basic provisioning procedures for general 
provisioning procedures.

Procedure steps
1 Start the ATM service provisioning tool from the Preside MDM window:
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Configuration -> Passport Devices -> Service Provisioning -> ATM

If the Administration Database is installed, you are prompted for a 
database user ID and password.

2  In the User name and Password fields, type a user ID and password, and 
click OK.

The Service Provisioning - ATM window opens.
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3 In the Circuit Type list in the main window, select the ATM SPVC circuit 
type.

4 In the Default User Id and Default Password fields, type the default user 
id and password to provision the Passport devices in the path.
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5 If you are using circuit management, complete the following steps

• in the Circuit Id field, enter a circuit ID.

• optionally, in the Customer field, enter a customer name. If the 
customer does not exist in the database, it is created.

6 To set the correlation tag to the same value as the circuit ID, check the 
Use Circuit Id check box. Other wise, in the Correlation Tag field, enter 
an independent identifier, as required.

The correlation tag is only 32 bytes, so if you use the circuit ID, you need 
to limit the allowed 128 byte circuit ID to 32 bytes. If you have selected 
Use Circuit Id and more than 32 characters are entered in the Circuit Id 
field, the correlation tag on the Passport device is set to the first 32 
characters. 

Note:  If accounting collection has been enabled at the ATM Interface, 
then provisioning the correlation tag enables accounting collection for the 
VCC. The correlation tag can be left un-provisioned if this effect is not 
desired.

7 On the source side of the Node Properties panel, type a node name in 
the Source Node field or click the browse [...] button and select a 
Passport node from the Browse Nodes dialog. See “Browsing Node 
Names” (page 186).

8 Type an ATM Interface name in the source AtmIf field, or click the browse 
[...] button and select a ATM interface from the list of available ATM 
interfaces. See the section Browsing ATM Interfaces.

9 Fill in the VPI and VCI fields.

10 Enable or disable AIS Generation at the source.
This attribute enables/disables the generation of an Alarm Indication 
Signal (AIS) to the customer-provided equipment (CPE), when the 
switched portion of the SPVC is disconnected.

11 From the TM Profile drop down list, select the TM profile, or accept the 
default profile. You can edit the TM Profile by clicking the [...] button next 
to the TM Profile field.

12 On the destination side of the Node Properties panel, the Dest Node 
field is disabled.

13 Select Foreign in the Node Type field.

14 Select FrAtm from the Interface Type drop down list.

15 Apply the provisioning. See “Applying service creations” (page 126).
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Chapter 9
ATM Traffic Management Profile Editor

For a description of the ATM Traffic Management Profile Editor and how it 
works see the following sections:

• “About the ATM Traffic Management Profile Editor” (page 217)

• “Starting the ATM Profile Editor from the Preside MDM toolset” 
(page 226)

• “Starting the ATM Profile Editor from a command line” (page 227)

• “Opening the ATM Traffic Management Profile Editor from the ATM 
service provisioning tool” (page 228)

• “Modifying attribute values” (page 230)

• “Deleting a Traffic Management profile” (page 231)

• “Saving a traffic management profile” (page 232)

• “Setting the traffic management profile as the selected traffic 
management profile for the Passport device” (page 233)

• “Applying a Traffic Management profile to a Passport device” (page 235)

About the ATM Traffic Management Profile Editor
The ATM Traffic Management Profile Editor provides a graphical user 
interface to manage the Traffic Management (TM) profiles for the 
Asynchronous Transfer Mode (ATM) service provisioning tool. The user 
interface is dynamic. That is, its contents correspond to the ATM service 
being provisioned (Trunk, VccBearerServiced, VpcBearerService, CES over 
PVC, SPVC, SPVP, or FrATM ACCESS SPVC). 
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You can perform the following TM profile management tasks with the ATM 
Traffic Management Profile Editor:

• create TM profiles

• view and modify one or more values in an existing TM profile while you 
are using the ATM service provisioning tool, and apply the changes 
without saving the TM profile to disk

• save multiple TM profiles so that manual file versioning is possible

The table “Modifiable components and attributes” (page 218) identifies the 
circuit type and components whose attributes you can modify using the 
Traffic Management Profile Editor. Each must be dealt with on an individual 
basis.

Opening the ATM Traffic Management Profile Editor
You can open the ATM Traffic Management Profile Editor in the following 
ways:

• in standalone mode from the Configuration -> Passport Devices -> 
Administration menu

• in standalone mode from a command line

• from the ATM service provisioning tool

Table 1
Modifiable components and attributes

Circuit Type Component

SPVC AtmIf Vcc Vcd Tm

SPVP AtmIf Vpc Vpd Tm

VccBearerService AtmIf Vcc Vcd Tm

VpcBearerService AtmIf Vpc Vpd Tm

Trunk AtmIf Vcc Vcd Tm

CES over PVC AtmIf Vcc Vcd Tm

FRF.8 FrAtm PVC FrAtm DLCI ServiceParameters (Sp)
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ATM Traffic Management Profile Editor user interface
The user interface opened in standalone mode differs from that which appears 
when you open the Profile Editor from the ATM service provisioning tool in 
the following ways:

• In standalone mode, the Circuit Type drop down list is enabled, allowing 
you to select another circuit type. When you open the Profile Editor from 
the ATM service provisioning tool, the circuit type in the Circuit Type 
drop down list corresponds to the type that you selected in the ATM 
service provisioning tool and is read-only. 

• In standalone mode, the Profile Editor contains the Save, Delete, Close 
and Help buttons. You cannot apply the TM profile to the Passport device 
when in standalone mode. You need to apply the TM profile from the 
ATM service provisioning tool. See “Applying a Traffic Management 
profile to a Passport device” (page 235). When opened from the ATM 
service provisioning tool, the Profile Editor contains the Apply, Apply 
and Save, Delete, Close and Help buttons.

For an illustration of the ATM Traffic Management Profile Editor, see the 
figure “ATM Traffic Management Profile Editor” (page 220). This figure 
illustrates the ATM TM Profile Editor when you launch it from the ATM 
service provisioning client. When you launch the ATM Traffic Management 
Profile Editor as a stand-alone tool, a similar dialog box opens, but it does not 
have the Apply and Apply and Save buttons.
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Figure 25
ATM Traffic Management Profile Editor

Complex attributes have descriptive labels that make them easier to identify. 
These labels change according to the value of the Traffic Descriptor Type 
attribute.

Default values are provided for each component’s attributes and specific 
values are set for those instances where an attribute must assume a particular 
value. 
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Note: The default value for an attribute always appears at the top of the 
drop down list. 

For the Bandwidth QoS Parameters and Forward QoS Parameters seen in 
SPVC mode, you can obtain the default values for the text fields by resting 
the mouse over the respective text field to access a tool tip. Tx and Rx Traffic 
Descriptor Parameters, regardless of the mode, do not have similar tool tips 
because of the variation between the different card and circuit types. The only 
common restriction in the Tx and Rx Traffic Descriptor text fields is that the 
maximum is always 2147483647.

If an attribute is mandatory for a certain service, the attribute and its values 
are shown but are greyed out so that they are inaccessible. As a result, you will 
not be able to edit them. An example of this is the value for txTrafficDesParm 
attribute. The txTrafficDesParm attribute must all be 0 if txTrafficDescType 
is 1 or 2. You can, therefore, only modify non-critical attribute values. This 
safeguards against corruption of the TM profile for the service and reduces 
likelihood of corruption or failure at “check prov.”

The following command buttons that are common to both interfaces:

• Delete deletes the TM profile selected in the TM Profile Name drop 
down list.

• Close closes the ATM Traffic Management Profile Editor. If you opened 
the ATM Traffic Management Profile Editor from the ATM service 
provisioning tool, closing the tool sends the currently selected TM profile 
back to the ATM service provisioning tool.

• Help opens the on-line documentation for the ATM Traffic Management 
Profile Editor

If opened in standalone mode, the Profile Editor also contains the following 
command button:

• Each Save action overwrites the entire contents of the 
eteATMProfiles.cfg file. Only the currently selected TM profile has its 
changes saved to disk. Changes made to the other TM profiles since the 
last save are not written to disk.
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If opened from the ATM service provisioning tool, the Profile Editor also 
contains the following commands

• Apply and Save generates a TM profile in the eteATMProfiles.cfg file 
with the specified name overwriting the contents of the previous TM 
profile. You can also change the name of the TM profile in the TM Profile 
Name field to create a new TM profile. See “Saving TM profiles” 
(page 223) and the procedure for “Saving a traffic management profile” 
(page 232).

• Apply creates a new TM profile in memory only with the current TM 
profile name plus a asterisk (*) appended to the end of it. This TM profile 
will only exist until the ATM tool is exited. 

Note: The TM profile that gets selected for the Passport device is the one 
currently selected in the ATM Traffic Management Profile Editor when 
the tool closes, and not the latest TM profile that was applied.

See “Setting the traffic management profile as the selected traffic 
management profile for the Passport device” (page 233)

Relationship to the ATM service provisioning tool interface
The Default TM drop down list in the ATM service provisioning tool is 
populated from the eteATMProfiles.cfg file with only the traffic management 
profiles that have been created and stored for the service type currently being 
provisioned, as specified in the Circuit Type drop down list. Consequently, 
TM profiles that are created and stored for another ATM service would not 
appear in the Default TM drop down list.

You are provided with a default Traffic Management profile for each of the 
circuit types (Trunk, CES over PVC, VccBearerService, VpcBearerService, 
SPVC, SPVP). This provides you with the basis from which to create 
customized Traffic Management profiles.

When you select a circuit type in the ATM service provisioning tool, the 
default Traffic Management profile is automatically selected. 

Traffic Management profiles are applied to the Passport device from the ATM 
service provisioning tool. See “Applying a Traffic Management profile to a 
Passport device” (page 235).
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Modifying TM profiles
You can modify the non-mandatory attribute values. When you select a TM 
profile in the ATM service provisioning tool and then click the edit TM button 
[...], you open the ATM Traffic Management Profile Editor with the attribute 
values for the selected TM profile appearing in the attribute fields. 

For the procedure to modify TM profile attributes, see “Modifying attribute 
values” (page 230).

Saving TM profiles
Note: You cannot save the default TM profile for any of the circuit types.

You can view and modify one or more of the traffic management values, and 
apply the changes without ever saving them to disk. 

When a TM profile has been changed, applied, but not saved to disk, an 
asterisk (*) appears at the end of its name to indicate that the traffic 
management profile has changed from the original traffic management 
profile.

Traffic management profiles that are saved to memory and not to disk are 
written to the Administration Database as “Custom” after a circuit is 
successfully activated on the Passport device. This indicates that this TM 
Profile has not been saved to disk and could have been altered substantially 
from its original base TM Profile. When retrieving a circuit from the database, 
you need to make your own record of what the TM Profile means. Since a 
“Custom” TM Profile is not stored to disk, you cannot apply it to the Passport 
device after retrieving a circuit from the database.

If a save is required, you can save the TM profile under the same name, or a 
new name. Saving under the same name generates a TM profile in the 
eteATMProfiles.cfg file with the specified name overwriting the contents of 
the previous TM profile.

Saving under a new name allows for manual file versioning.

Note:  It is recommended, when you create a traffic management profile, 
that you give it a meaningful name to make it easier to retrieve the desired 
traffic management profile in the ATM service provisioning tool window.
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For the procedure to save TM profiles, see “Saving a traffic management 
profile” (page 232).

Storage of TM profiles
 The TM profiles are stored locally on the Preside Multiservice Data Manager 
(MDM) that is running the ATM client. For additional information on the 
eteATMProfiles.cfg file, see “eteATMProfiles.cfg file” (page 38).

Warning and error messages
Warning or error messages are displayed in the ATM service provisioning 
tool messages window. This window is accessed by View -> Show 
Messages... The following situations generate an error or warning message:

Note: Warning messages do not stop the provisioning session.

• If you have saved ATM Traffic Management Profiles prior to R14.1, the 
first time the ATM service provisioning tool is run from a new MDM 
install, a warning dialog box opens informing you of the new location for 
the eteATMProfiles.cfg files. Any eteATMProfiles.cfg files created 
before R14.1 remain unchanged in /opt/MagellanNMS/cfg. However, the 
ATM service provisioning tool does not use these files.

• the ATM service provisioning tool cannot read from the /opt/
MagellanNMS/cfg/eteATMProfiles.cfg or /opt/MagellanNMS/lib/cfg/
eteATMAttributes.cfg files

• for SPVC circuits which allow Bwd QoS parameters. For PCR release 
2.2 to PCR 3.0 the Bwd QoS had three parameters. For PCR 3.1 and 
above, it only has two. The ATM service provisioning tool always tries 
to apply all three parameters and will generate a warning message if the 
PCR release does not support all three parameters. The warning does not 
stop the other two parameters from being set.

• for Tx WRED Mode and Tx WRED Threshold attributes. These 
attributes did not exist before PCR release 3.0 so a warning message is 
generated if the ATM service provisioning tool tries to apply these 
attributes to a pre-3.0 PCR release. This does not affect the other TM 
attributes being set, as they are set in a separate set command.
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Procedures
For relevant procedures, see the following sections:

• “Starting the ATM Profile Editor from the Preside MDM toolset” 
(page 226)

• “Starting the ATM Profile Editor from a command line” (page 227)

• “Opening the ATM Traffic Management Profile Editor from the ATM 
service provisioning tool” (page 228)

• “Modifying attribute values” (page 230)

• “Deleting a Traffic Management profile” (page 231)

• “Saving a traffic management profile” (page 232)

• “Setting the traffic management profile as the selected traffic 
management profile for the Passport device” (page 233)

• “Applying a Traffic Management profile to a Passport device” (page 235)
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Starting the ATM Profile Editor from the Preside MDM 
toolset

Use this procedure to open the ATM Traffic Management Profile Editor in 
stand-alone mode, independent of the ATM service provisioning tool. Since 
there is no interaction with the ATM service provisioning tool you can only 
view, edit, and save the TM Profile to disk. You can not send it to the ATM 
service provisioning tool.

Procedure steps
1 Start Preside MDM:

2  In the Preside MDM toolsets window, select Configuration -> Passport 
Devices -> Administration -> ATM Traffic Management Profile Editor.

The ATM Traffic Management Profile Editor dialog box opens with the 
default_SPVC displayed in the TM Profile Name field.

In stand-alone mode, the Circuit Type drop down list is editable and the 
action buttons are Save, Delete, Close, and Help. Apply and Apply and 
Save are not available.
241-6001-600   14.3RSUP   



Chapter 9 ATM Traffic Management Profile Editor   227
Starting the ATM Profile Editor from a command line
Use this procedure to open the ATM Traffic Management Profile Editor from 
a command line on a Preside Multiservice Data Manager (MDM) 
workstation. When you start the ATM Profile Editor from a command line, it 
starts in stand-alone mode, independent of the ATM service provisioning tool. 
Since there is no interaction with the ATM service provisioning tool you can 
only view, edit, and save the TM Profile to disk. You can not send it to the 
ATM service provisioning tool.

Procedure steps
1 Open an xterm on the Preside MDM workstation

2  Enter the following command:

/opt/MagellanNMS/bin/eteATMTM &

The ATM TM Profile Editor dialog box opens with the default_SPVC 
displayed in the TM Profile Name field.
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Opening the ATM Traffic Management Profile Editor from 
the ATM service provisioning tool 

Use this procedure to start the ATM Traffic Management Profile Editor from 
the ATM service provisioning tool. This procedure lets you view and modify 
the TM profile of an existing circuit.

Procedure steps
1 Start Preside MDM:

2 To start the ATM service provisioning tool, select one of the following 
options:

• in the Preside MDM window, select Configuration -> Passport 
Devices -> Service Provisioning -> ATM

• in a UNIX shell, enter the following command at the prompt:

/opt/MagellanNMS/bin/eteATM

3 If the Administration Database is installed, you are prompted for a userid 
and password. Enter a valid user id and password.

The ATM service provisioning tool opens.

4 In Circuit Properties panel of the ATM service provisioning tool main 
window, select a service type from the Circuit Type dropdown list.

The TM Profile shows the default TM profile for the selected circuit type.

5 To open the ATM Traffic Manager Profile Editor, select one of the following 
options:

• Click the Edit TM [...] button found to the right of the Default TM 
Profile dropdown list.

• From the Tools menu select ATM Traffic Management Profile 
Editor. 

The ATM Traffic Management Profile Editor opens with the TM Profile 
Name field containing the default traffic management profile for the circuit 
type selected in step 4. 

If you have saved ATM Traffic Management Profiles prior to R14.1, the 
first time the ATM service provisioning tool is run from a new MDM install, 
a warning dialog box opens informing you of the new location for the 
eteATMProfiles.cfg files. Any eteATMProfiles.cfg files created before 
R14.1 remain unchanged in /opt/MagellanNMS/cfg. However, the ATM 
service provisioning tool does not use these files.
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For PVC circuit types, when you click the edit TM profile button [...] you 
can select another TM profile from the TM Profile Name drop down list, 
and this TM profile becomes the selected TM profile in the Default TM 
Profile field in the ATM service provisioning tool.
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Modifying attribute values
Use this procedure to modify Traffic Management attributes. Attributes that 
cannot be modified are greyed out.

Prerequisites
This procedure requires that the following conditions are met:

• you have launched the ATM Traffic Management Profile Editor 

• you have selected the TM Profile that you wish to modify.

Procedure steps
1 Click in the text field of the attribute that you wish to modify.

2 Type in the new value, or select a new value from the drop down list.

3 Repeat steps 1 and 2 for all the attributes you wish to modify.

4 If you opened the ATM Traffic Management Profile Editor in stand-alone 
mode, select Save. See “Saving a traffic management profile” (page 232).

If you opened the ATM Traffic Management Profile Editor from the ATM 
service provisioning tool, select one of the following options:

• Apply. See “Applying a Traffic Management profile to a Passport 
device” (page 235).

• Apply and Save. See “Saving a traffic management profile” 
(page 232)
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Deleting a Traffic Management profile
Use this procedure to delete a traffic management profile. You can not delete 
a default TM profile.

Prerequisites
This procedure requires that the following conditions are met:

• you have launched the ATM Traffic Management Profile Editor 

Procedure steps
1 From the TM Profile Name drop down list, in the ATM Traffic 

Management Profile window, select the TM profile that you wish to 
delete.

2 Click Delete.

A confirmation dialog box opens confirming that you wish to proceed with 
the delete action.

3 Click Yes to delete the selected TM profile.
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Saving a traffic management profile
Use this procedure to save a traffic management profile in the 
eteATMProfiles.cfg file. Note that you cannot overwrite the default TM 
profile for any of the circuit types.

Prerequisites
This procedure requires that the following conditions are met:

• you have launched the ATM Traffic Management Profile Editor 

Procedure steps
1 In the ATM Traffic Management Profile Editor dialog box, modify 

attribute values, as desired. See “Modifying attribute values” (page 230).

2 Retain the current file name or in the TM Profile Name field, enter a new 
name, if you wish to create a new TM profile. It is recommended, when 
you give the new TM profile a meaningful name to make it easier to 
retrieve the desired traffic management profile in the ATM service 
provisioning tool window. 

Note:  You can keep the original TM profile and save the current TM 
profile contents under a new name, by typing a new name for the TM 
profile.

3 If you opened the Profile Editor from the ATM service provisioning tool, 
click Apply and Save. 

A TM Profile is generated in the eteATMProfiles.cfg file with the specified 
file name overwriting the contents of the previous TM profile. If you 
created a new file name for the TM profile, this new name appears in both 
the TM Profile Name field in the Profile Editor and in the TM profile field 
in ATM service provisioning window.

If you click Apply, an asterisk (*) appears at the end of the TM profile 
name once Apply is clicked.

If you opened the Profile Editor in standalone mode, click Save. 

A TM Profile is generated with the specified file name, overwriting the 
contents of the previous TM profile. 
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Setting the traffic management profile as the selected 
traffic management profile for the Passport device

Use this procedure to modify and set the traffic management (TM) profile as 
the selected TM profile for the Passport device, without applying the profile 
to the Passport device.

Prerequisites
This procedure requires that the following condition is met:

• you have launched the ATM service provisioning tool

Procedure steps
1 In the ATM service provisioning tool select the circuit that the TM profile 

will be applied to by selecting the circuit type, component instances and 
Passport device.

2 From the Default TM drop down list, select the TM profile that will be 
applied to the circuit, or select the default TM profile, if desired.

Only the TM profiles that are valid for the selected circuit type are 
displayed in the drop down list.

3 Click the edit TM button [...] to open the ATM Traffic Management 
Profile Editor.

4 Select one of the following actions:

• Click Apply to save the current TM Profile in memory. This does not 
apply the settings to the device but only saves the TM profile to 
memory. An asterisk (*) is appended to the TM profile name.

• Modify the TM profile and click Apply to create a new TM profile in 
memory with an asterisk (*) at the end of its name. This does not 
apply the settings to the device, but only saves the TM Profile to 
memory.
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• Modify the TM profile and click Apply and Save to overwrite the 
existing TM profile and save it to disk. 

The TM profile that is selected in the Profile Editor when it is closed 
becomes the selected TM profile in the drop down list on the device from 
which the Traffic Management Profile Editor was started in the service 
provisioning tool. To apply the TM profile to the device, along with the rest 
of the circuit configuration, you need to click Apply from the ATM service 
provisioning tool. See “Applying a Traffic Management profile to a 
Passport device” (page 235).
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Applying a Traffic Management profile to a Passport device
Use this procedure to apply a traffic management profile to an ATM circuit on 
the Passport device. TM profiles can only be applied to a Passport device from 
the ATM service provisioning tool.

Prerequisites
This procedure requires that the following conditions are met:

• you have opened the ATM service provisioning tool

•  the Traffic Management (TM) Profile that you wish to apply exists in the 
eteATMProfiles.cfg file.

Procedure steps
1 In the ATM service provisioning tool window select the circuit that the 

TM profile will be applied to by selecting the circuit type, component 
instance, and Passport device.

2 From the Default TM drop down list, select the TM profile that will be 
applied to the circuit, or select the Default TM profile, if desired.

Only the TM profiles that are valid for the selected circuit type are 
displayed in the drop down list.

3 Select the Use Default TM check box, if desired.

4 Click Apply to apply the TM profile to the Passport device.

If applying an existing TM Profile, the ATM service provisioning tool 
applies the TM profile to the Passport device, only if the name of the TM 
profile has changed. If the contents of the TM Profile have changed, but 
the name is the same, the TM settings are applied to the Passport device 
if these changes occurred in a Traffic Management Profile Editor launch 
from the current instance of the ATM service provisioning tool. Once the 
ATM service provisioning tool instance is dismissed, a record of these 
changes is lost.

Note:  When a “Custom TM profile is retrieved from the database, if the 
custom TM profile is the selected TM on a node when the circuit is applied 
to the Passport, no changes are made to the TM attributes of the 
corresponding node in the circuit.
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